. ® Richard Pflanzer, Ph.D.
n B’OPAC® Blopac Student Lab™ Lesson 1 Associate Professor Emeritus

* sterns’ InC. ELECTROMYOGRAPHY (EMG) | Indiana University School of Medicine

42 Aero Camino, Goleta, CA 93117

Registered to 1SO 9001:2008 . Purdue University School of Science
Introduction o
William McMullen

www.biopac.com Rev. 01152013 Vice President, BIOPAC Systems, Inc.

g - Hmow M- o e S o * =i

- * -

INTRODUCTION

In this lesson, you will investigate some properties of skeletal muscle. Physiological phenomena associated with other
kinds of muscle, such as electrophysiology of the heart, will be studied in subsequent lessons.

The human body contains three kinds of muscle tissue and each performs specific tasks to maintain homeostasis:
Cardiac muscle, Smooth muscle, and Skeletal muscle.

e Cardiac muscle is found only in the heart. When it contracts, blood circulates, delivering nutrients to
cells and removing cell waste.

e Smooth muscle is located in the walls of hollow organs, such as the intestines, blood vessels or lungs.
Contraction of smooth muscle changes the internal diameter of hollow organs, and is thereby used to
regulate the passage of material through the digestive tract, control blood pressure and flow, or regulate
airflow during the respiratory cycle.

o Skeletal muscle derives its name from the fact that it is usually attached to the skeleton. Contraction of
skeletal muscle moves one part of the body with respect to another part, as in flexing the forearm.
Contraction of several skeletal muscles in a coordinated manner moves the entire body in its
environment, as in walking or swimming.

The primary function of muscle, regardless of the kind, is to convert chemical energy to mechanical work, and in so
doing, the muscle shortens or contracts.

Human skeletal muscle consists of hundreds of individual cylindrically shaped cells (called fibers) bound together by
connective tissue. In the body, skeletal muscles are stimulated to contract by somatic motor nerves that carry signals in
the form of nerve impulses from the brain or spinal cord to the skeletal muscles (Fig. 1.1). Axons (or nerve fibers) are
long cylindrical extensions of the neurons. Axons leave the spinal cord via spinal nerves and the brain via cranial nerves,
and are distributed to appropriate skeletal muscles in the form of a peripheral nerve, which is a cable-like collection of
individual nerve fibers. Upon reaching the muscle, each nerve fiber branches and innervates several individual muscle
fibers.

Although a single motor neuron can innervate several muscle fibers, each muscle fiber is innervated by only one motor
neuron. The combination of a single motor neuron and all of the muscle fibers it controls is called a motor unit (Fig.
1.1).

When a somatic motor neuron is activated, all of the muscle fibers it innervates respond to the neuron’s impulses by
generating their own electrical signals that lead to contraction of the activated muscle fibers.
Physiologically, the degree of skeletal muscle contraction is controlled by:

1. Activating a desired number of motor units within the muscle, and

2. Controlling the frequency of motor neuron impulses in each motor unit.

When an increase in the strength of a muscle’s contraction is necessary to perform a task, the brain increases the number
of simultaneously active motor units within the muscle. This process is known as motor unit recruitment.

Resting skeletal muscles in vivo exhibit a phenomenon known as tonus, a constant state of slight tension that serves to
maintain the muscle in a state of readiness. Tonus is due to alternate periodic activation of a small number of motor units
within the muscle by motor centers in the brain and spinal cord. Smooth controlled movements of the body (such as
walking, swimming or jogging) are produced by graded contractions of skeletal muscle. Grading means changing the
strength of muscle contraction or the extent of shortening in proportion to the load placed on the muscle.
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Skeletal muscles are thus able to react to different loads accordingly. For example, the effort of muscles used in walking
on level ground is less than the effort those same muscles expend in climbing stairs.
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Fig. 1.1 Example of Motor Units

When a motor unit is activated, the component muscle fibers generate and conduct their own electrical impulses that
ultimately result in contraction of the fibers. Although the electrical impulse generated and conducted by each fiber is
very weak (less than 100 microvolts,) many fibers conducting simultaneously induce voltage differences in the overlying
skin that are large enough to be detected by a pair of surface electrodes. The detection, amplification, and recording of
changes in skin voltage produced by underlying skeletal muscle contraction is called electromyography. The recording
thus obtained is called an electromyogram (EMG).

The EMG signal is the recorded consequence of two principal bioelectric activities: 1) propagation of motor nerve
impulses and their transmission at the neuromuscular junctions of a motor unit, and 2) propagation of muscle impulses
by the sarcolemma and the T-tubular systems resulting in excitation-contraction coupling. The magnitudes of the action
potentials of active motor units are not all the same nor are they in phase with one another. Furthermore, the timing
sequence of motor unit activation is variable. The net result of these and other factors is a complex EMG signal.
Remember we are recording all of this activity as it is detected by surface electrodes, and propagation of muscle and
nerve impulses involves both depolarization and repolarization phenomena. The "spikes" therefore, will have a negative
and a positive component and the amplitudes will be influenced by the location of the recording electrodes with respect
to the number of active underlying skeletal muscle and motor nerve fibers.

.
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Fig. 1.2 EMG

Integrated EMG is an alternative view of the EMG signal
that clearly shows the pattern of muscle activity. Integrated
EMG *“averages out” noise spikes in the raw EMG data to
provide a more accurate indication of the EMG output level.
Integrated EMG calculates a moving average (mean) of the
EMG data by first rectifying each point in the sample range
(inverting all negative values) and then computing the
mean. In this lesson, each data point of Integrated EMG is
calculated using 100 samples of data from the EMG source,
Fig. 1.3 Integrated EMG so the first 100 sample points should be ignored since they
reflect the number of zero values being averaged in with the
first few samples of data.

Integrated EMG
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Il. EXPERIMENTAL OBJECTIVES

1) To observe and record skeletal muscle tonus as reflected by a basal level of electrical activity associated with
the muscle in a resting state.

2) To record maximum clench strength for right and left hands.
3) To observe, record, and correlate motor unit recruitment with increased power of skeletal muscle contraction.
4) To listen to EMG “sounds” and correlate sound intensity with motor unit recruitment.

Il. MATERIALS
e BIOPAC Electrode Lead Set (SS2L)
e BIOPAC Disposable Electrodes (EL503,) 6 electrodes per Subject
e BIOPAC Electrode Gel (GEL1) and Abrasive Pad (ELPAD) or Skin cleanser or alcohol prep
e Optional: BIOPAC Headphones (OUT1/OUT1A for MP3X or 40HP for MP45)
e Biopac Student Lab System: BSL 4 software, MP36, MP35 or MP45 hardware

e Computer system (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP
FAST TRACK Setup Detailed Explanation of Setup Steps

OUT1 OUT1A

1. Turn the computer ON.
e If using an MP36/35 unit, turn it OFF.

e If using an MP45, make sure USB cable
is connected and “Ready” light is ON.

2. Plug the equipment in as follows:
Electrode Lead Set (SS2L) — CH 1

Headphones (OUT1 or OUT1A*) — back
of unit

*OUT1A is compatible with MP36 only.
3. Turn ON the MP36/35 unit.

Fig. 1.4 MP3X (top) and MP45 (bottom) equipment connections

=  Windows: If using MP45, the Sound Playback device must be set to
MP45 via Start > Control Panel.

Setup continues...
Page P-1 ©BIOPAC Systems, Inc.
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4. Clean and abrade skin. If the skin is oily, clean electrode sites with soap and water or alcohol
5. Attach three electrodes to each forearm before abrading.
(Fig. 1.5). If electrode is dry, apply a drop of gel.

6. Clip the Electrode Lead Set (SS2L) to
Subject’s dominant arm, following the
color code (Fig. 1.5).

Follow Color Code!

Fig. 1.5 Electrode placement and lead attachment
= If Subject is right-handed, the right forearm is generally dominant; if
Subiject is left-handed, the left forearm is generally dominant.
=  For optimal electrode adhesion, place electrodes on the skin at least 5
minutes before the start of Calibration.
= The pinch connectors work like a small clothespin and will only
latch onto the nipple of the electrode from one side of the connector.

®=  The dominant arm should
rest on thigh to relax the
muscles in the shoulder and
upper arm.

7. Subject gets in a seated position, facing
the monitor.

= QOptional: Subject may hold
a small object, such as a
rubber ball, while
performing this procedure

Fig. 1.7 Positioning

Setup continues...
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8. Start the Biopac Student Lab Program.

9. Choose lesson “L01 —
Electromyography (EMG) I’ and click
OK.

10. Type in a unique filename and click OK.

11. Optional: Set Preferences.
e Choose File > Lesson Preferences.
« Select an option.

e Select the desired setting and click
OK.

END OF SETUP

B. CALIBRATION

L01 - Electromyography (EMG) |

Page P-3

Start Biopac Student Lab by double-clicking the Desktop shortcut.

Biopac
Student Lab
4.0

No two people can share the same filename, so use a unique identifier,
such as Subject’s nickname or student 1D#.

A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a common folder.

To change the preference, see next step.

This lesson has optional Preferences for data and display while recording.
Per your Lab Instructor’s guidelines, you may set:
Grids: Show or hide gridlines
Lesson Recordings: Specific recordings may be omitted based on
instructor preferences.

Calibration establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for optimal
performance. Pay close attention to Calibration. For a video example of proper Calibration procedure, click the

Calibration tab in the Lesson Set Up Journal.

FAST TRACK Calibration
1. Click Calibrate.

2. Two seconds after Calibration begins,
clench fist as hard as possible for two to
three seconds, then release.

3. Wait for Calibration to stop.

4. Verify recording resembles the example
data

o If similar, click Continue and
proceed to Data Recording.

o If necessary, click Redo
Calibration.

END OF CALIBRATION

Detailed Explanation of Calibration Steps

The program needs a reading
of the maximum clench to
perform an auto-calibration.

Fig. 1.8 Clench Fist for Calibration

Calibration lasts eight seconds.

Data should show a zero
baseline and a clear burst
when Subject clenched.

Fig. 1.9 Example Calibration data

If recording does not resemble the Example

Data

= If the data is noisy or flatline, check all
connections to the MP unit.

= Verify electrodes are making good contact
and that leads are clipped to the correct
color position with minimal cable strain.
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C. DATA RECORDING

FAST TRACK Recording
1. Prepare for the Dominant arm
recording.

o Electrodes must be attached to
Subject’s dominant arm.

e Subject’s hand must be relaxed.
e Review recording steps.

Dominant arm

Click Record.

3. Perform a series of four Clench -Release-
Wait cycles.

¢ Hold clench for two seconds, release
for two seconds.

e Begin with a weak clench, then
increase grip so the fourth clench is at
maximum.

Click Suspend.

5. Verify recording resembles the example
data.

o If similar, click Continue and
proceed to next recording.

e If necessary, click Redo.

e If all required recordings have been
completed, click Stop and proceed to
Step 11.

Nondominant arm

6. Prepare for the Nondominant arm
recording.

e Clip electrode leads to Subject’s
nondominant arm.

e Subject’s hand must be relaxed.
e Review recording steps.

7. Click Record.
Recording continues...

L01 - Electromyography (EMG) |

Biopac Student Lab 4

Detailed Explanation of Recording Steps

Two data recordings* will be acquired in this lesson:
a. Recording 1 records Dominant arm.
b. Recording 2 records Nondominant arm.

To work efficiently, read this entire section before recording, or review
onscreen Tasks to preview recording steps in advance.

*IMPORTANT

This procedure assumes that all lesson recordings are enabled in Lesson
Preferences, which may not be the case for your lab. Always match the
recording title to the recording reference in the journal and disregard any
references to excluded recordings.

=  Completely relax the grip between clenches.
=  Allow at least two seconds between clenches.

=  Two channels will be presented during the recording, CH 1 = Raw
EMG, and CH 2 = Integrated EMG (a moving average of the raw
signal).

Data should show four EMG “bursts” of increasing amplitude.

o0 7] ) F)

Fig. 1.10 Example data — Dominant arm

If recording does not resemble the Example Data

= |f there is not enough variation between the clenches, repeat
recording and start with a weaker clench.

= If the data is noisy or flatline, check all connections to the MP unit.

=  Verify electrodes are making good contact and that leads are clipped
to the correct color position with minimal cable strain.

Click Redo and repeat Steps 2 -5 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

Disconnect the lead set (SS2L) from the electrodes on the “dominant”
forearm and connect to electrodes on “nondominant” forearm. Refer to
Fig. 1.5 for proper electrode lead attachment.
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8. Perform a series of four Clench-Release-
Wait cycles.

» Hold clench for two seconds, release
for two seconds.

e Begin with a weak clench, and then
increase grip so the fourth clench is at
maximum.

9. Click Suspend.

10. Verify recording resembles the example
data.

e If similar, click Continue to proceed
to the optional recording section, or
click Stop to end the recording.

e If necessary, click Redo.

OPTIONAL AcCTIVE LEARNING PORTION

Recording continues...

Perform four cycles of Clench-Release-Wait, holding for two seconds and
waiting for two seconds after releasing before beginning the next cycle.
Try to increase the strength in equal increments so that the fourth clench is
at maximum force.

=  Completely relax the grip between clenches.
=  Allow at least two seconds between clenches.

1) om )

Fig. 1.11 Example data— Nondominant arm
The data description is the same as outlined in Step 4.
Click Redo and repeat Steps 7 — 10 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

With this lesson you may record additional data by clicking Continue
following the last recording. Design an experiment to test or verify a
scientific principle(s) related to topics covered in this lesson. Although
you are limited to this lesson’s channel assignments, the electrodes may
be moved to different locations on the Subject.

Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each step
to make it easy to follow during recording.

Run Your Experiment
D. SetUp

Set up the equipment and prepare the subject for your experiment.
E. Record

Use the Continue, Record, and Suspend buttons to record as much
data as necessary for your experiment.

Click Stop when you have completed all of the recordings required
for your experiment.

Analyze Your Experiment

F. Set measurements relevant to your experiment and record the results
in a Data Report.
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e To listen to the EMG signal, proceed Listening to the EMG is optional.

to Step 11. Listening to the EMG is optional and can be a valuable tool in detecting
« To skip listening to the EMG signal muscle abnormalities, and is performed here for general interest. Data on
and end the recording, proceed to screen is not saved.
Step 14.
11. Click Listen to record EMG data and hear The EMG signal will be audible through the headphones as it is being
it through the headphones. displayed on the screen. The screen will display two channels:
12. Increase grip force and notice how the CH 1 EMG and CH 40 Integrated EMG
volume increases. The signal will run until Stop is clicked. If others in lab group would like

to listen to the EMG signal, pass the headphones around before clicking
Stop or click Redo and then Stop when done.

13. Click Stop when finished. This will end listening to the EMG.
e Click Redo to hear EMG again.
14. Click Done to end the lesson. If choosing the Record from another Subject option:
15. Choose an option and click OK. = Repeat Setup Steps 4 — 7 and then proceed to Calibration.
16. Remove the electrodes. Remove the electrode cable pinch connectors, and peel off all electrodes.

Discard the electrodes (BIOPAC electrodes are not reusable). Wash the
electrode gel residue from the skin, using soap and water. The electrodes
may leave a slight ring on the skin for a few hours, which is quite normal.

END OF RECORDING



#BIOPAC
W Systerms, nc.

42 Aero Camino, Goleta, CA 93117

www.biopac.com

Biopac Student Lab® Lesson 1

ELECTROMYOGRAPHY (EMG) |
Analysis Procedure

Richard Pflanzer, Ph.D.
Associate Professor Emeritus
Indiana University School of Medicine
Purdue University School of Science

William McMullen
Vice President, BIOPAC Systems, Inc.

Rev. 12112014

V. DATA ANALYSIS

FAST TRACK Data Analysis

1. Enter the Review Saved Data mode.

e Note Channel Number (CH)
designations:

Channel  Displays

CH1 EMG

CH 40 Integrated EMG
» Note measurement box settings:

Channel  Measurement

CH 40 Mean

2. Set up your display window for optimal

viewing of “Dominant arm” recording.

Data Analysis continues...

Page P-1

Detailed Explanation of Data Analysis Steps

If entering Review Saved Data mode from the Startup dialog or Lessons
menu, make sure to choose the correct file.

The data window should resemble Fig. 1.12.

) 5] s B 5 = e - on ] e e P weon 5 | s o

BEEREPS RSN R

Fig. 1.12 Example data

The measurement boxes are above the marker region in the data window.
Each measurement has three sections: channel number, measurement type,
and result. The first two sections are pull-down menus that are activated
when you click them.

Brief definition of measurements:
Mean: Displays the average value in the selected area.

The “selected area” is the area selected by the I-beam tool (including
endpoints).

Record measurement data individually by hand or choose Edit > Journal >
Paste measurements to paste the data to your journal for future reference.
Note:

The append event markers # mark the beginning of each recording. Click
on (activate) the event marker to display its label.

Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom Back,
Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)
Cursor Tools: Zoom Tool
Buttons: Overlap, Split, Show Grid, Hide Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click” (Mac)
the channel number box to toggle channel display.

©BIOPAC Systems, Inc.
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3. Use the I-Beam cursor to select an area on  Fig. 1.13 below shows an EMG data selection in the first recording.
the plateau of the first EMG clench data G - e RN 8 ST ST e W

Tl 0w

(Fig. 1.13).  ——

4. Repeat Step 3 on each successive EMG s

cluster.
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Fig. 1.13 EMG data selection

5. Scroll to the second recording. The second recording begins at the append event marker labeled

6. Repeat Steps 3 and 4 for “Nondominant  ~Nondominant arm” and includes four clenches from Subject’s
arm” data. nondominant arm.

7. Scroll to the first recording. Tonus is the resting state, and is represented by the area between clenches

8. Use the I-Beam cursor to select the area  (Clusters). Fig. 1.14 below shows the selected area between clenches.
between the first and second clenches T —— . L — A ——
(Fig. 1.14). ' =

9. Repeat Step 7 between each successive

;e S

clench.
10. Scroll to the second recording. ! B \
11. Repeat Steps 7 — 8 for “Nondominant | = '

arm” data. . e |

m o0 m 4m 00 ) wm wm e W I
C L . : e
Fig. 1.14 Selection between clenches to measure tonus

12. Answer the questions at the end of the An electronically editable Data Report can be found in the journal

Data Report. (following the lesson summary,) or immediately following this Data
13. Save or Print the Data Report. Analysis section. Your instructor will recommend the preferred format for

your lab.

14. Quit the program.

END OF DATA ANALYSIS

END OF LESSON 1
Complete the Lesson 1 Data Report that follows.
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Gender: Male / Female

Dominant arm: Right / Left

DATA REPORT
Student’s Name:
Lab Section:
Date:
I. Data and Calculations
Subject Profile
Name: Height:
Age: Weight:
A. EMG Measurements
Table 1.1
Dominant arm Nondominant arm
Clench # [ mean | [ Mean |
1
2
3
4

B. Use the mean measurement from the table above to compute the percentage increase in EMG activity recorded
between the weakest clench and the strongest clench of Dominant arm.

Calculation: Answer: %
C. Tonus Measurements
Table 1.2
Between Dominant arm Nondominant arm
Clenches # [ Mean | [ Mean |
1-2
2-3
3-4
II. Questions
D. Compare the mean measurement for the right and left maximum clench EMG data.
Avre they the same or different? Same Different
Which one suggests the greater clench strength? Right Left Neither

Explain.
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E. What factors in addition to sex contribute to observed differences in clench strength?

F. Does there appear to be any difference in tonus between the two forearm clench muscles? Yes No

Would you expect to see a difference? Does Subject’s gender influence your expectations? Explain.

G. Explain the source of signals detected by the EMG electrodes.

H. What does the term “motor unit recruitment” mean?

I. Define skeletal muscle tonus.

J.  Define electromyography.
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I11. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials
C. Method
D. SetUp

E. Experimental Results

End of Lesson 1 Data Report
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INTRODUCTION

Mechanical work, in the physical sense, refers to the application of a force resulting in

the movement of an object. Skeletal muscle performs mechanical work when the i

muscle contracts and an object is moved, as in lifting a weight. To lift a weight, your m

muscles must exert a force great enough to overcome the weight. If you exert less force, { \&'} ;
| 9.

then the weight does not move (Fig. 2.1).

Physiologically, skeletal muscle is stimulated to contract when the brain or spinal cord
activates motor units of the muscle.

Fig. 2.1
Motor units are defined as a motoneuron and all of the muscle fibers that the

motoneuron innervates. An action potential (AP) in a human motoneuron always causes an action potential in all of
the muscle fibers of the motor unit. As a matter of fact, humans generally do not send just one AP at a time down a
motoneuron. Instead, a train of APs is sent — enough to induce tetany (the sustained fusion of individual muscle
twitches) in the muscle fibers of the motor unit.

(A discussion of motor units and their control was presented in Lesson 1.)

Most human skeletal muscles are composed of hundreds of motor units (Fig. 2.2). When a skeletal muscle is called on
to perform mechanical work, the number of motor units in the muscle activated by the brain is proportional to the
amount of work to be done by the muscle; the greater the amount of work to be done, the greater the number of motor
units activated. Thus, more motor units are simultaneously active when a skeletal muscle lifts 20 kilograms than when
the same muscle lifts 5 kilograms.
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N\ \& P Spinal Motor Unit . end
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Fig. 2.2 Example of Motor Units
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The brain determines the number of active motor units required for a muscle to perform a given task by utilizing
sensory information from stretch receptors in the muscle and associated tendons and joint capsules. For example, when
lifting a bucket of water from the ground, the brain first activates several motor units in the requisite skeletal muscles.
If sensory information returning from the muscles indicates the muscles are contracting but not developing adequate
power to lift the bucket, the brain activates additional motor units until the sensory information indicates the bucket is
being lifted. The sequential activation of motor units to perform a designated task is called motor unit recruitment.

Once you have lifted a light object, the brain recruits approximately the same number of motor units to keep the object
up, but cycles between different motor units. The muscle fibers consume stored energy available in the muscle, and
generate a force by contracting. As the muscle fibers deplete this fuel source, more energy must be created in order to
continue contracting. By recruiting different motor units, motor units can relax and replenish their fuel sources.

Skeletal muscles performing acute maximum work or chronic submaximum work of a repetitive nature will eventually
fatigue. Fatigue is defined as a decrease in the muscle’s ability to generate force. Fatigue is caused by a reversible
depletion of the muscle’s fuel supply. If the muscle uses its energy sources faster than they can be generated by
cellular metabolism, fatigue occurs. During contraction, skeletal muscle cells convert chemical energy into thermal
and mechanical energy, and, in the process, produce chemical waste products.

Normally the waste products are removed from the muscle by the circulatory system as the blood brings nutrients to
the muscle for energy transformation. If certain waste products (metabolites) are not removed at an adequate rate, they
will accumulate and chemically interfere with the contractile process, thereby hastening the onset of fatigue. Some
accumulated waste products also stimulate pain receptors in surrounding connective tissue and induce cramping of
skeletal muscle, a general sign of inadequate blood flow to the muscle.

In this lesson, you will examine motor unit recruitment and skeletal muscle fatigue by combining electromyography
with dynamometry.

When a motor unit is activated, the component muscle fibers generate and conduct their own electrical impulses,
which cause the fibers to contract. Although the electrical impulse generated and conducted by each fiber is very weak
(less than 100 pvolts,) many fibers conducting simultaneously induce voltage differences in the overlying skin which
are large enough to be detected by a pair of surface electrodes.

The detection, amplification, and recording of changes in skin voltage produced by underlying skeletal muscle
contraction is called electromyography, and the recording thus obtained is called an electromyogram (EMG).

The EMG signal is the recorded consequence of two principal bioelectric activities: 1) propagation of motor nerve
impulses and their transmission at the neuromuscular junctions of a motor unit, and 2) propagation of muscle impulses
by the sarcolemma and the T-tubular systems resulting in excitation-contraction coupling. The magnitudes of the
action potentials of active motor units are not all the same nor are they in phase with one another. Furthermore, the
timing sequence of motor unit activation is variable. The net result of these and other factors is a complex EMG
signal. Remember we are recording all of this activity as it is detected by surface electrodes, and propagation of
muscle and nerve impulses involves both depolarization and repolarization phenomena. The "spikes" therefore, will
have a negative and a positive component and the amplitudes will be influenced by the location of the recording
electrodes with respect to the number of active underlying skeletal muscle and motor nerve fibers.
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Fig. 2.3 EMG signal
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Integrated EMG

Fig. 2.4

Integrated EMG is an alternative view of the EMG signal that
clearly shows the pattern of muscle activity. Integrated EMG
“averages out” noise spikes in the raw EMG data to provide a
more accurate indication of the EMG output level. Integrated
EMG calculates a moving average (mean) of the EMG data by
first rectifying each point in the sample range (inverting all
negative values) and then computing the mean. In this lesson,
each data point of Integrated EMG is calculated using 100
samples of data from the EMG source, so the first 100 sample
points should be ignored since they reflect the number of zero
values being averaged in with the first few samples of data.

Power is defined as the amount of work done per unit of time. Dynamometry means the measurement of power (dyno
= power, meter = measure,) and the graphic record derived from the use of a dynamometer is called a dynagram.

In this lesson, the power of contraction of clench muscles will be determined by a hand dynamometer equipped with
an electronic transducer. Model SS25LA/L measures force in “kg” units; model SS56L measures proportionality of
bulb pressure to clench force in “kgf/m”2” units (a pressure unit). Both measures are accurate for the relative measures

recorded in this lesson.

The BIOPAC system will simultaneously record three bands of information:

1)  The force you exert on the transducer,

2) The electrical signal produced by the muscle during contraction, and
3) The integrated waveform, which is an indication of the activity levels of the muscle.
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Il. EXPERIMENTAL OBJECTIVES

1) To determine the maximum clench strength for right and left hands and compare differences between male and

female.

2) To observe, record, and correlate motor unit recruitment with increased power of skeletal muscle contraction.

3) To record the force produced by clench muscles, EMG, and integrated EMG when inducing fatigue.

I, MATERIALS
e BIOPAC Hand Dynamometer (SS25LA, SS25LB* or SS25L)

*SS25L B is compatible with software versions BSL 4.1 and higher only.

o0 Optional BIOPAC Hand Clench Force Pump Bulb (SS56L) may be used—ypressure in bulb is
proportional to clench force. For SS56L units, set the Clench Force Transducer Preference
BEFORE starting calibration.

BIOPAC Electrode Lead Set (SS2L)

BIOPAC Disposable Electrodes (EL503,) 6 electrodes per Subject

BIOPAC Electrode Gel (GEL1) and Abrasive Pad (ELPAD) or Skin cleanser or alcohol prep
Optional: BIOPAC Headphones (OUT1/OUT1A for MP3X or 40HP for MP45)

Biopac Student Lab System: BSL 4 software, MP36, MP35 or MP45 hardware

Computer system (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP

FAST TRACK Setup Detailed Explanation of Setup Steps

1. Turn your computer ON.

e If using an MP36/35 unit, turn it OFF.

e If using an MP45, make sure USB
cable is connected and “Ready” light
is ON.

2. Plug the equipment in as follows:
Electrode Lead Set (SS2L) — CH 1
Hand Dynamometer (SS25LA/LB or

SS25L)
or Clench Force Pump Bulb (SS56L) —

CH?2

Headphones (OUT1 or OUT1A*) — back
of unit

*QUT1A is compatible with MP36 only.
3. Turn ON the MP36/35 unit.

Page P-1

OUT1 OUT1A

) Fig. 2.5 MP3X (top) and MP45 (bottom) equipment connections
Setup continues...

©BIOPAC Systems, Inc.
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4. Clean and abrade skin. If the skin is oily, clean electrode sites with soap and water or alcohol
5. Attach three electrodes to each forearm ~ before abrading.
(Fig. 2.6). If the electrode is dry, apply a drop of gel.

6. Clip the Electrode Lead Set (SS2L) to the ~ For optimal electrode contact, place electrodes on the skin at least five
Subject’s dominant forearm, following the ~Minutes before the start of Calibration.
color code (Fig. 2.6).

7. Hold hand dynamometer with dominant
hand.

Clip the Lead Set (SS2L) to the Subject’s dominant forearm (Fig. 2.6) for
recordings 1 and 2.

Make sure electrode lead colors
match!

Fig. 2.6 Electrode Placement & Lead Attachment

= |If Subject is right-handed, the right forearm is generally dominant;
if the subject is left-handed, the left forearm is generally dominant.

= The pinch connectors work like a small clothespin and will only
latch onto the nipple of the electrode from one side of the connector.

e Subiject gets in a seated position,
facing the monitor.

Fig. 2.7 Proper Seating Position

= Arm holding the hand dynamometer should rest on thigh to relax
the muscles in the shoulder and upper arm.

Setup continues...
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8. Start the BIOPAC Student Lab Program.

9. Choose lesson “L02 — Electromyography

(EMG) 11” and click OK.
10. Type in a unique filename and click OK.

11. Make sure the picture in the journal
(Hardware tab) matches your setup. If it
does not, you may need to change
preference settings.

12. Optional: Set Preferences.
e Choose File > Lesson Preferences.
e Select an option.

o Select the desired setting and click
OK.

END OF SETUP

L02 — Electromyography (EMG) Il

Fig. 2.8 Positioning
Start Biopac Student Lab by double-clicking the Desktop shortcut.

Biopac
Student Lab
4.0

No two people can share the same filename, so use a unique identifier,
such as the subject’s nickname or student ID#.

A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a common folder.

The SS25LA picture represents both the SS25LA/LB and SS25L.
To change the preference, see next step.
This ends the Set Up procedure.

This lesson has optional Preferences for data and display while
recording. Per your Lab Instructor’s guidelines, you may set:
Clench Force Transducer: Choose model SS25LA/LB/L or SS56L
(Bulb)
Lesson Recordings: Specific recordings may be omitted based on
instructor preferences.

Page P-3
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B. CALIBRATION

The Calibration procedure establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for
optimal performance. Pay close attention to Calibration. For a video example of proper Calibration procedure, click the
Calibration tab in the Lesson > Set Up Journal.

FAST TRACK Calibration
1. Click Calibrate.

Detailed Explanation of Calibration Steps

You will be prompted to remove any grip force from the hand
dynamometer.

2. Set the hand dynamometer down and click  This will remove any clench force which is important for establishing a

OK.

. Hold the BIOPAC hand dynamometer with
dominant hand when prompted and click
OK.

SS25LA/B: Place the short grip bar against
the palm, toward the thumb, and wrap your
fingers to center the force.

SS25L: Grasp as close to the dynagrip
crossbar as possible without actually
touching the crossbar.

SS56L: WRAP your hand around the bulb
with relaxed fingers—do NOT curl fingers
into bulb.

IMPORTANT
Hold the dynamometer in the
same position for all
measurements from each arm.
Note your hand position for the first
recording and try to repeat it for

the subsequent recordings.

. When Calibration recording begins,
clench the hand dynamometer as hard as
possible for 2 sec. and then release.

. Wait for Calibration to stop.

. Verify recording resembles the example
data.

e If similar, click Continue and proceed
to Data Recording.

« If necessary, click Redo Calibration.

END OF CALIBRATION

zero force baseline.

Clench with the hand of your dominant forearm.

SS25LA/B grip position

/t]) ><§!\

SS56L grip position
Fig. 2.9

SS25L grip position

The program needs a reading of your maximum clench to establish
proper force increments (grid settings) used during the recordings.

Calibration lasts eight seconds.

Both channels should begin with a zero baseline and then there should be
a clear EMG “burst” and simultaneous increase in Clench Force when the
Subject clenched.

= If using SS25L/LA/B, units are kg; If using SS56L, units are kgf/m"2.

ek e

Fig. 2.10 Examplé"-Calibration data
If recording does not resemble the Example Data
= If the data is noisy or flatline, check all connections to the MP unit.

= If the hand dynamometer signal is not zero when relaxed, make sure
all grip force is removed until prompted.

= Verify electrodes are making good contact and that leads are clipped
to the correct color position with minimal cable strain.
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C. DATA RECORDING
FAST TRACK Recording

1. Prepare for the Dominant arm recording.

o Electrodes must be attached to
Subject’s dominant arm.

e Subject’s hand must be relaxed.

e Grip the hand dynamometer with
dominant hand.

e Review recording steps.

Dominant arm: Increasing clench force

e Calibrated grip force

2. Click Record.
3. Perform a series of Clench-Release-Wait
cycles until maximum grip force is reached

« Hold clench for two seconds, release
for two seconds.

o Use sufficient grip force on each cycle
to increase the force by one grid line
per clench.

Recording continues...

Detailed Explanation of Recording Steps

Four data recordings* will be acquired, two on each arm:

a. Recordings 1 and 3 record Motor unit recruitment.

b. Recordings 2 and 4 record Fatigue
In order to work efficiently, read this entire section, or review onscreen
Tasks to preview recording steps in advance.
*IMPORTANT
This procedure assumes that all lesson recordings are enabled in Lesson
Preferences, which may not be the case for your lab. Always match the
recording title to the recording reference in the journal and disregard any
references to excluded recordings.

When Continue is clicked following Calibration, the display will change
to show only the Clench Force channel, with grids displayed.

Based on maximum grip force during calibration, the software sets the
grid as follows:

SS25L/LA/LB Force Calibration (kg) Assigned Increment (kg)

0-25 5

25 -50 10

50-75 15

>75 20

SS56L Max Clench (kgf/im”2) Assigned Increment (kgf/m”2)
0-5,000 1,000

5,000 - 7,500 1,500

7,500 — 10,000 2,000

10,000 — 12.500 2,500

>12,500 3,000

Fig. 2.11 Example Increasing Clench Force data
= Completely relax grip force between clenches.

= Itis important to reach the first gridline on the first clench. Increase
grip on subsequent clenches to advance the force signal one gridline
per clench until maximum grip force is reached.

= A total of five clenches are used in the Example Data, but certain
Subjects may require a lesser or greater number of clenches to attain
maximum grip force.
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4. After maximum grip force is reached, click

L02 — Electromyography (EMG) Il Biopac Student Lab 4

Suspend.

5. Verify recording resembles the example data

above.

o If similar, click Continue and proceed

to Step 6.

If necessary, click Redo.
If all required recordings have been

completed, click Stop.

Dominant arm: Continued clench at

maximum force

Review recording steps.

6. Click Record.

7. Clen

possible and try to maintain maximum force.
8. Continue clenching until force has decreased

ch the hand dynamometer as hard as

by 50%.

9. Click Suspend.
10. Verify recording resembles the example

data.

If similar to Fig. 2.12, click Continue
and proceed to the next recording.

If necessary, click Redo.

If all required recordings have been
completed, click Stop.

Recording continues...

= The data must show multiple peaks of increasing clench force.

® The data shown above (Fig. 2.11) is from a Subject who was able to
maintain an even force throughout the clench. Your data may be
correct even if your peaks are not “flat.”

If recording does not resemble the Example Data

= If the data is noisy or flatline, check all connections to the MP unit.

Click Redo and repeat Steps 2 — 5 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

Note the maximum clench force so you can determine when the force
has decreased by 50%. (The maximum force may scroll out of view.) Try
to maintain the maximum clench force. (The forearm will fatigue and the
force will decrease.)

The time to fatigue to 50% of maximal clench force will vary greatly
among individuals.

Fig. 2.12 Example Fatigue data

Note that the peak found immediately following the start of the
recording represents the maximal clench force. This example shows the
point of fatigue to 50% maximal clench force captured on the same
screen, but maximum force may scroll out of view. Use the horizontal
(time) scroll bar to see the beginning of the recording.

If recording does not resemble the Example Data

= If the data is noisy of flatline, check all connections to the MP unit..

Click Redo and have the Subject rest arm for a few minutes. When
ready, repeat Steps 6 — 10. Note that once Redo is clicked, the most
recent recording will be erased.
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Nondominant arm: Increasing clench force

11

12.
13.

14,

15.

16.
17.

18.

19.

. Prepare for the Nondominant arm
recording.

e Clip electrode leads to Subject’s
nondominant arm.
e Subject’s hand must be relaxed.

e Grip hand dynamometer with
nondominant hand.

e Review recording steps.

Click Record.

Perform a series of Clench-Release-Wait
cycles.

After maximum grip force is reached, click
Suspend.

Verify recording resembles the example
data.

e If similar, click Continue and
proceed to the next recording.

 If necessary, click Redo.

e If all required recordings have been
completed, click Stop.

Nondominant arm: Continued clench at
maximum force
e Review recording steps.
Click Record.
Clench the hand dynamometer as hard as

possible and try to maintain maximum
force.

Continue clenching until force has
decreased by more than 50%.

Click Suspend.

Recording continues...

L02 — Electromyography (EMG) Il
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These recordings apply to the
nondominant forearm, following the
same procedure used for the dominant
forearm.

Disconnect the lead set (SS2L) from
the electrodes on the “dominant™
forearm and connect to electrodes on
“nondominant” forearm per Fig. 2.13.

Fig. 2.13 Electrode lead
attachment

Follow Color Code!

Repeat a cycle of Clench-Release-Wait, holding for two seconds and
waiting for two seconds after releasing before beginning the next cycle.
Begin with your Assigned Increment of force (first grid) and increase by
the Assigned Increment for each cycle until maximum clench force is
obtained.

Fig. 2.14 Example Increasing Clench Force data
If recording does not resemble the Example Data

= If the data is noisy or flatline, check all connections to the MP unit.

Click Redo and repeat Steps 12 — 15 if necessary. Note that once Redo
is clicked, the most recent recording will be erased.

Note the maximum clench force so you can determine when the force
has decreased by 50%. (The maximum force may scroll out of view.) Try
to maintain the maximum clench force. (The forearm will fatigue and the
force will decrease.)

The time to fatigue to 50% of maximal clench force will vary greatly
among individuals.
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20. Verify recording resembles the example
data.

e If similar to Fig. 2.15, click
Continue to proceed to the optional
recording section, or click Stop to
end the recording.

e If necessary, click Redo.

OPTIONAL ACTIVE LEARNING PORTION

e To listen to the EMG signal, proceed
to Step 21.

e To skip listening to the EMG signal
and end the recording, proceed to
Step 24.

Recording continues...

Fig. 2.15 Example Fatigue data
If recording does not resemble the Example Data

= If the data is noisy or flatline, check all connections to the MP unit.

Click Redo and have the Subject rest arm for a few minutes. When
ready, repeat Steps 16 — 20. Note that once Redo is clicked, the most
recent recording will be erased.

With this lesson you may record additional data by clicking Continue
following the last recording. Design an experiment to test or verify a
scientific principle(s) related to topics covered in this lesson. Although
you are limited to this lesson’s channel assignments, the electrodes may
be moved to different locations on the Subject.

Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each
step to make it easy to follow during recording.

Run Your Experiment
D. SetUp

Set up the equipment and prepare the subject for your experiment.
E. Record

Use the Continue, Record and Suspend buttons to record as much
data as necessary for your experiment.

Click Stop when you have completed all of the recordings required
for your experiment.

Analyze Your Experiment

F. Set measurements relevant to your experiment and record the
results in a Data Report.

Listening to the EMG is optional.

Listening to the EMG can be a valuable tool in detecting muscle
abnormalities, and is performed here for general interest. Data on screen
is not saved.
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21. Click Listen to record EMG data and hear  The EMG signal will be audible through the headphones as it is being

it through the headphones. displayed on the screen. The screen will display two channels:
22. Increase clench force and notice how the CH 1 EMG and CH 41 Clench Force
volume increases. The signal will run until Stop is clicked. If others in your lab group

would like to hear the EMG signal, pass the headphones around before
clicking Stop or click Redo and then Stop when done.

23. Click Stop when finished. This will end listening to the EMG.
e Click Redo to hear EMG again.

24. Click Done to end the lesson. If choosing the Record from another Subject option:
25. Choose an option and click OK. " Repeat Setup Steps 4 — 7 and proceed to Calibration.
26. Remove the electrodes. Remove the electrode cable pinch connectors, and peel off all electrodes.

Discard the electrodes (BIOPAC electrodes are not reusable). Wash the
electrode gel residue from the skin, using soap and water. The electrodes
may leave a slight ring on the skin for a few hours, which is quite

END OF RECORDING normal.
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V. DATA ANALYSIS

FAST TRACK Data Analysis

1. Enter the Review Saved Data mode

¢ Note Channel Number (CH)
designations:

Channel Displays

CH1 EMG (hidden*)
CH 40 Integrated EMG
CH 41 Clench Force

» Note measurement settings:

Channel  Measurement
CH 41 Mean

CH 40 Mean
CH41 Value

CH 40 Delta T

Analysis of Increasing Clench Force

2. Setup your display for optimal viewing of
“Dominant arm: Increasing clench force”
data.

3. Read the journal and note your force
increment in the Data Report.

g A

Data Analysis continues....
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Detailed Explanation of Data Analysis Steps
If entering Review Saved Data mode from the Startup dialog or Lessons
menu, make sure to choose the correct file.
The data window should resemble Fig. 2.16.
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Fig. 2.16 Example data
The measurement boxes are above the event marker region in the data
window. Each measurement has three sections: channel number,
measurement type, and result. The first two sections are pull-down menus
that are activated when clicked.
Brief definition of measurements:
Mean: Displays the average value in the selected area.

Value: Displays the amplitude value at the point selected by the I-beam
cursor. If an area is selected, displays the value of the endpoint based on the
direction the cursor was dragged.

Delta T: Measures the difference in time between the end and beginning
of the selected area.

The “selected area” is the area selected by the I-Beam tool (including
endpoints)

Note: The append event markers # mark the beginning of each
recording. Click (activate) the event marker to display its label.

Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom Back,
Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)

Cursor Tools: Zoom Tool

Buttons: Overlap, Split, Show Grid, Hide Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click” (Mac)
the channel number box to toggle channel display.

The Journal summary shows the force increment used in your recordings.
The grid divisions should use the same increment. Note this increment in
Table 2.1 in the second column, Force (kg) Increments for Peak #1. For
subsequent peaks, add the increment (i.e., 5, 10, 15 kg or 10, 20, 30 kg).

©BIOPAC Systems, Inc.
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. Use the 1-Beam cursor to select an area on
the plateau phase of the first clench (Fig.
2.17).

g A

. Repeat Step 4 on the plateau of each
successive clench.

g A

Scroll to marker labeled “Nondominant
arm: Increasing clench force” and set up
your display for optimal viewing.

Repeat Steps 3 — 4 for this recording.

Analysis of Continued Clench

. Scroll to “Dominant arm: Continued
clench at maximum force” and set up your
display for optimal viewing.
Use the I-Beam cursor to select a point of
maximal clench force immediately
following the start of the recording (Fig.
2.18).

Sl s

10. Calculate 50% of the maximum clench
force from Step 9.

Sl s

11. Find the point of 50% maximum clench
force by using the I-beam cursor and leave
the cursor at this point.

Data Analysis continues....

L02 -
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Fig. 2.17 Plateau of first clench selected

This recording begins at the append event marker labeled “Dominant
arm: Continued clench at maximum force.”
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Fig. 2.18

The point selected should represent the maximal clench force at the start
of continuous maximal clench recording, as shown in Fig. 2.18.

This number is necessary in order to complete Step 11.

Make an eyeball approximation of the point that is 50% down from the
maximal clench point. Then, use the I-beam cursor to click points near
this region, noting the value displayed in the measurement box, until you
are on a point within 5% of the maximal clench force. Leave the cursor
at this point.
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12.

13.

14.

15.
16.

Select the area from the point of 50%
clench force back to the point of maximal
clench force by using the I1-beam cursor
and dragging (Fig. 2.19). Note the time to
fatigue measurement (CH 40 Delta T).

g s

Scroll to marker labeled “Non dominant
arm: Continued clench at maximum
force” and set up your display for optimal
viewing.

Repeat Steps 8 — 12 for this recording.

Answer the questions at the end of the Data
Report.

Save or Print the data file.
Quit the program.

END OF DATA ANALYSIS

L02 — Electromyography (EMG) Il
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One way to select the area is as follows: The cursor should be flashing
on the point of 50% maximal clench force. Hold down the mouse button
and drag to the left of this point until you reach the point of maximal
clench force, then release the mouse button.

Note: You do not need to indicate the Delta T polarity as it only reflects
the direction the "1-beam" cursor was dragged to select the data. Data
selected left to right will have a positive ("+") polarity, while data
selected right to left will have a negative ("-") polarity.
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Fig. 2.19 showing area max-50%

An electronically editable Data Report is located in the journal
(following the lesson summary,) or immediately following this Data
Analysis section. Your instructor will recommend the preferred format
for your lab.

END OF LESSON 2

Complete the Lesson 2 Data Report that follows.
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ELECTROMYOGRAPHY II

e Motor unit recruitment and Fatigue

DATA REPORT

Student’s Name:

Biopac Student Lab 4

Lab Section:

Date:

Subject Profile
Name:
Age:

Height:
Weight:

l. Data and Calculations

Motor Unit Recruitment

Gender:

Male / Female

Dominant arm: Right/ Left

A. Complete Table 2.1 using Dominant arm and Nondominant arm data. In the "Force (kg) Increments"
column, note the force increment assigned for your recording under Peak #1; the increment was pasted to the
Journal and should be noted below from Data Analysis—Step 2. For subsequent peaks, add the increment (i.e.,

500, 1000, 1500). You may not need eight peaks to reach max.

Table 2.1 Increasing Clench Force Data

Assigned (Dominant arm) (Nondominant arm)
pPeak  Force Increment Force at Peak Integrated EMG Force at Peak Integrated EMG
# SS25L/LA = Kg (mV) (mV)
SS56L = kgf/m"2 [ Wean || 6] v |
1
2
3
4
5
6
7
8
Fatigue
B. Complete Table 2.2 using Dominant arm and Nondominant arm data.
Table 2.2 Maximum Clench Force Data
(Dominant arm) (Nondominant arm)
Maximum 50% of Max Time to Maximum 50% of Max Time to
Clench Force Clench Force Fatigue Clench Force Clench force fatigue
calculate [ DetaT | [ vaue | calculate
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I. Questions
C. Isthe strength of your right arm different than your left arm? Yes No
D. Isthere a difference in the absolute values of force generated by males and females in your class? Yes No

What might explain any difference?

E. When holding an object, does the number of motor units remain the same? Are the same motor units used for
the duration of holding the object?

F. As you fatigue, the force exerted by your muscles decreases. What physiological processes explain the decline in
strength?

G. Define Motor unit

H. Define Motor unit recruitment

I. Define Fatigue

J. Define EMG

K. Define Dynamometry
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I11. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials

C. Method

D. SetUp

E. Experimental Results

End of Lesson 2 Data Report
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I. INTRODUCTION

The brain is encased by the cranium, bones of the skull which immediately cover and protect brain surfaces. A thin cover of
skin, called the scalp, covers most of the cranium. The largest part of the brain immediately beneath the bones of the cranium
is the cerebral cortex. The cerebral cortex is composed of nerve cells (neurons,) many of which are functionally connected
to each other, and connected to other parts of the brain. Electrical activity in the form of nerve impulses being sent and
received to and from cortical neurons is always present, even during sleep. In a biological sense (as well as a medical or legal
sense,) absence of electrical activity in the human cerebral cortex signifies death.

Functions of the cerebral cortex include abstract thought, reasoning, voluntary and involuntary control of skeletal muscle, and
the recognition and differentiation of somatic, visceral, and special sensory stimuli. Specific regions of the cerebral cortex
process or generate various kinds of information. For example, the occipital lobe processes visual information while the
parietal lobe processes somatosensory information such as cutaneous pain or temperature (Fig. 3.1).

CentraE sulcus

Parietal lobe
Frontal lobe

Occipital lobe

Cerebellum

Fig. 3.1 Regions of the brain

The sensory information is relayed from the periphery through lower centers in the brain, and then the information is sent to
various regions of the cerebral cortex. Since the cerebral cortex is just under the cranium, electrodes placed on the scalp
above the various regions of the brain can detect the electrical activity associated with functioning neurons. The recording of
the brain’s activity obtained by using electrodes is called electroencephalogram or EEG (electro = electrical, encephelo =
brain, gram = record).

An EEG electrode will mainly detect the activity in the brain region just under it. Nevertheless, the electrodes receive the
activity from thousands of neurons. In fact, one square millimeter of cortex has more than 100,000 neurons. Since each
region of the cerebral cortex of an alert person is busy receiving, integrating, and sending many impulses, this activity is
detected in the EEG. (For more information about waveforms, see “Waveform Concepts” in the BSL Tutorial.)

It is only when the input to a region is synchronized with electrical activity occurring at the same time that you begin to

distinguish simple, periodic waveforms in an EEG.
In 1929, an Austrian physician named Hans Berger discovered that electrodes placed on the scalp could
detect various patterns of electrical activity. After verifying that the recordings were indeed recording from
the brain, and were not artifacts of muscle or scalp, scientists began to study these “brain waves.” Today,
the EEG is still a medically useful recording for brain function. In medical and basic research, the correlation
of particular brain waves with sleep phases, emotional states, psychological profiles, and types of mental
activities is ongoing.

Four simple periodic rhythms recorded in the EEG are alpha, beta, delta, and theta. These rhythms are identified by

frequency (Hz or cycles/sec) (Table 3.1). The amplitudes recorded by scalp electrodes are in the range of microvolts (uV or
1/1,000,000 of a volt).

Page I-1 ©BIOPAC Systems, Inc.
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Table 3.1 Typical Frequencies of Synchronized Brainwaves

Rhythm Typical Frequencies (Hz)
alpha 8-13
beta 13-30
delta 1-5
theta 4-8

Alpha

The four basic rhythms have been associated with various states. In general, the alpha rhythm is the prominent EEG
wave pattern of an adult who is awake but relaxed with eyes closed. Each region of the brain has a characteristic alpha
rhythm but alpha waves of the greatest amplitude are recorded from the occipital and parietal regions of the cerebral
cortex. Results from various studies indicate that:

o females tend to have higher mean frequencies of alpha waves than males
e alpha wave amplitudes are likely to be higher in “outgoing” subjects
e alpha wave amplitudes vary with a subject’s attention to mental tasks performed with the eyes closed

In general, amplitudes of alpha waves diminish when subjects open their eyes and are attentive to external stimuli
although some subjects trained in relaxation techniques can maintain high alpha amplitudes even with their eyes open.

Beta

Beta rhythms occur in individuals who are alert and attentive to external stimuli or exert specific mental effort, or
paradoxically, beta rhythms also occur during deep sleep, REM (Rapid Eye Movement) sleep when the eyes switch back
and forth. Notice that the amplitude of beta rhythms tends to be lower than for alpha rhythms. This does not mean that
there is less electrical activity, rather which the “positive” and “negative” activities are starting to counterbalance so that
the sum of the electrical activity is less. Thus, instead of getting the wave-like synchronized pattern of alpha waves,
desynchronization or alpha block occurs. So, the beta wave represents arousal of the cortex to a higher state of
alertness or tension. It may also be associated with “remembering” or retrieving memories.

Delta and Theta

Delta and theta rhythms are low-frequency EEG patterns that increase during sleep in the normal adult. As people move
from lighter to deeper stages of sleep (prior to REM sleep,) the occurrence of alpha waves diminishes and is gradually
replaced by the lower frequency theta and then delta rhythms.

Although delta and theta rhythms are generally most prominent during sleep, there are cases when delta and theta
rhythms are recorded from individuals who are awake. For example, theta waves will occur for brief intervals during
emotional responses to frustrating events or situations. Delta waves may increase during difficult mental activities
requiring concentration. In general, the occurrence and amplitudes of delta and theta rhythms are highly variable within
and between individuals.

Electrode positions

Electrode positions have been named according to the brain region below that area of the scalp: frontal, central (sulcus,)
parietal, temporal, and occipital. In the bipolar method, the EEG is measured from

a pair of scalp electrodes. The pair of electrodes measures the difference in electrical potential (voltage) between their two
positions above the brain. A third electrode is attached behind the ear as a point of reference, ‘ground’, of the body’s baseline
voltage due to other electrical activities within the body.

In today’s lesson, you will record an EEG using the bipolar method.
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Il. EXPERIMENTAL OBJECTIVES

1) Torecord an EEG from an awake, resting subject with eyes open and eyes closed.
2) To identify and examine alpha, beta, delta, and theta components of the EEG complex.

I11. MATERIALS

e BIOPAC electrode lead set (SS2L)
e BIOPAC Disposable Electrodes (EL503,) 3 electrodes per subject
e BIOPAC Electrode Gel (GEL1) and Abrasive Pad (ELPAD) or Skin cleanser or alcohol prep

e Lycra® swim cap (such as Speedo® brand) or supportive wrap (such as 3M Coban™ Self-adhering Support
Wrap) to press electrodes against head for improved contact

e Biopac Student Lab System: BSL 4 software, MP36, MP35 or MP45 hardware
e  Computer system (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP
FAST TRACK Setup Detailed Explanation of Setup Steps

1. Turn the computer ON.
e If using an MP36/35 unit, turn it OFF.

o If using an MP45, make sure USB
cable is connected and “Ready” light
is ON.

2. Plug the equipment in as follows:

o Electrode Lead Set (SS2L)—Electrode
Check (MP3x only. For MP45, plug
into CH 1.)

3. Turn ON the BIOPAC MP36/35 unit.

Fig. 3.2 MP3X (top) and MP45 (bottom) hardware connections

Setup continues...

Page P-1 ©BIOPAC Systems, Inc.
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4.

Position electrodes on the scalp.

L03 - Electroencephalography (EEG) |

Fig. 3.3 shows a sample configuration.

IMPORTANT
Good electrode contact with
scalp is crucial for obtaining a
meaningful EEG recording.

Clip the Electrode Lead Set following the

color code in Fig. 3.3.

Place cap/wrap on Subject’s head to press
electrodes into scalp (Fig. 3.4).

Setup continues...

Biopac Student Lab 4

Fig. 3.3

Guidelines for electrode placement:

The placement of the scalp electrodes can vary (within limits)
depending on your instructor’s or Subject’s preference.

Keep the electrodes on one side (right or left) of the head.

The third electrode is the ground electrode and is placed over
the Mastoid region (behind the ear).

Hints for obtaining optimal data:

As much as possible, move (part) the hair away from the
electrode area to ensure the electrode makes contact with the
scalp.

Gently abrade skin at the electrode sites.

Apply some gel to the electrode. (A fair amount of gel must be
used to obtain a good electrode to scalp connection.)

Apply pressure to the electrodes for about 1 minute after the
initial placement.

Subject must remain still. Blinking and other movement will
affect the recording of all four rhythms.

Despite your best efforts, electrode adhesion may not be strong
enough to record data; try another Subject or different electrode
placement.

The pinch connectors work like a small clothespin, but only latch onto

the nipple of the electrode from one side of the connector.
Drape the electrode cables over the head so that they are not pulling on

the electrodes.

The cap or wrap should be snug but not uncomfortably tight.

Place a Lycra® swim
cap or supportive
wrap on Subject’s
head to press the
VIN+ and VIN-
electrodes against the
scalp with a constant
pressure. Subject
should not press
electrodes against
scalp.
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Fig. 3.4

Armres F : - q Subject should be seated and relaxed. Ideally, the room should be
It ggt) Subject in proper seating position (Fig. reasonably quiet to help Subject mentally relax.

8. Wait five minutes to allow Subject to i
relax, and for electrodes to establish proper '
contact.

Fig. 3.5 Positioning

9. Start the Biopac Student Lab Program. Start Biopac Student Lab by double-clicking the Desktop shortcut.

10. Choose “L03 - Electroencephalography
(EEG) I” and click OK.

11. Type in a unique filename and click OK.

Biopac
Student Lab
4.0

No two people can have the same filename, so use a unique identifier,
such as Subject’s nickname or student ID#.

A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a common folder.
12. Optional: Set Preferences. This lesson has optional Preferences for data and display while
« Choose File > Lesson Preferences. recording. Per your Lab Instructor’s guidelines, you may set:
« Select an option. Grids: Show or hide gridlines

« Select the desired setting and click Lesson Recordings: Specific recordings may be omitted based on
OK. instructor preferences.

END OF SETUP
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B. CALIBRATION

L03 - Electroencephalography (EEG) |

Biopac Student Lab 4

The Calibration procedure establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for
optimal performance. Pay close attention to Calibration.

FAST TRACK Calibration

1. Subject remains relaxed with eyes closed

during Calibration.

2. Check Electrode Impedance. (Optional*)

*Only functional if your MP
hardware is compatible with the
Electrode Check feature. If your
MP hardware is not compatible,
this feature will not be available.

Please contact BIOPAC Technical
Support for more information on
how to enable Electrode Check

functionality.

IMPORTANT
Certain subjects may not fall
below the 10 K ohm reading. This
reading is subject to individual
variations in skin conductivity and
electrode placement.

3. Click Calibrate.

4. During Calibration Subject must:

o Remain seated, relaxed and still,
with eyes closed.

o Wait for Calibration to stop.
5. Verify recording resembles the example
data.

o If similar, click Continue and
proceed to Data Recording.

o If necessary, click Redo
Calibration.

END OF CALIBRATION

Detailed Explanation of Calibration Steps

This step is optional and not
applicable to MP45 hardware.

*+ [Red] 1o GHD Bk

1000k

Use Check Electrode Impedance
to check the Subject’s skin
conductivity. This opens the
Electrode Checker panel and
displays skin resistance in k ohm. BB

TEI k

File Display Lessons Help
EC!

Check Electrode Impedance | Calibrate |

To use:

. 989 xO
= Make sure the SS2L is

987 xQ

.—
W

it 1o CHID (Back)

plugged into the MP unit’s
Electrode Check input.

= Click Check Electrode
Impedance button.

= Ideally, both readings
should be similar and
below 10 k ohm. (See Fig.
3.6)

= When finished, be sure to
remove the SS2L from the
Electrode Check input and
plug into the CH 1 input
before continuing (right).

Fig. 3.6

Calibration lasts eight seconds.

The baseline should be relatively stable around 0 uV.

Fig. 3.7 Example Calibration data

If the data shows excessive baseline drift or large spikes, make sure the
electrodes are making good contact with the scalp and that the cables are

not pulling on the electrodes.
Click Redo Calibration and repeat Steps 3 — 5 if necessary.
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C. DATA RECORDING
FAST TRACK Recording

1. Prepare for the recording.

e Subject remains seated, relaxed and
still, with eyes closed.

* Review recording steps.

2. Click Record.

e Subject remains seated, relaxed and
still, with eyes closed.

e Record for 20 seconds.

o Director presses F4 and cues
Subiject to open eyes.

o Record for an additional 20 seconds.

o Director presses F5 and cues
Subiject to close eyes.

e Record for an additional 20 seconds.

3. Click Suspend.

4. Verify recording resembles the example
data.

o |f similar, click Continue and
proceed to the optional recording
section, or click Done to finish.

o If necessary, click Redo.

Recording continues...

L03 - Electroencephalography (EEG) |
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Detailed Explanation of Recording Steps

This lesson will record the “raw” (full bandwidth) EEG while the
Subject is relaxed with eyes closed, eyes opened, and eyes closed again.
The alpha, beta, delta and theta channels are simultaneously recorded,
but are hidden by default. Hidden channels may be displayed during the
recording by holding down the “Alt” (PC) or “Option” (Mac) key when
clicking on the channel button.
To work efficiently, read this entire section before recording, or review
onscreen Tasks to preview recording steps in advance.
Hints for obtaining optimal data:

= Subject should be seated and relaxed to keep muscles still,

especially facial muscles. (Do not talk.)

=  Subject must try not to blink during “Eyes Open” portion of
recording.

= Subject should try to relax mentally; i.e. think of a relaxing

place.

Q_ Biopac Student Lab® - L0
File | Digplay  Lessans Help
Autoscale Waveforms
Autoscale Horizontal

Note: Display > Autoscale Waveforms
and Autoscale Horizontal are available
DURING recordings to allow scale
changes if necessary.

i EreyinuE
Zoan Hest
Hefrest Erapt

Ellﬂlzu

The Director instructs Subject to change the eye condition for 20-
second intervals, and inserts an event marker at each change.

First 20 seconds (secs. 0 — 20)
Subiject is relaxed, with eyes closed for the first 20 seconds.
Next 20 seconds (secs. 21 — 40)

Director presses F4 to insert a marker labeled “Eyes Open” and
cues Subject to open eyes and try not to blink for the next 20
seconds.

After another 20 seconds (secs. 41 — 60)

Director presses F5 to insert a marker labeled “Eyes Closed” and
cues Subject to close eyes for the next 20 seconds.

- CH1EEG
CH 40 alpha
CH 41 beta
CH 42 delta

| I " | 1 [l f i
i g Y ff“.“qf’l”‘h'w"wﬂﬂ" ﬁim.wl‘é*'w‘i{:ﬁh‘*:‘“ CH 43 theta
Ii

Fig. 3.8 Example data

Verify recording shows variation between the
“Eyes Open” and “Eyes Closed” recordings.
Note: To check the data, it may be necessary to
show one or more of the hidden frequency bands.
To activate, hold down the Alt (PC) or Option
(Mac) key when clicking on the channel button.
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OPTIONAL ACTIVE LEARNING PORTION

5. After clicking Done, choose an option and

6.

click OK.

Remove electrodes.

END OF RECORDING

L03 - Electroencephalography (EEG) | Biopac Student Lab 4

If recording does not resemble the Example Data

= |f the data is noisy or flatline, check all connections to the MP unit.
= If there is excessive baseline drift or large spikes:

=  Check that electrodes are making good contact with the scalp, cap or
wrap is snug and that the cables are not pulling on the electrodes.

= Subject must remain as still as possible.

=  Try relaxation techniques, such as slow breathing or relaxing
muscles.

Click Redo and repeat Steps 2 — 4 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

With this lesson you may record additional data by clicking Continue
following the last recording. Design an experiment to test or verify a
scientific principle(s) related to topics covered in this lesson. Although
you are limited to this lesson’s channel assignments, the electrodes may
be moved to different locations on the Subject.

Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each
step to make it easy to follow during recording.

Run Your Experiment
D. SetUp
Set up the equipment and prepare the subject for your experiment.
E. Record
Use the Continue, Record and Suspend buttons to acquire as many
recordings as necessary for your experiment.
Click Done when you have completed all of the recordings required
for your experiment.
Analyze Your Experiment

F. Set measurements relevant to your experiment and record the
results in a Data Report.

If choosing the Record from another Subject option:
=  Continue the entire lesson from Setup Step 4.

Remove cap or wrap, the electrode cable pinch connectors, and peel off
all electrodes. Discard the electrodes. (BIOPAC electrodes are not
reusable.) Wash the electrode gel residue from the skin, using soap and
water. The area around the electrode sites may remain red for a few
hours, which is quite normal.
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V. DATA ANALYSIS
FAST TRACK Data Analysis Detailed Explanation of Data Analysis Steps
1. Enter the Review Saved Data mode. If entering Review Saved Data mode from the Startup dialog or lessons
menu, make sure to choose the correct file.
» Note Channel Number (CH) T M —— W — W——

designations. " T
Channel Displays H ' [

CH1  EEG (hidden®) L ey

CH40 alpha e
CH41  beta F n i .
CH42  delta [ ) ) - R |
& " ” e ' 3 | " Y

CH 43 theta [ (] B mm nm T o ET) am am £ £ e

¢ Note measurement box settings: Fig. 3_9“;‘Xample data
Channel  Measurement The EEG channel is hidden but can be easily brought into view. (See
CH40  Stddev Step 2.)
CH41  Stddev The measurement boxes are above the marker region in the data
CH42  Stddev window. Each measurement has three sections: channel number,

measurement type, and result. The first two sections are pull-down
menus that are activated when you click them.
Brief definition of measurements:

Stddev: Standard deviation is a measure of the variability of data
points. The advantage of the Stddev measurement is that extreme
values or artifacts do not unduly influence the measurement.

Freq: Converts the time segment of the selected area to frequency in
cycles/sec.

The “selected area” is the area selected by the I-beam tool (including
endpoints).

CH43  Stddev
SC Freq

2. Set up your display window for optimal Useful tools for changing view:

viewing of the channels 40 — 43. Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom
Back, Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)
Cursor Tools: Zoom Tool
Buttons: Overlap, Split, Show Grid, Hide Grid, +, -

Hide/Show Channel: “Alt + click” (Windows) or “Option + click”
(Mac) the channel number box to toggle channel display.

3. Use the I-Beam cursor to select the first This is the data from the time 0 to the first event marker.
“Eyes closed” data. o Do IEorme e BT S B

Data Analysis continues... Fig. 3.10 First Eyes Closed data
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10.

11.

12.

13.
14.

Repeat Step 3 using “Eyes open” data.

g A

Repeat Step 3 using the second “Eyes
closed” data.

g A

Zoom in on a 3 — 4 second section of the
first “Eyes closed” data.

Use the I-beam cursor to select an area that
represents one cycle in the alpha wave
(Fig. 3.11).

g s

Repeat Step 7 for two other alpha wave
cycles.

9.

Repeat Steps 7 — 8 using the beta wave
data.

g s

Repeat Steps 7 — 8 using the delta wave
data.

g s

Repeat Steps 7 — 8 using the theta wave
data.

g s

Answer the questions at the end of the Data
Report.

Save or Print the Data Report.
Quit the program.

END OF DATA ANALYSIS
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This is the data between the first and second event markers.

This is the data between the second event marker and the end of the file.

Accurate Frequency calculation requires a selected area of only one
cycle.

WO EEEe - tosnmwv NS B LTS A2 [ e S nasow G S0 - 05T S0 MR - 5

[ theea

)
secords

Fig. 3.11 Selected area shows one cycle of the alpha wave.

Make sure you stay in the first “Eyes Closed” data region.

Click the cursor/pointer into the beta wave region to select this channel
for “SC” measurements. (Channel label will darken.)

Click the cursor/pointer into the delta wave to select this channel for
“SC” measurements.

Click the cursor/pointer into the theta wave to select this channel for
“SC” measurements.

An electronically editable Data Report is located in the journal
(following the lesson summary,) or immediately following this Data
Analysis section. Your instructor will recommend the preferred format
for your lab.

END OF LESSON 3

Complete the Lesson 3 Data Report that follows.
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DATA REPORT
Student’s Name:
Lab Section:
Date:

l. Data and Calculations

Subject Profile
Name: Height:

Age: Gender: Male / Female Weight:

A. EEG Amplitude Measurements from Standard Deviation measurements
Table 3.2 Standard Deviation [Stddev]

Rhythm CH Measurement Eyes Closed Eyes Open Eyes Re-closed

Alpha

Beta | [ai] [ Stddev |

Delta | [42] | Stddev |

Theta @

B. EEG Frequency Measurements from first ‘Eyes closed’ data
Table 3.3 Frequency (Hz)

Rhythm CH Measurement Cycle 1 Cycle 2 Cycle 3 Mean

Apha | [SC]

Beta

Delta (sc][ Freqg |

Theta | 58]

Il. Questions

C. Listand define two characteristics of regular, periodic waveforms.

Page P-3

D. Compare and contrast synchrony and alpha block.
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E. Examine the alpha and beta waveforms for change between the “eyes closed” state and the “eyes open” state.

i. Does desynchronization of the alpha rhythm occur when the eyes are open?

ii. Does the beta rhythm become more pronounced in the “eyes open” state?

F. The amplitude measurements (Stddev) are indicative of how much alpha activity is occurring in Subject. But,
the amplitude values for beta do not truly reflect the amount of mental activity occurring with the eyes open.
Explain.

G. Examine the delta and theta rhythm. Is there an increase in delta and theta activity when the eyes are open?
Explain your observation.

H. Define the following terms:

i. Alpharhythm

ii. Betarhythm

iii. Delta rhythm

iv. Theta rhythm
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I11. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials
C. Method
D. SetUp

E. Experimental Results

End of Lesson 3 Data Report
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I. INTRODUCTION

The brain constantly receives sensory input and integrates the information. The sensory information is relayed from the
periphery through lower centers in the brain, and then the information is sent to specific regions of the cerebral cortex where
it is processed. For example, the occipital lobe processes visual information while the parietal lobe processes non-visual,
sensory information such as cutaneous pain (Fig. 4.1). If you choose to, you can direct your attention to particular bits of
sensory information; you can access memories associated with the sensory information; or you can selectively ignore this
sensory input.

The blood/brain barrier separates cerebral spinal fluid from the blood. Oxygen, glucose, and carbon dioxide can cross the
blood/brain barrier, but unbound protons (H") cannot. The brain requires
oxygen and glucose for energy. Without a relatively constant source of
oxygen and glucose, the brain ceases to function. Levels of carbon
dioxide in the spinal fluid can change the pH of the spinal fluid, which
can in turn change the body’s respiration rate.

Centra} sulcus

Frontal lobe

Because brain activity is related to ions and charge movement, this
activity can be detected by electrodes. The record of the brain’s activity
is called an electroencephalogram (EEG) from the root words of electro
(electrical,) encephalo (brain,) and gram (record).

Fig. 4.1 Brain anatomy

The EEG records the electrical activity on the surface of the cerebral cortex. The EEG is complex and variable between
adults, although under certain conditions, the EEG exhibits simpler, rhythmic activity. Simpler patterns in the EEG occur
when many cells synchronize their input to the surface of the cerebral cortex. The more synchronized the charge movement,
the more rhythmic the EEG.

Your EEG changes as you grow. The development of EEG is rapid with newborns. As neural development
proceeds, the EEG recorded from the posterior regions of the brain of an infant of 3-4 months begins to
m resemble EEGs recorded from the posterior region of adults. The difference is that the 3-4 month old
infants have EEGs in the frequency range of 3-4 Hz, whereas adults tend to have average frequencies of
10 Hz. By the time the infant is one year old, the posterior region EEG is approximately 6 Hz, by three
years, 8 Hz, and by 13-14 years (puberty,) the average frequency is 10 Hz (similar to adults).
One of the simpler patterns is the alpha rhythm. The alpha rhythm is characterized by a frequency of 8-13 Hz and

amplitudes of 20-200 uV. Each region of the brain has a characteristic frequency of alpha rhythm. Alpha waves of the
greatest amplitude tend to be recorded from the occipital and parietal regions of the cerebral cortex.

Just as the EEG is variable depending upon the mental state of an individual, the frequency and amplitude of alpha
rhythms within an individual change as well. In general, the alpha rhythm is the prominent EEG wave pattern of an
adult in a relaxed, inattentive state with eyes closed.

More specific conditions of alpha rhythms are listed below:

e Hyperventilation (breathing abnormally quickly and deeply) causes the gas composition of the blood to
change. During hyperventilation, the carbon dioxide levels of the blood fall, pH levels increase, and
blood pressure decreases. These effects of hyperventilation are associated with changes in brainwave
activity. With hyperventilation, the overall electrical activity of the brain increases, with the amplitude of
the alpha rhythms often increasing as well.

e  Females tend to have higher mean frequencies of alpha waves than males, although the differences are
small.

Page I-1 ©BIOPAC Systems, Inc.
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e  Frequency may affect the speed of “remembering” during memory tests and may be approximately 1 Hz
higher for high-scoring subjects than subjects who scored lower.

e Amplitudes tend to be higher in subjects who are more “outgoing” and extroverted.
e Amplitudes vary with the difficulty of mental tasks performed with the eyes closed.

e Amplitudes of alpha waves diminish when subjects open their eyes and are attentive to external stimuli.
Thus, instead of getting the wave-like synchronized pattern of alpha waves, desynchronization occurs.

e Amplitudes increase when subjects are less alert and tend to be higher from 1:30-4:30 pm.

In this lesson, you will record the EEG and alpha rhythm under several conditions. At the same time,

the root-mean-squared of the alpha rhythm (alpha-RMS) and an “alpha thermometer” will be displayed. Alpha-RMS
and the “alpha thermometer” are indices of the activity levels of the alpha rhythm. Alpha RMS is the root mean square
value of the signal within a window length of 0.25 seconds. This parameter provides a good characterization for the
actual quantity of the alpha waves.
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Il. EXPERIMENTAL OBJECTIVES

1) To record an EEG from an awake, resting subject under the following conditions:
a) Relaxed with eyes closed;
b) Performing mental arithmetic with eyes closed,;
¢) Hyperventilating (breathing quickly and deeply) with eyes closed:;
d) Relaxed with eyes open.

2) To examine differences in the level of alpha rhythm activity during mental arithmetic and hyperventilation
compared to the control condition of eyes closed and relaxed.

I, MATERIALS
e BIOPAC Electrode Lead Set (SS2L)
e BIOPAC Disposable Electrodes (EL503,) 3 electrodes per subject
e BIOPAC Electrode Gel (GEL1) and Abrasive Pad (ELPAD) or Skin cleanser or alcohol prep

«  Lycra® swim cap (such as Speedo® brand) or supportive wrap (such as 3M Coban™ Self-adhering Support
Wrap) to press electrodes against head for improved contact

e Biopac Student Lab System: BSL 4 software, MP36, MP35 or MP45 hardware

e  Computer system (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP
FAST TRACK Setup Detailed Explanation of Setup Steps

1. Turn the computer ON.
e If using an MP36/35 unit, turn it OFF.

e If using an MP45, make sure USB cable
is connected and “Ready” light is ON.

2. Plug the equipment in as follows:
Electrode Lead Set (SS2L)—CH 1
3. Turn ON the BIOPAC MP3X unit.

Setup continues... Fig. 4.2 MP3X (top) and MP45 (bottom) hardware connections

Page P-1 ©BIOPAC Systems, Inc.
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4. Position electrodes on the scalp.
Fig. 4.3 shows a sample configuration.

IMPORTANT
Good electrode contact with the
scalp is crucial for obtaining a
meaningful EEG recording.

Fig. 4.3
Guidelines for electrode placement:

= The placement of the scalp electrodes can vary (within limits)
depending on your instructor’s or Subject’s preference.

= Keep the electrodes on one side (right or left) of the head.

= Apply some gel to the electrode. (A fair amount of gel must be
used to obtain a good electrode to scalp connection.)

= The third electrode is the ground electrode and is placed over the
Mastoid region (behind the ear).
Hints for obtaining optimal data:
= As much as possible, move (part) the hair away from the

electrode adhesion area to ensure the electrode makes contact
with the scalp.

=  Gently abrade skin at the electrode sites.
= Apply a drop of gel to the electrode.

= Apply pressure to the electrodes for about one minute after the
initial placement.

= Subject must remain still. Blinking and other movement will
affect the recordings of all four rhythms.

= Despite your best efforts, electrode adhesion may not be strong
enough to record data; try another Subject or different electrode
placement.

5. Clip the Electrode Lead Set following the  The pinch connectors work like a small clothespin, but only latch onto
color code in Fig. 4.3. the nipple of the electrode from one side of the connector.
) Drape the electrode cables over the head so that they are not pulling on
6. Place cap/wrap on Subject’s head to press the electrodes.

UL D e [ (8. 24 The cap or wrap should be snug but not uncomfortably tight.

Setup continues...
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7. Get Subject in proper seating position
(Fig. 4.5).

8. Wait five minutes to allow Subject to
relax, and for electrodes to establish
proper contact.

Place a Lycra® swim
cap or supportive
wrap on Subject’s
head to press
electrodes against the
scalp with a constant
pressure. Subject
should not press
electrodes against
scalp.

Subject should be seated and relaxed. Ideally, the room should be
reasonably quiet to help Subject mentally relax.

Fig. 4.5 Positioning

9. Start the Biopac Student Lab Program. Start Biopac Student Lab by double-clicking the Desktop shortcut.

10. Choose lesson “L.04 —
Electroencephalography (EEG) 11” and
click OK.

Biopac
Student Lab
4.0

11. Type in a unique filename and click OK.  No two people can have the same filename, so use a unique identifier,
such as Subject’s nickname or student ID#.

A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a common folder.
12. Optional: Set Preferences. This lesson has optional Preferences for data and display while recording.
Per your Lab Instructor’s guidelines, you may set:
Grids: Show or hide gridlines.

. . . Lesson Recordings: Specific data recordings may be omitted based on
o Select the desired Settlng and click instructor preferences_

OK.

e Choose File > Lesson Preferences.

e Select an option.

END OF SETUP
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B. CALIBRATION

L04 - Electroencephalography (EEG) |1
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The Calibration procedure establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for
optimum performance. Pay close attention to Calibration.

FAST TRACK Calibration

1. Subject remains relaxed with eyes closed
during Calibration.

2. Check Electrode Impedance. (Optional*)

*Only functional if your MP
hardware is compatible with the
Electrode Check feature. If your
MP hardware is not compatible,
this feature will not be available.

Please contact BIOPAC
Technical Support for more
information on how to enable

Electrode Check functionality.

IMPORTANT
Certain subjects may not fall
below the 10 K ohm reading.

This reading is subject to

individual variations in skin

conductivity and electrode
placement.

3. Click Calibrate.

4. During Calibration Subject must:

o Remain seated, relaxed and still, with
eyes closed.

« Wait for Calibration to stop.

5. Verify recording resembles the example
data.

o If similar, click Continue and
proceed to Data Recording.

e If necessary, click Redo Calibration.

END OF CALIBRATION

Detailed Explanation of Calibration Steps

This step is optional and not
applicable to MP45 hardware.

Use Check Electrode Impedance to
check the Subject’s skin conductivity.
This opens the Electrode Checker
panel and displays skin resistance in K
ohms.

File Display Lessons Help

Check Electrode Impedance | Calibrate |

To use:

= Remove the Lead Set (SS2L)
from CH1 and plug into the
‘Electrode Check' input.

= Click ‘Check Electrode
Impedance’ button.

= Ideally, both readings should
be similar and below 10 k
ohm. (See Fig. 4.6).

= When finished, be sure to
remove the SS2L from the
‘Electrode Check’ input and
plug into the CH 1 input
before continuing.

Calibration lasts eight seconds.

e e

Electrode Check
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Fig. 4.6

The baseline should
be relatively stable
around O uV.

Fig. 4.7 Example Calibration data

If the data shows excessive baseline drift or large spikes, make sure the
electrodes are making good contact with the scalp and that the cables are

not pulling on the electrodes.

Click Redo Calibration and repeat Steps 3 — 5 if necessary.
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C. DATA RECORDING

FAST TRACK Recording

1. Prepare for the recording.

e Subject remains seated, relaxed,
and still, with eyes closed.

» Review recording steps.

Relaxed with eyes closed (Control)
2. Click Record.

e Subject remains seated, relaxed and

still, with eyes closed.

3. Record for 10 seconds.
4. Click Suspend.
Recording continues...

L04 - Electroencephalography (EEG) |1 Page P-5

Detailed Explanation of Recording Steps

Subject will perform four tasks™; Subject will perform tasks in the intervals
between recordings.

Recording 1: Relaxed with eyes closed

Recording 2: Performing mental math with eyes closed

Recording 3: Recovering from hyperventilation with eyes closed

Recording 4: Relaxed with eyes open
To work efficiently, read this entire section before recording, or review
onscreen Tasks to preview recording steps in advance.

*IMPORTANT

This procedure assumes that all lesson recordings are enabled in Lesson
Preferences, which may not be the case for your lab. Always match the
recording title to the recording reference in the journal and disregard any
references to excluded recordings.

Hints for obtaining optimal data:

= Subject must try not to blink during “Eyes Open” portion of
recording.

=  Subject should not talk during any of the recordings, and should
not verbalize answers to the mental arithmetic.

= The alpha signal will be increased during the relaxation recording
if Subject relaxes mentally; i.e. thinks of a relaxing place.

Subject should try to relax mentally; i.e. % Biopac Student Lab® - L04

think of a relaxing place. File | Display Lessors  Help
Note: Display > Autoscale Waveforms 5 Autoscale Waveforms
and Autoscale Horizontal —

are available DURING recordings

to allow scale changes if necessary. o

Autoscale Horzontal
2o Erevious
oo ewt

IF Eefresh Grapt

Note  The graph window will reduce to fit the Input i
values window on the right side of the display.
The Input values window shows the alpha-RMS
value in a thermometer-like bar display, and can
be used as a visual aid to determine fluctuations
in alpha-RMS activity. It is only updated during
the recording.

.M..—Im:h

(U )

Fig. 4.8 Input
Values
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5.

10.

11.

Verify recording resembles the example
data.

o If similar, click Continue and proceed
to the next recording.

o If necessary, click Redo.

« If all required recordings have been
completed, click Done.

Mental Arithmetic

Director prepares a math problem.

e Subject remains seated and relaxed,
with eyes closed.

e Review recording steps.

Click Record.

Director verbalizes math problem to
Subject.

e Subject solves the problem silently
with eyes closed.

 Record for 20 seconds.
Click Suspend.
If the Subject indicates the math problem

was given too quickly, Redo the recording.

Verify recording resembles the example
data.

e If similar, click Continue and proceed
to the next recording.

o If necessary, click Redo.

o If all required recordings have been
completed, click Done.

Recording continues...

L04 - Electroencephalography (EEG) |1 Biopac Student Lab 4
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Fig. 4.9 Example Relaxed, Eyes Closed data

If recording does not resemble the Example Data

= If the data is noisy or flatline, check all connections to the MP
unit.

= If there is excessive baseline drift or large spikes:

0 Check that electrodes are making good contact with the
scalp, cap or wrap is snug and that the cables are not
pulling on the electrodes.

0 Subject must remain as still as possible.

0 Try relaxation techniques, such as slow breathing or
relaxing muscles.

Click Redo and repeat Steps 2 — 5 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

Subject remains relaxed with eyes closed. Director prepares a math
problem. The problem should be challenging but not too difficult—the
point is to make Subject really work for the answer, not to stump
Subject. For example:

2 minus 4...times 3...plus 9...double that...double again...divide by 4...

Director provides arithmetic problem at a rate that the Subject can solve
silently.

l;m Ak et TP g i Ay i M s M.‘—-m‘\ww‘«-qm"-n{ -

[T T ] Wm (5] X THpa Mm ) EL] ded {
2

Fig. 4.10 Mental Arithmetic, Eyes Closed

The data may be different for the reasons outlined in Step 5.

Click Redo and repeat Steps 7 — 11 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.
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12.

13.

14,
15.
16.

17.

18.
19.
20.

After Hyperventilation

Subject is seated.
e Review recording steps.

e Subject hyperventilates for two
minutes with eyes closed.

WARNING
Hyperventilation can make Subject
dizzy and light headed. Subject

should be seated with Director
watching. Stop the procedure if
Subject starts to feel sick or dizzy.

As soon as Subject stops hyperventilating
and is sitting still, Click Record
immediately.

Record for 10 seconds.
Click Suspend.

Verify recording resembles the example
data.

o If similar, click Continue and proceed
to the next recording.

e If necessary, click Redo.

o If all required recordings have been
completed, click Done.

Eyes Open recording

Subject remains seated and relaxed.
e Review recording steps.

e Subject opens eyes and avoids blinking
during recording.

Click Record.
Record for 10 seconds.
Click Suspend.

Recording continues...
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Subject hyperventilates (by breathing rapidly and deeply through mouth)
for two minutes with eyes closed.

It is important that recording be resumed as quickly as possible after
Subject has hyperventilated. However, to avoid EMG artifact, make sure
Subject has stopped hyperventilating prior to clicking Record.

b s bl 4

St vkl e s Ut it

| =M e ) =0 4000 200 o ®m 4800 sang)

Fig. 4.11 Example after Hyperventilation, Eyes Closed data

The data may be different for the reasons outlined in Step 5, with the
following exception:

= Itis normal to have some baseline drift after hyperventilation.

Click Redo and repeat Steps 12 — 16 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

Director instructs Subject to open eyes.
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21. Verify recording resembles the example
data.

Bmmi g - g s 0 o

« If similar, click Continue and proceed T

to optional recording section, or click
Done to finish.

. L o =
o If necessary, click Redo. frdn

Fig. 4.12 Example Relaxed, Eyes Open data
The data may be different for the reasons outlined in Step 5, with the
following exception:

= If the Subject blinked, it may have created a large spike in the
data. If excessive, consider redoing the recording.

Click Redo and repeat Steps 17 — 21 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

OPTIONAL ACTIVE LEARNING With this lesson you may record additional data by clicking Continue
PORTION following the last recording. Design an experiment to test or verify a
scientific principle(s) related to topics covered in this lesson. Although

you are limited to this lesson’s channel assignments, the electrodes may
be moved to different locations on the Subject.

Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each step
to make it easy to follow during recording.

Run Your Experiment

D. SetUp
Set up the equipment and prepare the subject for your experiment.
E. Record

Use the Continue, Record and Suspend buttons to record as much
data as necessary for your experiment.

Click Done when you have completed all of the recordings required
for your experiment.

Analyze Your Experiment

F. Set measurements relevant to your experiment and record the results
in a Data Report.

22. After clicking Done, choose an option and  After clicking Done, dialog with options will be generated. Make a
click OK. selection, and continue as directed.

If choosing the Record from another Subject option:

=  Repeat Setup Steps 5 — 9, and then proceed to Calibration.

23. Remove electrodes. Remove cap or wrap, the electrode cable pinch connectors, and peel off
all electrodes. Discard the electrodes. (BIOPAC electrodes are not
reusable.) Wash the electrode gel residue from the skin, using soap and
water. The area around the electrode sites may remain red for a few

END OF RECORDING hours, which is quite normal.
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V. DATA ANALYSIS

FAST TRACK Data Analysis

1. Enter the Review Saved Data mode.

¢ Note Channel Number (CH)
designations:

Channel Displays
CH1 EEG
CH 40 alpha
CH 41 alpha RMS
« Note measurement box settings:
Channel Measurement
CH1 Stddev
CH 40 Stddev
CH 41 Mean
CH 40 Freq

2. Set up your display window for optimal
viewing of the entire recording.

Data Analysis continues...

Page P-1

Detailed Explanation of Data Analysis Steps

If entering Review Saved Data mode from the Startup dialog or lessons
menu, make sure to choose the correct file.

The data should resemble Fig. 4.13.

[T e - S - 4L e e R i - % [ form - o
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Fig. 4.13 Example data
The measurement boxes are above the marker region in the data
window. Each measurement has three sections: channel number,
measurement type, and result. The first two sections are pull-down
menus that are activated when you click them.

Brief definition of measurements:

Stddev: Standard deviation is a measure of the variability of data
points. The advantage of the Stddev measurement is that extreme
values or artifacts do not unduly influence the measurement.

Mean: Displays the average value in the selected area.

Freq: Converts the time segment of the selected area to frequency in
cycles per second

The “selected area” is the area selected by the I-beam tool (including
endpoints).

Note: The append event markers 4 mark the beginning of each
recording. Click on (activate) the event marker to display its
label.

Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom
Back, Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)
Cursor Tools: Zoom Tool
Buttons: Overlap, Split, Show Grid, Hide Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click”
(Mac) the channel number box to toggle channel display.

©BIOPAC Systems, Inc.
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3. Use the I-Beam cursor to select the first
data recording.

g A

4. Repeat the measurements for each of the
data recordings.

g A

5. Zoom in on a small section of the
Recording 1 data.

6. Use the I-Beam cursor to select an area
from one peak to the next in the alpha
band (CH 40).

g s

7. Answer the questions at the end of the Data
Report.

8. Save or Print the Data Report.
9. Quit the program.

END OF DATA ANALYSIS
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Fig. 4.14 First data recording selected

Be sure to zoom in far enough so that you can easily measure the
frequency of the alpha wave.

Fig. 4.15 shows a sample setup for measuring the frequency in the alpha
band (CH 40).
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Fig. 4.15 Alpha wave frequency measurement

An electronically editable Data Report is located in the journal
(following the lesson summary,) or immediately following this Data
Analysis section. Your instructor will recommend the preferred format
for your lab.

END OF LESSON 4

Complete the Lesson 4 Data Report that follows.
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ELECTROENCEPHALOGRAPHY II

o EEGII

DATA REPORT

Student’s Name:

Lab Section:

Date:

|. Data and Calculations

Subject Profile
Name:

Age:

Amplitudes

Gender: Male /

Female

Height:

Page P-3

Weight:

A. Complete Table 4.1 with the amplitudes of the recorded data in the control and experimental conditions. Calculate
the difference for the Alpha-RMS Mean between the Experimental Conditions and the Control, and then summarize

whether the Experimental Mean was larger (+,) smaller (—,) or the same (=) as the Control Mean.

For example: To calculate Alpha-RMS Difference for the “Mental Arithmetic” recording, subtract the “Eyes Closed
(Control)” Alpha-RMS value from the measured “Mental Arithmetic” Alpha-RMS value.

Mental arithmetic

Table 4.1
EEG Alpha Alpha-RMS Alpha-RMS Alpha-RMS
Condition Difference Summary
[a1] (Exp. - Control) (+,= =
Eyes closed Nw
(Control) k

Recovering from
hyperventilation

Eyes open

Frequency

B. What is the frequency of an alpha rhythm from “Eyes closed” data? [Frea 1]-
Does this agree with the expected values?

I. Questions

Yes No

C. Referto Table 4.1: When was the general amplitude of the EEG highest?

Hz

D. Referto Table 4.1: When were the alpha wave levels highest?
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E. Referto Table 4.1: How do your results compare with the information presented in the Introduction?

F. Did Subject need to concentrate during math problems? Yes No
How would the level of concentration required affect the data?

G. What might account for the amplitude difference of waves recorded from a subject tested alone, in a darkened room,
and subjects tested in a lab full of students?

H. Which conditions produced the lowest alpha activity?
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I11. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials
C. Method
D. SetUp

E. Experimental Results

End of Lesson 4 Data Report
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I. INTRODUCTION

The main function of the heart is to pump blood through two circuits:

1. Pulmonary circuit: through the lungs to oxygenate the blood and remove carbon dioxide; and
2. Systemic circuit: to deliver oxygen and nutrients to tissues and remove carbon dioxide.

Because the heart moves blood through two separate circuits, it is sometimes described as a dual pump.

In order to beat, the heart needs three types of cells:

m 1. Rhythm generators, which produce an electrical signal (SA node or normal pacemaker);
2.

Conductors to spread the pacemaker signal; and
3. Contractile cells (myocardium) to mechanically pump blood.

The Electrical and Mechanical Sequence of a Heartbeat

The heart has specialized pacemaker cells that start the electrical

sequence of depolarization and repolarization. This property of

cardiac tissue is called inherent rhythmicity or automaticity. The SA Node
electrical signal is generated by the sinoatrial node (SA node) and
spreads to the ventricular muscle via particular conducting
pathways: internodal pathways and atrial fibers, the Internadal Pathways !
atrioventricular node (AV node,) the bundle of His, the right AV Node I\ | eft Bundle Branch
and left bundle branches, and Purkinje fibers (Fig. 5.1). Right Bundle Branch 5

When the electrical signal of a depolarization reaches the Right Ventricle
contractile cells, they contract—a mechanical event called systole.
When the repolarization signal reaches the myocardial cells, they
relax—a mechanical event called diastole. Thus, the electrical
signals cause the mechanical pumping action of the heart;
mechanical events always follow the electrical events (Fig. 5.2).

The SA node is the normal pacemaker of the heart, initiating each

electrical and mechanical cycle. When the SA node depolarizes,

the electrical stimulus spreads through atrial muscle causing the muscle to contract. Thus, the SA node depolarization is
followed by atrial contraction.

The SA node impulse also spreads to the atrioventricular node (AV node) via the internodal fibers. (The wave of
depolarization does not spread to the ventricles right away because there is nonconducting tissue separating the atria and
ventricles.) The electrical signal is delayed in the AV node for approximately 0.20 seconds when the atria contract, and then
the signal is relayed to the ventricles via the bundle of His, right and left bundle branches, and Purkinje fibers. The
Purkinje fibers relay the electrical impulse directly to ventricular muscle, stimulating the ventricles to contract (ventricular
systole). During ventricular systole, ventricles begin to repolarize and then enter a period of diastole (Fig. 5.2).

Although the heart generates its own beat, the heart rate (beats per minute or BPM) and strength of contraction of the heart
are modified by the sympathetic and parasympathetic divisions of the autonomic nervous system.

Left Atrium
Bundle of His

Right Atrium

Interventricular Septum
Left Ventricle

Purkinje Fibers
Fig. 5.1 The Heart

Page I-1 ©BIOPAC Systems, Inc.
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e The sympathetic division increases automaticity and excitability of the SA node, thereby increasing heart rate. It
also increases conductivity of electrical impulses through the atrioventricular conduction system and increases the
force of atrioventricular contraction. Sympathetic influence increases during inhalation.

e The parasympathetic division decreases automaticity and excitability of the SA node, thereby decreasing heart rate.
It also decreases conductivity of electrical impulses through the atrioventricular conduction system and decreases
the force of atrioventricular contraction. Parasympathetic influence increases during exhalation.

The Electrocardiogram (ECG)
Just as the electrical activity of the pacemaker is communicated to the cardiac muscle, “echoes” of the depolarization and
repolarization of the heart are sent through the rest of the body. By placing a pair of very sensitive receivers (electrodes) on
other parts of the body, the echoes of the heart’s electrical activity can be detected. The record of the electrical signal is called
an electrocardiogram (ECG). You can infer the heart’s mechanical activity from the ECG. Electrical activity varies through
the ECG cycle as shown below (Fig. 5.2):

R+ R+

Ventricular Systole-i=—————Ventricular Diastole 4f‘ \
[\

P-R S-T T-P i
Segmen Segment +T Segment | \
P+ P+ f
|
ioetectric ./ N\ | o\ /. Al — L. P
Line \‘ [ ‘a8
\ /
Q- Q- !
=P-R Interval Q-T Interval ——— -

R-R Interval

Fig. 5.2 Components of the ECG & Electrical and mechanical events of the cardiac cycle
Because the ECG reflects the electrical activity, it is a useful “picture” of heart activity. If there are interruptions of the
electrical signal generation or transmission, the ECG changes. These changes can be useful in diagnosing changes within the
heart. During exercise, however, the position of the heart itself changes, so you cannot standardize or quantify the voltage
changes.

Components of the ECG

The electrical events of the heart (ECG) are usually recorded as a pattern of a baseline (isoelectric line,) broken by a P wave,
a QRS complex, and a T wave. In addition to the wave components of the ECG, there are intervals and segments (Fig. 5.2).

e The isoelectric line is a point of departure of the electrical activity of depolarizations and repolarizations of the
cardiac cycles and indicates periods when the ECG electrodes did not detect electrical activity.

e Aninterval is a time measurement that includes waves and/or complexes.

e Asegment is a time measurement that does not include waves and/or complexes.
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Table 5.1 Components of the ECG & Typical Lead Il Values*
29¢ Measurement area Represent DU AT E
COMPONENT P (seconds) (millivolts)
P begin and end on isoelectric depolarization of the right and left atria. 0.07-0.18 <0.25
line (baseline); normally
upright in standard limb leads

o | QRS begin and end on isoelectric depolarization of the right and left 0.06 — 0.12 0.10-1.50

2| complex line (baseline) from start of Q | ventricles. Atrial repolarization is also part of

g wave to end of S wave this segment, but the electrical signal for

atrial repolarization is masked by the larger
QRS complex (see Fig. 5.2)
T begin and end on isoelectric repolarization of the right and left ventricles. | 0.10 —0.25 <0.5
line (baseline)
P-R from start of P wave to start time from the onset of atrial depolarization 0.12-0.20
of QRS complex to the onset of ventricular depolarization.

% Q-T from start of QRS complex to | time from onset of ventricular 0.32-0.36

> end of T wave depolarization to the end of ventricular

8 repolarization. It represents the refractory

= period of the ventricles.

R-R from peak of R wave to peak | time between two successive ventricular 0.80
of succeeding R wave depolarizations.

P-R from end of P wave to start of | time of impulse conduction from the AV 0.02-0.10
QRS complex node to the ventricular myocardium.

al| ST between end of S wave and period of time representing the early part of <0.20

5 start of T wave ventricular repolarization during which

S ventricles are more or less uniformly

(‘,%; excited.

T-P from end of T wave to start of | time from the end of ventricular 0.0 -0.40
successive P wave repolarization to the onset of atrial
depolarization.

* Notes: Tabled values represent results from a typical Lead Il setup (wrist and ankle electrode placement) with Subject
heart rate ~75 BPM. Values are influenced by heart rate and placement; values for torso placement would be
different.

Leads

The particular arrangement of two electrodes (one positive, one negative) with respect to a third electrode (the ground) is
called a lead. The electrode positions for the different leads have been standardized. For this lesson, you will record from
Lead 11, which has a positive electrode on the left ankle, a negative electrode on the right wrist, and the ground electrode on
the right ankle. Typical Lead Il values are shown in Table 5.1.
The dominant ECG component in any normal standard lead record is the QRS complex. Usually, in a Lead |1 record the Q
and S waves are small and negative and the R wave is large and positive as shown in Fig. 5.2. However, it is important to

note many factors, normal and abnormal, determine the duration, form, rate, and rhythm of the QRS complex.

= Normal factors include body size (BSA) and distribution of body fat, heart size (ventricular mass,) position of the
heart in the chest relative to lead locations, metabolic rate, and others.
For example, in a person who has a high diaphragm, the apex of the heart may be shifted slightly upward and to the
person’s left. This change in the position of the heart alters the “electrical picture” of ventricular depolarization seen by the
Lead Il electrodes, resulting in decreased positivity of the R wave and increased negativity of the S wave. In other words,
the positive amplitude of the R wave decreases and the negative amplitude of the S wave increases.
Similar changes in the Lead Il QRS complex may be observed in a person, an athlete for example, who has no cardiac
disease but does have a larger than normal left ventricular mass. In fact the decrease in R wave positivity coupled with the
increase in S wave negativity may be so extreme as to give rise to the mistaken impression that the R wave has become
inverted, when in reality the inverted spike is an enlarged S wave preceded by a much smaller but still positive R wave.
When the amplitudes of Lead Il Q, R, and S waves are all negative, the result is an abnormal inverted QRS complex.
= Abnormal factors include hyper- and hypothyroidism, ventricular hypertrophy (observed for example, in chronic
valvular insufficiency,) morbid obesity, essential hypertension and many other pathologic states. A more detailed
discussion of QRS changes in response to normal and abnormal factors requires an introduction to cardiac vectors,
for which the reader is referred to Lesson 6.
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Effects of the Resting Respiratory Cycle on Heart Rate

Temporary minor increases and decreases in heart
rate associated with the resting respiratory cycle
reflect heart rate adjustments made by systemic
arterial and systemic venous pressure receptor
(baroreceptor) reflexes in response to the cycling of
intrathoracic pressure (Fig. 5.4).

When inspiratory muscles contract, pressure within
the thorax (intrathoracic pressure) decreases,
allowing thoracic veins to slightly expand. This
causes a momentary drop in venous pressure,
venous return, cardiac output, and systemic arterial
blood pressure. The carotid sinus reflex normally
decreases heart rate in response to a rise in carotid
arterial blood pressure. However, the momentary
drop in systemic arterial blood pressure during
inspiration reduces the frequency of carotid
baroreceptor firing, causing a momentary increase
in heart rate.

When inspiratory muscles relax, resting expiration
passively occurs. During early resting expiration,
intrathoracic pressure increases causing
compression of thoracic veins, momentarily
increasing venous pressure and venous return. In
response, systemic venous baroreceptors reflexively
increase heart rate. However, the slight increase in
heart rate is temporary because it increases cardiac
output and systemic arterial blood pressure, which
increases carotid baroreceptor firing causing heart
rate to decrease.
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Source: Richard Pflanzer, Ph.D., Associate Professor
Indiana University S5chool of Medicine, Purdue University School of Science

Fig. 5.3 Effects of the Resting Respiratory Cycle on Heart Rate

Because ECGs are widely used, basic elements have been standardized to simplify reading I

ECGs. ECGs have standardized grids of lighter, smaller squares and, superimposed on the .04 sec.
first grid, a second grid of darker and larger squares (Fig. 5.4). The smaller grid always has =% =

time units of 0.04 seconds on the x-axis and the darker vertical lines are spaced 0.2 seconds R =
apart. The horizontal lines represent amplitude in mV. The lighter horizontal lines are 0.1 il
mV apart and the darker grid lines represent 0.5 mV. In this lesson, you will record the ECG
under four conditions.

The average resting heart rate for adults is between 60-80 beats/min. (Average 70 bpm for males and 75
bpm for females.) Slower heart rates are typically found in individuals who regularly exercise. Athletes are
able to pump enough blood to meet the demands of the body with resting heart rates as low as 50
beats/min. Athletes tend to develop larger hearts, especially the muscle in the left ventricle—a condition
known as “left ventricular hypertrophy.” Because athletes (usually) have larger and more efficient hearts,
their ECGs may exhibit differences other than average resting heart rate. For instance, low heart rate and
hypertrophy exhibited in sedentary individuals can be an indication of failing hearts but these changes are
“normal” for well-trained athletes.

[ | 1 1 1
=2 sec.>=

|

Grid
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T

Fig. 5.4‘1 standard ECG Grid
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Il. EXPERIMENTAL OBJECTIVES

1)
2)

3)

To become familiar with the electrocardiograph as a primary tool for evaluating electrical events within the
heart.

To correlate electrical events as displayed on the ECG with the mechanical events that occur during the cardiac
cycle.

To observe rate and rhythm changes in the ECG associated with body position and breathing.

I11. MATERIALS

BIOPAC Electrode Lead Set (SS2L)

BIOPAC Disposable Electrodes (EL503,) 3 electrodes per subject

BIOPAC Electrode Gel (GEL1) and Abrasive Pad (ELPAD) or Skin cleanser or alcohol prep
Mat, cot or lab table and pillow for Supine position

Biopac Student Lab System: BSL 4 software, MP36, MP35 or MP45 hardware
Computer System (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP

1. Turn the computer ON.
e If using an MP36/35 unit, turn it OFF.

e If using an MP45, make sure USB
cable is connected and “Ready” light
is ON.

2. Plug the equipment in as follows:
Electrode Lead Set (SS2L)—CH 1
3. Turn ON the MP36/35 unit.

FAST TRACK Setup Detailed Explanation of Setup Steps

Fig. 5.5 MP3X (top) and MP45 (bottom) hardware connections

4. Clean and abrade skin. If the skin is oily, clean electrode sites with soap and water or alcohol
5. Attach three electrodes on Subject as before abrading.
shown in Fig. 5.6. If electrode is dry, apply a drop of gel.

Page P-1

Remove any jewelry on or near the electrode sites.

Place one electrode on the medial surface of each leg, just above the
ankle. Place the third electrode on the right anterior forearm at the
wrist (same side of arm as the palm of hand).

For optimal electrode contact, place electrodes on skin at least 5

Setup continues... minutes before start of Calibration.

©BIOPAC Systems, Inc.
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6. Clip the Electrode Lead Set (SS2L) to the
electrodes following the color code
(Fig. 5.6).

e RIGHT forearm = WHITE lead
e RIGHT leg = BLACK lead (ground)
e LEFT leg = RED lead

o VIN+

Fig. 5.6 Lead Il Setup

The pinch connectors work like a small clothespin, but will only latch
onto the nipple of the electrode from one side of the connector.

7. Subject gets in supine position (lying Position the electrode cables so that they are not pulling on the
down, face up) and relaxes (Fig. 5.7). electrodes. Connect the electrode cable clip to a convenient location
on Subject’s clothes.

Fig. 5.7 Positioning (supine)

8. Start the BIOPAC Student Lab program. Start Biopac Student Lab by double-clicking the Desktop shortcut.
9. Choose lesson “L05 —
Electrocardiography (ECG) I” and click

OK.
Biopac
Student Lab
4.0
10. Type in a unique filename and click OK. A folder will be created using the filename. This same filename can be
11. Optional: Set Preferences. used in other lessons to place the Subject’s data in a common folder.
o Choose File > Lesson Preferences. This lesson has optional Preferences for data and display while

recording. Per your Lab Instructor’s guidelines, you may set:
Grids: Show or hide gridlines
ECG filter: Set bandwidth
Heart Rate Data: Calculate and display Heart Rate data

Time Scale: Set the full screen time scale with options from 10 to 20
seconds.

Lesson Recordings: Specific recordings may be omitted based on
END OF SETUP instructor preferences.

e Select an option.

e  Select the desired setting and click
OK.
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B. CALIBRATION

The Calibration procedure establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for
optimal performance. Pay close attention to Calibration.

FAST TRACK Calibration

1. Subject is supine and relaxed, with eyes
closed.

2. Click Calibrate.

e Subject remains relaxed with eyes
closed.

o Wait for Calibration to stop.

3. Verify recording resembles example data.

o If similar, click Continue and
proceed to Data Recording.

o If necessary, click Redo
Calibration.

END OF CALIBRATION

Detailed Explanation of Calibration Steps

Subject must remain relaxed and as still throughout calibration to
minimize baseline shift and EMG artifact.

Calibration lasts eight seconds.

There should be a recognizable ECG waveform with a baseline at or
near 0 mV, little EMG artifact and no large baseline drift.

Fig. 5.8 Example Calibration data

If recording does not resemble the Example Data
= If the data is noisy or flatline, check all connections to the MP unit.
= |If the ECG displays baseline drift or excessive EMG artifact:

o Verify electrodes are making good contact with the skin and
that the leads are not pulling on the electrodes.

0 Make sure Subject is in a relaxed position.

Click Redo Calibration and repeat Steps 1 — 3 if necessary.
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C. DATA RECORDING

FAST TRACK Recording Detailed Explanation of Recording Steps
1. Subject remains supine and relaxed, with Four conditions* will be recorded: Supine, Seated, Breathing deeply, and
eyes closed. After exercise. Subject performs tasks in the intervals between
« Subject must remain still. recordings.
*IMPORTANT

* Review recording steps. h . .
This procedure assumes that all lesson recordings are enabled in Lesson

Preferences, which may not be the case for your lab. Always match the
recording title to the recording reference in the journal and disregard any
references to excluded recordings.

Hints for obtaining optimal data:
To minimize EMG artifact and baseline drift:
=  Subject’s arms and legs must be relaxed.

= Subject must remain still and should not talk during any
recordings.

= Make sure electrodes do not peel up and that the leads
do not pull on the electrodes.
Supine

2. Click Record.
3. Subject remains supine and relaxed, with

eyes closed.

. Record for 20 seconds.

5. Click Suspend.
6. Verify recording resembles the example The ECG waveform should have a baseline at or near 0 mV and should

data. not display large baseline drifts or significant EMG artifact. The Heart
Rate (BPM) data will not be accurate until after the first two cardiac

(ECG) cycles after which there should not be sporadic variations that
go out of the visible range.

e If similar, click Continue and
proceed to next recording.

Fig. 5.9 Example Supine data

o If necessary, click Redo If recording does not resemble the Example Data
« If all required recordings have been = If the data is noisy or flatline, check all connections to the MP unit.
completed, click Done. = If the ECG displays excessive baseline drift or EMG artifact, or if

the Heart Rate (BPM) data shows sporadic values:

o Verify electrodes are making good contact with the skin and
that the leads are not pulling on the electrodes.

0 Make sure Subject is in a relaxed position.

=  Click Redo and repeat Steps 2 — 6 if necessary. Note that once Redo
is clicked, the most recent recording will be erased.

Recording continues...
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Seated
o Review recording steps. Subject should sit with arms relaxed at side of body and hands apart in
7. Subject gets up quickly and then settles lap, with legs flexed at knee and feet supported for seconds 21 — 40.

into a seated position (Fig. 5.10).

Fig. 5.10 Positioning (seated)

8. Once Subject is seated and still, click In order to capture the heart rate variation, click Record as quickly as
Record. possible after Subject sits and relaxes.
9. Record for 20 seconds. Subject remains seated, relaxed, and breathing normally.

10. Click Suspend.

11. Verify recording resembles the example
data.

o If similar, click Continue and L*U,H&J/u' .‘-"-L"‘-'-""\'“‘Jr""J /“J('*'a"'"*-r’*‘J/*'J(""J/"Jj("'-'j("-kt"* J/ul;__bi,,ﬂl_,uJM_Lﬁ_it !

proceed to the next recording.

TEm Hw ) T 000 = T %00 T o
e

Fig. 5.11 Example Seated data

o If necessary, click Redo. The data description is the same as outlined in Step 6.
« If all required recordings have been Click Redo if necessary. The Subject must return to the Supine position
completed, click Done. for at least 5 minutes before repeating Steps 7 — 11.

Note that once Redo is clicked, the most recent recording will be erased.

Recording continues...
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Deep Breathing

* Review recording steps.
12. Click Record.

13. Subject inhales and exhales slowly and
completely as possible for five prolonged
(slow) breath cycles.

o Recorder presses F4 at the start of
each inhale.

o Recorder presses F5 at the start of
each exhale.

14. Click Suspend.
15. Verify recording resembles the example
data.

o If similar, click Continue and
proceed to the next recording.

o If necessary, click Redo.

o If all required recordings have been
completed, click Done.

After exercise

o Review recording steps.
16. Subject exercises to elevate heart rate.

o If electrode leads were unclipped,
clip them back on.

o Following exercise, Subject sits
down and relaxes.

17. Record for 60 seconds.
18. Click Suspend.

19. Verify recording resembles the example
data.

o If similar, click Continue to proceed
to optional recording section, or
click Done if finished.

Recording continues...

L05 — Electrocardiography (ECG) |
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Subject remains seated.

Note It is important to breathe with long, slow, deep breaths
to help minimize EMG artifact.

If possible, the Subject should breathe through nose so the Recorder can
clearly observe the start of each inhale and exhale.

[ | | ‘ ' ||

LTk
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Fig. 5.12 Example Deep Breathing data

The data description is the same as outlined in Step 6 with the following
exception:

=  The ECG data may exhibit some baseline drift during deep
breathing which is normal and unless excessive, does not
necessitate Redo.

Click Redo and repeat Steps 12 — 15 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

Subject should perform an exercise to elevate his/her heart rate fairly
rapidly, such as running up stairs, push-ups, or jumping-jacks.
Note You may remove the electrode cable pinch connectors so that
Subject can move about freely, but do not remove the
electrodes.

If you do remove the cable pinch connectors, you must
reattach them following the precise color placement in Fig. 5.6
prior to clicking Record.

When seated, Subject’s arms must be relaxed and at sides of body, with
arms relaxed and feet supported.

In order to capture the heart rate variation, it is important that you
resume recording as quickly as possible after Subject has performed the
exercise. However, it is also important that you do not click Record
while Subject is exercising or you will capture motion artifact.

el ot

Fig. 5.13 Example After Exercise data



©BIOPAC Systems, Inc. L05 — Electrocardiography (ECG) | Page P-7

o If necessary, click Redo.

OPTIONAL ACTIVE LEARNING PORTION

20. After clicking Done, choose an option and
click OK.

21. Remove the electrodes.

END OF RECORDING

The data description is the same as outlined in Step 6, with the following
exception:

= The ECG data may exhibit some baseline drift which is normal
and unless excessive, does not necessitate Redo.

Click Redo and repeat Steps 16 — 19 if necessary. Note that once Redo
is clicked, the most recent recording will be erased.

With this lesson you may record additional data segments by clicking
Continue following the last recording segment. Design an experiment
to test or verify a scientific principle(s) related to topics covered in this
lesson. Although you are limited to this lesson’s channel assignments,
the electrodes-may be moved to different locations on the Subject.

Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each step
to make it easy to follow during recording.
Run Your Experiment

D. SetUp

Set up the equipment and prepare the subject for your experiment.
E. Record

Use the Continue, Record and Suspend buttons to record as many
segments as necessary for your experiment.
Click Done when you have completed all of the segments required
for your experiment.

Analyze Your Experiment

F. Set measurements relevant to your experiment and record the
results in a Data Report.

If choosing the Record from another Subject option:
= Repeat Setup Steps 6 — 9, and then proceed to Calibration.

Remove the electrode cable pinch connectors and peel off all electrodes.
Discard the electrodes. (BIOPAC electrodes are not reusable.) Wash the
electrode gel residue from the skin, using soap and water. The electrodes
may leave a slight ring on the skin for a few hours which is quite normal.
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V. DATA ANALYSIS

In this section, you will examine ECG co
the ECG components.

mponents of cardiac cycles and measure amplitudes (mV) and durations (msecs) of

Note: Interpreting ECGs is a skill that requires practice to distinguish between normal variation and those arising from

medical conditions. Do not be alarmed

FAST TRACK Data Analysis

1. Enter the Review Saved Data mode.

¢ Note Channel Number (CH)
designation:

CH1 ECG (Lead II)
CH 40 Heart Rate

¢ Note measurement box settings:

Channel Measurement

CH40 Value
CH1 Delta T
CH1 P-P
CH1 BPM

Data Analysis continues...
Page P-1

if your ECG is different than the normal values and references in the Introduction.

Detailed Explanation of Data Analysis Steps

If entering Review Saved Data mode from the Startup dialog or lessons
menu, make sure to choose the correct file.

[ vk - omooo e [F BRI - 1 e - 1 T - % e - o
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Fig. 5.14 Example data

The measurement boxes are above the marker region in the data window.
Each measurement has three sections: channel number, measurement
type, and result. The first two sections are pull-down menus that are
activated when you click them.

Brief definition of measurements:
Value: Displays the amplitude value at the point selected by the I-

beam cursor. If an area is selected, displays the value of the endpoint
based on the direction the cursor was dragged.

= CH 40 heart rate data is only updated at the end of an R-R
interval so it remains constant within an R-R interval; therefore,
the Value (BPM) measurement will be accurate from any selected
point in the R-R interval.

= Single point Values will be shown when placing the Arrow
cursor over the data while holding down the left mouse button.

Delta T: Displays the amount of time in the selected area (the
difference in time between the endpoints of the selected area).

P-P (Peak-to-Peak): Subtracts the minimum value from the maximum
value found in the selected area.

BPM: Use only if CH 40 was not recorded. The Beats Per Minute
measurement first calculates the difference in time between the
beginning and end of the selected area (seconds/beat,) and divides this
value into 60 seconds/minute.

Rate Mean: If CH 40 Heart Rate data was recorded, use the Rate
Mean measurement, which is designed specifically for rate data and
calculates accurate statistical means using one value only for every
cardiac cycle. This avoids any unintentional weighting due to time
variation in heart rate, unlike the amplitude "Mean" measurement.

The “selected area” is the area selected by the I-beam tool (including
endpoints).

©BIOPAC Systems, Inc.
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2. Set up your display window for optimal
viewing of three complete cardiac cycles

from the initial “Supine” segment.

NOTE: For accurate BPM data go past the first

two cardiac cycles.

3. For measuring heart rate, use the cursor to
select any data point within an R-R interval.

g A

Data Analysis continues...
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Textual notes (such as identifying components of the ECG wave) can be
inserted into the graph by using the Annotation tool. This tool will place
a small editable text box anywhere in the waveform.

SEvas = coomew DEEET - T = [ T Emes m o

Fig. 5.15 Zoom in on “Supine” data
Note: The append event markers 4 mark the beginning of each
recording. Click (activate) the event marker to display its label.
Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom
Back, Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)
Cursor Tools: Zoom Tool

Buttons: Overlap, Split, Adjust Baseline (Up, Down,) Show Grid, Hide
Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click” (Mac)
the channel number box to toggle channel display.

The Heart Rate
channel is
updated at the
end of each R-R
interval, so it will
i I} it ! | initially appear

/ “out of sync,” or
delayed by one
interval. (See Fig.
5.17 for
illustration.)

Fig. 5.16 Overlap sample: Heart Rate and ECG after supine Subject is seated
Adjust Baseline allows you to position the waveform up or down in
small increments so that the baseline (isoelectric line) can be exactly
zero. After Adjust Baseline is pressed, Up and Down buttons are
generated. Simply click these to move the waveform up or down. This is
not needed to get accurate amplitude measurements, but may be desired
before making a printout, or when using grids.

Note that the CH 40 Value measurement displays the BPM for the
interval preceding the current R-R interval.

If CH 40 Heart Rate data was not recorded, use CH 1 BPM measurement
to determine the heart rate; select from R wave peak to R wave peak as
precisely as possible.

Follow the examples shown above to complete all the measurements
required for the Data Report.
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10.

11.

12.

13.

Take measurements within two other R-R
intervals in the current segment.

g A

Repeat measurements on the other
segments as required for the Data Report.

g A

Hide CH 40.

Zoom in on a single cardiac cycle from
“Supine” segment.

Measure Ventricular Systole and Diastole.

g s

Repeat measurements for “After exercise”
segment.

g s

Zoom in on a single cardiac cycle
from “Supine” segment.

Use the I-Beam cursor to select segments
and measure the durations and wave
amplitudes required for the Data Report.

Use P-P measurement to obtain amplitudes.

gc

Zoom in on a single cardiac cycle
from “After exercise” segment.

Repeat duration and amplitude (P-P)
measurements using “After exercise” data
as required for the Data Report.

gc

Data Analysis continues...
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| Rate for this |
? Interval

shown here

Fig. 5.17 Data point selection for Heart Rate data correlated to ECG data

The remaining measurements use ECG data only. To hide Heart Rate
data display and focus on ECG data, Alt + click (Windows) or Option +
click (Mac) the “40” channel number box.

For Ventricular Systole and Diastole measurements, the T wave reference
point for the selected area is 1/3 of the way down the descending portion
of the T wave; if necessary, see Fig. 5.2 and Table 5.1 in the Introduction
PDF for selected area details.

Measurement data starts at the append event marker labeled “After
exercise.”

Select the components of the ECG as specified in the Introduction and
gather wave amplitude data for 3 cycles using the P-P measurement. If
necessary, see Fig. 5.2 and Table 5.1 in the Introduction for selected area
details.

P Wave
duration

-

Fig. 5.18 Measuring P wave duration (Delta T) and amplitude (P-P)

T

SE A - sumow DEERTOE- oo LEE B-oovo  DEBE- e
Tim s

P-R
Interval

-

Fig. 5.19 Selection of P-R Interval

Follow the examples shown above to complete all the measurements
required for your Data Report.
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14. OPTIONAL.: Using the Annotation tool,
insert text boxes identifying the ECG
components in the selected area. Copy and
paste this graph to the Data Report at the

L05 — Electrocardiography (ECG) |

Biopac Student Lab 4

Use the Annotation Tool ’I to insert text boxes into the graph

identifying the ECG components in the selected portion, and then drag
them to their correct locations within the ECG waveform.

end of Section C.

o |I —hd “..\.\
g

| - B,
i
Vi

B

a.en 4.00
seconds

Fig 5.20 Example of ECG Component Annotations
Use the Copy Graph button to copy the selected area.

Use the contextual menu in the Journal to paste the graph into the
Data Report.

| 340 3.60

15. Answer the questions at the end of the Data  An electronically editable Data Report is located in the journal

Report (following the lesson summary,) or immediately following this Data
16. Save or Print the data file. Analysis section. Your instructor will recommend the preferred format
17. Quit the program. for your lab.

END OF DATA ANALYSIS

END OF LESSON 5
Complete the Lesson 5 Data Report that follows.
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ELECTROCARDIOGRAPHY |

e ECGI

DATA REPORT
Student’s Name:
Lab Section:
Date:

|. Data and Calculations

Subject Profile
Name: Height:

Weight:

Age: Gender: Male / Female

A. Heart Rate
Complete the following tables with the lesson data indicated, and calculate the Mean as appropriate;

Table 5.2
Recording: Condition ~ Cardiac Cycle EREET Mean « If CH 40 was not recorded,
_ 1 2 3 (calculate) O i = |
Supine
Seated
Start of inhale
Start of exhale
After exercise
B. Ventricular Systole and Diastole
Table 5.3
Corafier Duration (ms) [1][ Detat ]
Ventricular Systole Ventricular Diastole
Supine
After exercise

C. Components of the ECG

Table 5.4
Condition: Supine Recording (measurements taken from 3 cardiac cycles)
g Duration (ms) Amplitude (mV)
Normative Values
Corrllz Cocil ent Based on resting heart -
p rate 75 BPM 2 3 Mean (calc) 2 3 Mean (calc)
=) .07 - .18 <.20
QRS Comp|ex .06 -.12 10-15
T .10 - .25 <5
P-R .12 - .20
Q-T .32 - .36
R-R -80
P-R .02 - .10
S-T <.20
T-P 0-.40
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Table 5.5
Condition: After Exercise Recording (measurements taken from 1 cardiac cycle)
Normative Duration (ms) Amplitude (mV)
ECG Values
Component Based on resting

heart rate 75 BPM

P .07-.18 <.20
QRS Comp|ex .06 - .12 10-15
T .10-.25 <5

Note Interpreting ECGs is a skill that requires practice to distinguish between normal variation and those arising from
medical conditions. Do not be alarmed if your ECG does not match the “Normative Values.”

1. Questions
D. Using data from table 5.2:

1) Explain the changes in heart rate between conditions. Describe the physiological mechanisms causing these
changes.

2) Are there differences in the cardiac cycle with the respiratory cycle (“Start of inhale-exhale” data)?

E. Using data from table 5.3:
1) What changes occurred in the duration of systole and diastole between resting and post-exercise?

F. Using data from tables 5.4 and 5.5:

1) Compared to the resting state, do the durations of the ECG intervals and segments decrease during exercise?
Explain

2) Compare your ECG data to the normative values. Explain any differences.




©BIOPAC Systems, Inc. L05 — Electrocardiography (ECG) | Page P-7

3) Compare ECG data with other groups in your laboratory. Does the data differ? Explain why this may not be
unusual.

G. Inorder to beat, the heart needs three types of cells. Describe the cells and their function.
1)
2)
3)

H. List in proper sequence, starting with the normal pacemaker, elements of the cardiac conduction system.
1)
2)
3)
4)
5)
6)
7)
8)
I.  Describe three cardiac effects of increased sympathetic activity, and of increased parasympathetic activity.
Sympathetic

Parasympathetic

J. Inthe normal cardiac cycle, the atria contract before the ventricles. Where is this fact represented in the ECG?

K. What is meant by “AV delay” and what purpose does the delay serve?

L. What is the isoelectric line of the ECG?

M. Which components of the ECG are normally measured along the isoelectric line?
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I11. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials

C. Method

D. SetUp

E. Experimental Results

End of Lesson 5 Data Report
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l. INTRODUCTION

Willem Einthoven developed a “string galvanometer” in 1901 that could About Willem Einthoven:
record the electrical activity of the heart. Although it was not the first such ’
recorder, it was a breakthrough in that it was accurate enough to duplicate 1860f1927

the results on the same patient. Einthoven’s work established a standard Born in Semarang, Java
configuration for recording the ECG and won him the Nobel Prize in 1924, Dutch physician

Since then, the ECG has become a powerful tool in diagnosing disorders of Professor, University of Leiden,
the heart. [It should be noted that the clinical interpretation of the ECG is 1885-1927

quite empirical in practice, and has evolved from a long history of Nobel Prize: 1924

reference to and correlation with known cardiac disorders.] )

The electrical activity of each cardiac cycle begins with depolarization of the sinoatrial (SA) node, the primary pacemaker of
the heart. The wave of depolarization spreads throughout the atria initiating contraction of atrial myocardium (see Lesson 5
ECG I for details.) Depolarization of the atria is recorded as the P wave of the ECG. Repolarization of the atria immediately
follows the depolarization and occurs during the PR segment of the ECG. At the AV node, transmission of the electrical
signal is slowed, allowing the atria sufficient time to complete their contraction, before the signal is conducted down the AV
bundle, the left and right bundle branches, and the Purkinje fibers to ventricular myocardium. Depolarization of the ventricles
is recorded as the QRS complex in the ECG, and repolarization of the ventricles is recorded as the T wave.

During the cardiac cycle, the current spreads along specialized pathways and depolarizes parts of the pathway in the specific
sequence outlined above. Consequently, the electrical activity has directionality, that is, a spatial orientation represented by
an electrical axis. The preponderant direction of current flow during the cardiac cycle is called the mean electrical axis.
Typically, in an adult the mean electrical axis lies along a line extending from the base to the apex of the heart and to the left
of the interventricular septum pointing toward the lower left rib cage.

The magnitude of the recorded voltage in the ECG is directly proportional to the amount of tissue being depolarized. Most of
the mass of the heart is made up of ventricular myocardium. Therefore, the largest recorded waveform, the QRS complex,
reflects the depolarization of the ventricles. Furthermore, since left ventricular mass is significantly greater than right
ventricular mass, more of the QRS complex reflects the depolarization of the left ventricle, and orientation of the mean
electrical axis is to the left of the interventricular septum.

The body contains fluids with ions that allow for electrical conduction. This makes it
possible to measure electrical activity in and around the heart from the surface of the
skin (assuming good electrical contact is made with the body fluids using electrodes.)
This also allows the legs and arms to act as simple extensions of points in the torso.
Measurements from the leg approximate those occurring in the groin, and
measurements from the arms approximate those from the corresponding shoulder.

Ideally, electrodes are placed on the ankles and wrists for convenience to the subject
undergoing the ECG evaluation. In order for the ECG recorder to work properly, a
ground reference point on the body is required. This ground is obtained from an
electrode placed on the right leg above the ankle. To represent the body in three
dimensions, three planes are defined for electrocardiography (Fig. 6.1.) The bipolar
limb leads record electrical activity of the cardiac cycle in the frontal plane and will be
used in this lesson to introduce principles of vectorcardiography.

Fig. 6.1 ECG planes

Page I-1 ©BIOPAC Systems, Inc.
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A bipolar lead is composed of two discrete electrodes of opposite polarity, one positive and the other negative. A
hypothetical line joining the poles of a lead is called the lead axis. The electrode placement defines the recording direction of
the lead, when going from the negative to the positive electrode. The ECG recorder computes the difference (magnitude)
between the positive and negative electrodes and displays the changes in voltage difference with time. A standard clinical
electrocardiograph records 12 leads, three of which are called standard (bipolar) limb leads.

The standard bipolar limb leads, their polarity and axes are as follows:

Lead Polarity Lead Axis
Lead | rightarm (-) to leftarm (+)  +£180°-0°
Lead Il right arm (-) to left leg (+) -120° - +60°
Lead Il left arm (-) to left leg (+) -60° - +120°

The relationships of the bipolar limb leads are such that the sum of the electrical currents recorded in leads I and 111 equal the
sum of the electric current recorded in lead II. This relationship is called Einthoven’s law, and is expressed mathematically
as:

Lead | + Lead 11l = Lead Il

It follows that if the values for any two of the leads are known, the value for the third lead can be calculated.

A good mathematical tool for representing the measurement of a lead is the vector. A vector is an entity that has both
magnitude and direction, such as velocity. At any given moment during the cardiac cycle, a vector may represent the net
electrical activity seen by a lead. An electrical vector has magnitude, direction, and polarity, and is commonly visualized
graphically as an arrow:

= The length of the shaft represents the magnitude of the electrical current.
= The orientation of the arrow represents the direction of current flow.

= The tip of the arrow represents the positive pole of the electrical current.

= The tail of the arrow represents the negative pole of the electrical current.

The electric current of the cardiac cycle flowing
toward the positive pole of a lead axis produces a Lead Il
positive deflection on the ECG record of that lead. An Right Are ()
electric current flowing toward the negative pole
produces a negative deflection. The amplitude of the
deflection, negative or positive, is directly proportional
to the magnitude of the current. If the current flow is
perpendicular to the lead axis, no deflection is produced
in the record of that lead. It follows that for as given
magnitude of electrical current, the largest positive
deflection will be produced by current flowing along
the lead axis toward the positive pole, and the largest
negative deflection produced by current flowing along  ead i
the lead axis toward the negative pole (Fig.6.2) When Left Leg (+)
the direction of current flow is between the lead axis Fig. 6.2
and its perpendicular, the deflection is smaller. This is
true for current flowing away from as well as toward
the positive pole. Lead I

Right Arm (-)
Due to the anatomy of the heart and its conduction

system, current flow during the electrical cardiac cycle
is partly toward and partly away from the positive pole
of the bipolar limb leads. This may produce a biphasic
(partially +, partially -) deflection on ECG lead record.
A good example is the coupled Q-R or R-S deflections
of the QRS complex typically seen in Lead Il. At any
given moment, the bidirectional electric current can be
represented by a single mean vector that is the average
of all the negative and positive electrical vectors at that
moment (Fig. 6.3.)

ECG * A 4

Lead Il -

ECG +
Lead i =

Left Leg (+)

Fig. 6.3
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The bipolar limb lead axes may be used to construct an equilateral triangle, called Einthoven’s triangle, at the center of which
lies the heart (Fig. 6.4.) Each side of the triangle represents one of the bipolar limb leads. The positive electrodes of the three
bipolar limb leads are electrically about the same distance from the zero reference point in the center of the heart. Thus, the
three sides of the equilateral triangle can be shifted to the right, left, and down without changing the angle of their orientation
until their midpoints intersect at the center of the heart (Fig. 6.4.) This creates a standard limb lead vectorgraph with each of
the lead axes forming a 60-degree angle with its neighbors. The vectorgraph can be used to plot the vector representing the
mean electrical axis of the heart in the frontal plane.

A vector can represent the electrical activity of the heart at
any instant in time. The mean electrical axis of the heart is

the summation of all the vectors occurring in a cardiac

cycle.

Since the QRS interval caused by ventricular depolarization
represents the majority of the electrical activity of the heart,
you can approximate the mean electrical axis by looking
only in this interval, first at the R wave amplitude, and then
at the combined amplitudes of the Q, R, and S waves. The
resultant vector, called the QRS axis, approximates the

mean electrical axis of the heart.

An initial approximation of the mean electrical axis in the
frontal plane can be made by plotting the magnitude of the
R wave from Lead | and Lead 1l (Fig. 6.5.) To plot R wave

magnitude:

1. Draw a perpendicular line from the
ends of the vectors (right angles to
the axis of the Lead.)

2. Determine the point of intersection
of these two perpendicular lines.

3. Draw a new vector from point 0,0 to
the point of intersection.

The direction of the resulting vector approximates the mean Fig. 6.5
electrical axis of the heart. The length of the vector
approximates the mean potential of the heart.

wu | h
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Fig. 6.6

Fig. 6.4

magnitude of R wave from leads
0,0

e
Mean Electrical Axis

A more accurate method of approximating the mean electrical axis
is to algebraically add the Q, R, and S potentials for one lead,
instead of using just the magnitude of the R wave. The rest of the
procedure would be the same as outlined above.

The normal range of the mean electrical axis of the ventricles is
approximately -30° to +90°. The axis may shift slightly with a
change in body position (e.g., standing versus supine) and variation
among individuals within the normal range occur as a result of
individual differences in heart mass, orientation of the heart in the
thorax, body mass index, and the anatomic distribution of the
cardiac conduction system.

A shift in the direction of the QRS axis from normal to one
between -30° and -90° is called left axis deviation (LAD.) Left
axis deviation is abnormal and results from conditions that cause
the left ventricle to take longer than normal to depolarize. One
example is hypertrophy (enlargement, and hence a longer
conduction pathway)) of the left ventricle associated with
systemic hypertension or stenosis (narrowing) of the aortic valve.
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Left axis deviation may also occur when the conduction pathway or the left ventricular myocardium is damaged, creating
blockage and slowing of the depolarization signal. Common causes of this include coronary occlusion (spasm, thrombosis,
etc.) and injuries resulting from drug usage. Fig. 6.6A shows typical ECG patterns of Leads I, II, and 111 associated with
LAD.

A shift in the direction of the QRS axis from normal to one between +90° and +180° is called right axis deviation (RAD.) In
some cases right axis deviation may be normal, such as in young adults with long narrow chests and vertical hearts, but in
the majority of adults, right axis deviation generally is associated with hypertrophy of the right ventricle or damage to the
conduction system in the right ventricle. In both conditions, the right axis deviation results from a slowing or blockage of the
depolarization signal for the right ventricle. Fig. 6.6B shows typical ECG patterns of Leads I, 1I, and I11 associated with
RAD. A convenient method of differentiating LAD and RAD is to examine the QRS patterns of Leads I and I1l. A pattern
where the apices of the QRS complexes go away from each other is left axis deviation (Fig. 6.6C.) A pattern where the
apices approach one another is right axis deviation.



. ® Richard Pflanzer, Ph.D.
A B’OPAC® Biopac Student Lab™ Lesson 6 Associate Professor Emeritus

* Systems, Inc. ELECTROCARDIOGRAPHY (ECG) II Indiana University School of Medicine

Purdue University School of Science

Registered to IS0 9001:2008 P d
42 Aero Camino, Goleta, CA 93117 roceaure
William McMullen
; Rev. 12012014
www.biopac.com Vice President, BIOPAC Systems, Inc.

Il. EXPERIMENTAL OBJECTIVES

1) Record ECG from Leads | and 111 in the following conditions: supine, seated, and breathing deeply while seated.

2) Compare the displayed calculated ECG Lead Il to recorded ECG Leads I and 111, and use the R wave amplitudes to
confirm Einthoven’s Law.

3) Approximate the mean electrical axis of the ventricles on the frontal plane using vectors derived from the amplitude
and polarity of the QRS complex in ECG Leads | and IlI.

4) Approximate the mean electrical potential of the ventricles on the frontal plane using the resultant vector derived
from the vectors of Leads | and I11.

I11. MATERIALS

e BIOPAC Electrode Lead Set x 2 (SS2L)

e BIOPAC Disposable Electrodes (EL503,) 6 electrodes per subject

e BIOPAC Electrode Gel (GEL1) and Abrasive Pad (ELPAD) or Skin cleanser or alcohol prep
e Mat, cot or lab table and pillow for Supine position

e  Protractor

e Two different colored pens/pencils

e Biopac Student Lab System: BSL 4 software, MP36, MP35 or MP45 hardware

e Computer System (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP
FAST TRACK Setup Detailed Explanation of Setup Steps

1. Turn the computer ON.
e If using an MP36/35 unit, turn it OFF.

e If using an MP45, make sure USB cable
is connected and “Ready” light is ON.

2. Plug the equipment in as follows:
Electrode Lead Set (SS2L)—CH 1
Electrode Lead Set (SS2L)—CH 2

3. Turn ON the MP36/35 unit.

) Fig. 6.7 MP3X (top) and MP45 (bottom) hardware connections
Setup continues...

Page P-1 ©BIOPAC Systems, Inc.



Page P-2

4. Clean and abrade skin.

5. Attach six electrodes to Subject, as

6.

follows:

One above right wrist
Two above left wrist
Two above right ankle
One above left ankle

Clip the first Electrode Lead Set (SS2L)
from CH 1 to the electrodes, following
LEAD I in Fig. 6.9.

e RED = LEFT wrist

e WHITE = RIGHT wrist

e BLACK = RIGHT ankle

Clip the second Electrode Lead Set (SS2L)
from CH 2 to the electrodes, following
LEAD Il in Fig. 6.9.

o WHITE = LEFT wrist
o RED = LEFT ankle
e BLACK = RIGHT ankle

Setup continues...

L06 — Electrocardiography (ECG) 11 Biopac Student Lab 4

Attach six electrodes to flat spots inside wrists and ankles as shown in
Fig. 6.8

If the skin is oily, clean electrode sites with soap and water or alcohol
before abrading.

If electrode is dry, apply a drop of gel.
Remove any jewelry on or near the electrode sites.

For optimal electrode contact, place electrodes on skin at least five
minutes before start of Calibration.

Fig. 6.8 Electrode Placement
Carefully follow the color code placement of each electrode lead

The pinch connectors work like a small clothespin, but will only latch
onto the nipple of the electrode from one side of the connector.
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8. Subject gets in supine position (lying Position the electrode cables so that they are not pulling on the
down, face up) and relaxes (Fig. 6.10). electrodes.
Connect the electrode cable clip to a convenient location on Subject’s
clothes.

Fig. 6.10

9. Start the BIOPAC Student Lab program. Start Biopac Student Lab by double-clicking the Desktop shortcut.

10. Choose lesson “L06 —
Electrocardiography (ECG) I1” and click
OK.

Biopac
Student Lab
4.0

11. Type in a unique filename and click OK. No two people can have the same filename, so use a unique identifier,
such as Subject’s nickname or student ID#.

A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a common folder.
12. Optional: Set Lesson Preferences. This lesson has optional Preferences for data and display while
recording. Per your Lab Instructor’s guidelines, you may set:
Grids: Show or hide gridlines
ECG filter: Set bandwidth
Heart Rate Data: Calculate and display Heart Rate data

Time Scale: Set the full screen time scale with options from 10 to 20
seconds.

Lesson Recordings: Specific recordings may be omitted based on
instructor’s preferences.

All setting changes will be saved.

e Choose File > Lesson Preferences.
o Select an option.
e Select the desired setting and click OK.

END OF SETUP
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B. CALIBRATION

The Calibration procedure establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for
optimal performance. Pay close attention to Calibration.

FAST TRACK Calibration Detailed Explanation of Calibration Steps
1. Subject is supine and relaxed, with eyes
closed.
2. Click Calibrate. Subject must remain relaxed and as still throughout calibration to

« Subject remains relaxed with eyes minimize baseline shift and EMG artifact.

closed.
» Wait for Calibration to stop. Calibration lasts eight seconds.
3. Verify recording resembles the example Both channels should show recognizable ECG waveforms with a baseline
data. at or near 0 mV, little EMG artifact and no large baseline drift.

e If similar, click Continue and proceed
to Data Recording. - _ | | | | - ji.

e If necessary, click Redo Calibration.

om0

Fig. 6.11 Example Calibration data

If recording does not resemble the Example Data
= |If the data is noisy or flatline, check all connections to the MP unit.

= |f the signals look reversed, verify that transducers are plugged into
the correct channels. (CH 1 for Lead | and CH 2 for Lead I11.)

= If the ECG displays baseline drift or excessive EMG artifact:

o Verify electrodes are making good contact with the skin and that
the leads are not pulling on the electrodes.

O Make sure Subject is in a relaxed position

END CALIBRATION
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C. DATA RECORDING

FAST TRACK Recording

1. Prepare for the recording.

e Subject remains supine and relaxed,
with eyes closed.

» Review recording steps.

Supine
Click Record.
Record for 30 seconds.
Click Suspend.

Verify recording resembles the example
data.

e If similar, click Continue and proceed
to next recording.

o 0N

e If necessary, click Redo.

« If all required recordings have been
completed, click Done.

Recording continues...

L06 — Electrocardiography (ECG) 11
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Detailed Explanation of Recording Steps
Two conditions will be recorded*, one with Subject supine and another
with Subject seated.

*IMPORTANT

This procedure assumes that all lesson recordings are enabled in lesson
Preferences, which may not be the case for your lab. Always match the
recording title to the recording reference in the journal and disregard any
references to excluded recordings.

Hints for obtaining optimal data
To minimize muscle (EMG) artifact and baseline drift:
= Subject’s arms and legs must be relaxed.

= Subject must remain still and should not talk during any
recordings.

= Make sure electrodes do not peel up and that the leads do
not pull on the electrodes.

Subject remains supine and relaxed, with eyes closed.

Both ECG waveform should have a baseline at or near 0 mV and should
not display large baseline drifts or significant EMG artifact.

Fig. 6.12 Example Supine data

If recording does not resemble the Example Data
= If the data is noisy or flatline, check all connections to the MP unit.
= If the ECG displays baseline drift or excessive EMG artifact:

o Verify electrodes are making good contact with the skin and that
the leads are not pulling on the electrodes.

O Make sure Subject is in a relaxed position

Click Redo and repeat Steps 2 — 5 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.
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Seated
* Review recording steps. Subject should sit with arms relaxed at side of body and hands apart in
6. Subject gets up quickly and then settles lap, with legs flexed at knee and feet supported.
into a seated position (Fig. 6.13). AN
Fig. 6.13 Proper position for “Seated” recording
7. Once Subject is seated and still, click In order to capture the heart rate variation, click Record as quickly as
Record. possible after Subject sits and relaxes.
8. Subject remains seated and relaxed. Note: Subject should not breathe in too deeply as to cause excessive
« Record for 10 seconds and then ask EMG artifact or baseline drift.

Subject to increase depth of breathing.

e Subject inhales audibly, Recorder
presses F4 on the inhale.

e Subject exhales audibly, Recorder
presses F5 on the exhale.

9. Record for 5 more seconds.
10. Click Suspend.

11. Verify that recording resembles the
example data.

it cognnrn M bbb

Done if finished.
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Fig. 6.14 Example Seated data

The data description is the same as outlined in Step 5 with the following
exception:
=  The ECG data may exhibit some baseline drift during deep

breathing which is normal and unless excessive, does not
necessitate Redo.

e If necessary, click Redo. Click Redo if necessary. Note that the Subject must return to the Supine
position for at least 5 minutes before repeating Steps 6 — 11. Once Redo
is clicked, the most recent recording will be erased.

Recording continues...
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OPTIONAL ACTIVE LEARNING PORTION

12. After clicking Done, choose an option and
click OK.

13. Remove the electrodes.

END RECORDING

With this lesson you may record additional data by clicking Continue
following the last recording. Design an experiment to test or verify a
scientific principle(s) related to topics covered in this lesson. Although
you are limited to this lesson’s channel assignments, the electrodes or
transducers may be moved to different locations on the Subject.
Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each step
to make it easy to follow during recording.

Run Your Experiment
D. SetUp

Set up the equipment and prepare the subject for your experiment.
E. Record

Use the Continue, Record, and Suspend buttons to record as much
data as necessary for your experiment.

Analyze Your Experiment

F. Set measurements relevant to your experiment and record the results
in a Data Report.

If choosing the Record from another Subject option:

= Repeat Setup Steps 6 — 9, and then proceed to Calibration.
Remove the electrode cable pinch connectors and peel off all electrodes.
Discard the electrodes. (BIOPAC electrodes are not reusable.) Wash the

electrode gel residue from the skin, using soap and water. The electrodes
may leave a slight ring on the skin for a few hours which is quite normal.



. ® Richard Pflanzer, Ph.D.
A B’OPAC® Biopac Student Lab™ Lesson 6 Associate Professor Emeritus

* Systems, Inc. ELECTROCARDIOGRAPHY (ECG) II Indiana University School of Medicine

Purdue University School of Science

Registered to IS0 9001:2008 .
42 Aero Camino, Goleta, CA 93117 AnalySlS Proced ure
William McMullen
; Rev. 12012014
www.biopac.com Vice President, BIOPAC Systems, Inc.

V. DATA ANALYSIS

FAST TRACK DATA ANALYSIS DETAILED EXPLANATION OF DATA ANALYSIS STEPS
1. Enter the Review Saved Data mode. If entering Review Saved Data mode from the Startup dialog or lessons
« Note Channel Number (CH) menu, make sure to choose the correct file.
designations: Note: After Done was pressed in the final recording section, the program

Channel Displays used Einthoven’s Law to automatically calculate Lead Il from Leads |
CH 1 Lead | and 11 and added a channel for Lead Il to the initial two channel

& recording (Fig. 6.15).
CH2 Lead 111 TR ST T s ER - o e
CH 40 Lead Il (calculated) ‘

LA AR AR Al

« Note measurement box settings: _ﬁ LU u 1 THiH Jﬁ‘“ﬁ

Channel Measurement
CH1 Delta LU “‘1""4 ‘-,-.r.-L-:-T-,...l.l-'.r Y‘l"l‘r‘r‘r“*'*"""‘J"f“{l‘l*"“'_"‘r““"'l'%TT’J‘TJ‘J"H
CH?2 Delta ] e

CH40 Delta " ! l | I LGS ﬂ4+~!a,"| :

rN AL F AN

|'-|-: 330 ] 780 frry 16.00 ] ) 240 80 X000 nX 040 aLe0 40 @ |
...... |

Fig. 6.15 Example data
The measurement boxes are above the marker region in the data window.
Each measurement has three sections: channel number, measurement
type, and result. The first two sections are pull-down menus that are
activated when you click them.

Brief definition of measurements:

Delta: Computes the difference in amplitude between the first point
and the last point of the selected area. It is particularly useful for
taking ECG measurements, because the baseline does not have to be
at zero to obtain accurate, quick measurements.

Rate Mean: If CH 40 Heart Rate data was recorded, use the Rate
Mean measurement, which is designed specifically for rate data and
calculates accurate statistical means using one value only for every
cardiac cycle. This avoids any unintentional weighting due to time
variation in heart rate, unlike the amplitude "Mean" measurement.

The “selected area” is the area selected by the I-beam tool (including
endpoints).
2. Set up the display window for optimal Note: The append event markers 4 mark the beginning of each
viewing of the first data recording. recording. Click on (activate) the event marker to display its label.
Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom
Back, Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)
Cursor Tools: Zoom Tool
Buttons: Overlap, Split, Show Grid, Hide Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click” (Mac)
the channel number box to toggle channel display.

The data window should resemble Fig. 6.16.

Data Analysis continues...

Page P-1 ©BIOPAC Systems, Inc.
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3. Zoom in to select two consecutive “clean”
cardiac cycles in the “Supine” recording.

4. Place an event marker above the second
R-wave to indicate which cardiac cycle will
be used for measurements.

5. Use the I-Beam cursor to select the area
from the midpoint between the cycles
(baseline) and the R-wave of the second
cycle

g A B

6. Scroll to the “Seated” recording, select two
consecutive cardiac cycles and repeat the
procedure described in Steps 4 and 5.

Data Analysis continues...

L06 — Electrocardiography (ECG) 11
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Fig. 6.16 Supine data
A clean cardiac cycle has ECG components that are easy to discern (Fig.
6.17).
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Fig. 6.17 Zoom in on Supine data
Insert the event marker directly above the R wave of the second cardiac
cycle in the display.
To place an event marker (inverted triangle,) Right-click with the cursor in
the event marker region and choose the contextual menu item “Insert New
Event.” You can then move the marker by holding down the “Alt” key
while clicking and dragging it.
Type “Reference 1” to label the marker.

Start at the midpoint between the T-wave of cardiac cycle 1 (left) and the
P-wave of cardiac cycle 2. Press and hold the mouse and sweep the
cursor to the right until the end of the selected area is at peak of the
desired wave—monitor the Delta measurement to determine when the
actual peak is reached; small movements to the right or left may be
necessary.

1 [ e H- comnves 3 Witen B asitiee o (w D = 0E

o (o] bievw - o o .o

B2

T T | T T~ T T T S T R

Fig. 6.18 Selection from baseline to R wave peak

Note R-waves may be inverted on some of the leads; include the polarity
of the Delta result in the Data Report tables.

= Lilicae)

Do not use a section between the “Start of inhale” and “Start of exhale”
event markers.

Note All remaining measurements are taken on Lead | and Lead 11 only
so you may choose to hide Lead Il (CH 40).
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7.

10.

11.
12.

13.
14.

Scroll to the “Start of inhale” section and
select two consecutive cardiac cycles and
repeat the procedure described in Steps 4
and 5.

g s

Scroll to the “Start of exhale” section and
select two consecutive cardiac cycles and
repeat the procedure described in Steps 4
and 5.

g s

Go back to the “Reference 1” marker
created in Step 4.

Measure the waves of the QRS complex
and record the amplitudes for Lead I and
Lead III.

g c

Fill in the vectorgrams.

Answer the questions at the end of the Data
Report.

Save or Print the data file.
Quit the program.
END OF DATA ANALYSIS

L06 — Electrocardiography (ECG) 11 Page P-3

Type “Reference 2” to label the marker.

Type “Reference 3” to label the marker.

Use the event marker left and right arrows to move to different markers.

To measure a wave, select the area from the baseline (Isoelectric Line) to
the peak of the wave.

T AT T TR TR W W

Fig. 6.19 Sample meésurement of the Q wave

e =-

fm s ——

Fig. 6.20 Sample measurement of the R wave
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e e

Fig. 6.21 Sample measurement of the S wave

= The LO6 Vectorgrams are contained in the printed manual, or can be

printed directly from the Help menu.

= An electronically editable Data Report is located in the journal

(following the lesson summary,) or immediately following this Data
Analysis section. Your instructor will recommend the preferred
format for your lab.

END OF LESSON 6

Complete the Lesson 6 Data Report that follows.
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ELECTROCARDIOGRAPHY Il

Bipolar Leads (Leads I, 11, 111,) Einthoven’s Law, and

L06 — Electrocardiography (ECG) 11

Mean Electrical Axis on the Frontal Plane

Biopac Student Lab 4

DATA REPORT
Student’s Name:
Lab Section:
Date:
Subject Profile
Name: Height:
Age: Gender: Male / Female Weight:
I. Data and Plots
A. Einthoven’s Law—Simulated Confirmation: Lead | + Lead 111 = Lead |1
Table 6.1 Supine
Lead | Cvdia Cycte | ™V
Lead | [ Deta | *Includg etr:(ra] \[/);rltzgtgn(:o% é)O?ft:]r;eI;(;I;a result since R-waves may
Lead Ill '
Lead Il

B. Mean Electrical Axis of the Ventricles (QRS Axis) and Mean Ventricular Potential—Graphical Estimate

Use Table 6.2 to record measurements from the Data Analysis section:

Table 6.2
QRS
CONDITION Lead | Lead Il
Deta Delta
Supine
Seated

Start of inhale

Start of exhale
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One way to approximate the mean electrical axis in the frontal plane is to plot the magnitude of the R wave from Lead |
and Lead I11, as shown in the Introduction (Fig. 6.4).

1. Draw a perpendicular line from the ends of the vectors (right angles to the axis of the Lead) using
a protractor or right angle guide.

2. Determine the point of intersection of these two perpendicular lines.
3. Draw a new vector from point 0.0 to the point of intersection.

The direction of this resulting vector approximates the mean electrical axis (QRS Axis) of the ventricles. The length of
this vector approximates the mean ventricular potential.

Create two plots on each of the following graphs, using data from Table 6.2. Use a different color pencil or pen for each
plot.

Graph 1: Supine and Seated

Radial Graduations = 0.1 mV

40°
-5°
RA(-) 180° 0%+ Lead |
LA(+)
@ o
~ I~ £
~N D e - O
& =%
N
From the above graph, find the following values:
Condition Mean Ventricular Potential Mean Ventricular (QRS) Axis
Supine
Seated

Explain the difference (if any) in Mean Ventricular Potential and Axis under the two conditions:
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Graph 2: Inhale /Exhale

Radial Graduations =0.1mV

0% Lead |
LA(+)

RA(-) 180°

From the above graph, find the following values:
Condition Mean Ventricular Potential Mean Ventricular (QRS) Axis
Start of inhale

Start of exhale

Explain the difference (if any) in Mean Ventricular Potential and Axis under the two conditions:
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C. Mean Electrical Axis of the Ventricles (QRS Axis) and Mean Ventricular Potential—More Accurate
Approximation

Use Table 6.3 to add the Q, R, and S potentials to obtain net potentials for Recording 1—Supine.

Table 6.3
QRS
POTENTIAL
Lead | ] [Dela ] Lead i L2 [ Deta ]
Q
R
S
QRS Net

Graph 3: Supine

Radial Graduations = 0.1 mV

40°
-5°
RA(-) 180° -0°» Lead |
LA(+)
& <
M~ o~
~N 0 e O
O %
&
From the above graph, find the following values:
Condition Mean Ventricular Potential Mean Ventricular (QRS) Axis

Supine

Page P-7

Explain the difference in Mean Ventricular Potential and Axis for the Supine data in this plot (Graph 3) and the first plot

(Graph 1).
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I1. Questions

D. Define ECG.

E. Define Einthoven’s Law.

F. Define Einthoven’s Triangle and give an example of its application.

G. What normal factors effect a change the orientation of the Mean Ventricular (QRS) Axis?

H. Define Left Axis Deviation (LAD) and its causes.

I. Define Right Axis Deviation (RAD) and its causes.

J. What factors affect the amplitude of the R wave recorded on the different leads?
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I11. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials
C. Method
D. SetUp

E. Experimental Results

End of Lesson 6 Data Report
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l. INTRODUCTION

The primary purpose of the heart is to pump blood throughout the body. To pump blood, the heart has a rhythmical sequence
of both electrical and mechanical events, the cardiac cycle. The electrical activity, recorded as an electrocardiogram
(ECG,)) initiates the mechanical activity of the heart (contraction and relaxation of atria and ventricles). When the heart
chambers contract, they pump blood to the next section of the cardiovascular system. This lesson will focus on the actions of
the left ventricle, which pumps blood to the systemic circulatory system, producing a pulse.

During the cardiac cycle the electrical activity of the ventricles, as represented by the QRS complex of the ECG, precedes the
mechanical event of ventricular muscle contraction (ventricular systole). Within the range of normal resting heart rates,
systole begins at the time of the R wave peak and ends at the end of the T wave. The T wave, which represents repolarization
of the ventricles, occurs during the time the ventricles are in systole. Ventricular diastole, a period of relaxation of
ventricular muscles, begins at the end of systole and lasts until the next R wave peak. Since each cardiac cycle contains one
period of ventricular systole immediately followed by one period of ventricular diastole, the duration of one cardiac cycle, or
heartbeat, can be measured as the time between successive R waves (Fig. 7.1). In the ECG cycle, electrical activity precedes
and initiates mechanical activity.

R R
P— . e
Electrical [
Activity
Qrs
13 S
11
Mechanical ventricular___ Ventricular __Ventricular__
Activity Systole Diastole Systole

Fig. 7.1 Cardiac cycle

Contraction of the ventricles (ventricular systole) pushes a volume of blood (stroke volume) into arteries. From the left
ventricle, the blood goes into the aorta and throughout the rest of the body. Each section of blood “bumps” the downstream,
neighboring section of blood to facilitate blood flow. The aorta and other arteries have muscular walls, which allow the
arterial walls to expand slightly to receive the volume of blood during systole and then, elastic recoil of the arteries helps to
continue “pushing” the blood through the rest of the system. The arterial pressure throughout the cardiac cycle is the main
force for blood flow.

The pumping action of the ventricles also initiates a pressure wave that is transmitted via the arterial walls. The pressure
increases with systole and decreases with diastole. The stiffness of the vessel walls helps transmit the pressure wave. The
stiffer the walls, the faster the transmission of the pressure wave, but the more work is required by the heart to move the same
blood volume.

When the pressure wave is transmitted to the periphery, e.qg., fingertip, there is a pulse of increased blood volume. The tissues
and organs change in volume as blood vessels dilate or constrict and as pulses of blood pass through the blood vessels during
each cardiac cycle. Changes in blood volume of organs may be brought about by the autonomic nervous system acting on the
cardiovascular system, environmental factors (such as temperature,) metabolic activity of an organ, and a variety of other
variables.

Page I-1 ©BIOPAC Systems, Inc.
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For example, temperature regulation involves controlling blood flow to the skin; when heat needs to be conserved, blood
flow to the skin is minimized and when excess heat is being generated, the opposite occurs.

The actual blood flow is slower than the transmission of the pressure wave. The aorta has the fastest blood flow in the body at
approximately 40-50 cm/sec (approximately 1 mile per hour) whereas the speed of the pressure wave can be much faster.

The travelling speed of the pressure wave from the heart to the periphery can be affected by many interrelated factors,
including the heart’s ability to contract strongly, blood pressure, the relative elasticity of the arteries, and the diameters of
systemic arteries and arterioles. These factors change in response to body positions, sympathetic nervous system input,
emotions, etc. For example, the travelling speed of the pressure wave has been shown to correlate with sympathetic influence
and systolic blood pressure.

The study of blood volume changes within an organ by using volume displacement techniques is known as plethysmography.
In this lesson, you will simultaneously record the ECG and subsequent pulse. The SS4LA transducer will be used to record
changes in blood volume via optical photoplethysmography (PPG) methods. The transducer works by shining a beam of
Near-infrared light through the skin and measuring the amount of light that is reflected. Blood is highly reflective of Near-
infrared light due to the hemes subunit of hemoglobin (red pigment in blood). When the transducer is placed on the skin, in
proximity to capillaries, the reflectance of the infrared light from the emitter to the detector will change in accordance to
capillary blood volume. Greater blood flow will cause greater signal amplitude. Note that the PPG signal provides a relative
(dimensionless,) not absolute, measure of blood flow, however in this lesson we display in units of millivolts (mV).
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Il. EXPERIMENTAL OBJECTIVES

1) To become familiar with the principle of plethysmography and its usefulness in qualitatively assessing peripheral
changes in blood volume.

2) To observe and record changes in peripheral blood volume and pressure pulse under a variety of both experimental
and physiological conditions.

3) To determine the approximate speed of the pressure pulse wave traveling between the heart and the finger.

4) To illustrate the electrical activity associated with normal cardiac activity and how it relates to the flow of blood
throughout the body.

I11. MATERIALS

e BIOPAC Electrode Lead Set (SS2L)

e BIOPAC Disposable Electrodes (EL503,) 3 electrodes per subject

e BIOPAC Pulse Transducer (SS4LA or SS4L)

e Ruler or Measuring Tape

e lce water or warm water in plastic bucket

e BIOPAC electrode gel (GEL1) and abrasive pad (ELPAD) or skin cleanser
e Biopac Student Lab System: BSL 4 software, MP36 or MP35 hardware

e Computer System (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP
FAST TRACK Setup Detailed Explanation of Setup Steps
1.  Turn the computer ON.
2. If the MP36/35 unit is on, turn it OFF.
3. Plug the equipment in as follows:
Electrode Lead Set (SS2L) — CH 1
Pulse Transducer (SS4LA) or
Pulse Transducer (SS4L) — CH 2
4.  Turn ON the MP36/35 unit.

Fig. 7.2 MP connections

5. Clean and abrade skin. If the skin is oily, clean electrode sites with soap and water or alcohol

6. Attach three electrodes on the Subject before abrad-lng.
(Fig. 7.3). If electrode is dry, apply a drop of gel.

Remove any jewelry on or near the electrode sites.

Setup continues...

Page P-1 ©BIOPAC Systems, Inc.
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7.

Clip the Electrode Lead Set (SS2L) to the
electrodes, following the color code (Fig.
7.4).

e RED = LEFT ankle

e WHITE = RIGHT wrist

e BLACK = RIGHT ankle

Setup continues...

L07 - ECG & Pulse Biopac Student Lab 4

Fig. 7.3
= One electrode on the medial surface of the left leg, just above
the ankle bone.
= One electrode on the medial surface of the right leg, just
above the ankle bone.
= One electrode on the right anterior forearm just above the
wrist (same side of arm as the palm of hand.)

Note: For optimal electrode contact, place electrodes on skin at least
five minutes before start of Calibration.

o VIN+

Fig. 7.4
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8. Clean the window of the pulse transducer.  This will prevent any oil or dirt on the window from interfering with the
signal. Use a soft cloth, Q-tip, or other non-abrasive material to wipe it

clean.
9. Put pulse transducer sensor on tip of The transducer should be snug, but not so much that blood circulation is
RIGHT index finger (Fig. 7.5) wrap cut off—it’s a fine line between snug and too tight.
Velcro snugly around finger, but not too
tightly.
Fig. 7.5 Sensor position on RIGHT hand
10. Subject gets in proper seating position, The cables should have enough slack to not pull on the electrodes or the
facing away from monitor and adjusts the  transducer when hands are in lap, and must be positioned to allow
leads and cables (Fig. 7.6). unrestricted movement when right hand is raised above the head.
Connect the electrode cable clip to a convenient location on Subject’s
clothes.
11. Start the Biopac Student Lab Program. Start Biopac Student Lab by double-clicking the Desktop shortcut.
12. Choose lesson “L07 — ECG & Pulse” and
click OK.

[l Ly
Biopac
Student Lab
4.0
No two people can have the same filename, so use a unique identifier,
such as Subject’s nickname or student ID#.

A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a common folder.

13. Type in a unique filename and Click OK.

14. Set Preferences. This lesson has optional Preferences for data and display while recording.
« Choose File > Lesson Preferences. Per your Lab Instructor’s guidelines, you may set:
Grids: Show or hide gridlines

Heart Rate Data: Calculate and display Heart Rate data.

Lesson Recordings: Specific recordings may be omitted based on
instructor preferences.

o Select an option.
o Select the desired setting and click OK.

END OF SETUP
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B. CALIBRATION

The Calibration procedure establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for
optimal performance. Pay close attention to Calibration.

FAST TRACK Calibration Detailed Explanation of Calibration Steps

1. Subiject is seated relaxed and still, facing
away from monitor (Fig. 7.6).

Fig. 7.6 Proper seating position for Calibration and Lesson

Subject must be seated in a chair, arms at side of body and knees flexed
with feet supported.

2. Click Calibrate. Subject must remain relaxed and as still throughout calibration to
minimize baseline shift and EMG artifact.

3. Wait for Calibration to stop. Calibration lasts eight seconds.

4. Verify recording resembles the example There should be a recognizable ECG waveform with a baseline at or near
data. 0 mV, little EMG artifact and no large baseline drift. The lower channel

e com aw— should display a visible pulsatile waveform.

proceed to Data Recording. _ _ '
o If necessary, click Redo Calibration.

Gm T am wm

Fig. 7.7 Example Calibration data

If recording does not resemble the Example Data
= |f the data is noisy or flatline, check all connections to the MP unit.
= |f the ECG displays baseline drift or excessive EMG artifact:

o Verify electrodes are making good contact with the skin and that
the leads are not pulling on the electrodes.
O Make sure Subject is in a relaxed position
= |If the Pulse Signal is not present, change the position or tightness of

END OF CALIBRATION the transducer. Some Subjects may not produce a good pulse signal
and it may be necessary to use a different Subject.
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C. DATA RECORDING

FAST TRACK Recording

1. Subject is seated and relaxed, arms
supported, breathing normally, facing away
from monitor.

¢ Review recording steps.

Seated and relaxed
Click Record.
Record for 15 seconds.
Click Suspend.

Verify that recording resembles the
example data.

o If similar, click Continue and proceed
to the next recording.

U S| @ [

e If necessary, click Redo.

o If all required recordings have been
completed, click Done.

Recording continues...

L07 - ECG & Pulse Page P-5

Detailed Explanation of Recording Steps
Three conditions will be recorded*: Arm relaxed, hand in hot or cold
water, and hand held up.

*IMPORTANT

This procedure assumes that all lesson recordings are enabled in Lesson
Preferences, which may not be the case for your lab. Always match the
recording title to the recording reference in the journal and disregard any
references to excluded recordings.

Hints for obtaining optimal data:
To minimize muscle (EMG) artifact and baseline drift:
= Subject must be relaxed.

= Make sure electrodes do not peel up and that the cables and leads do
not pull on the electrodes or transducer.

Subject remains seated and relaxed.

F00  BO0 900 000 1100 1200 1300 1400 1500 10D
[

Fig. 7.8 Example Seated and relaxed data

The data description is the same as outlined in Step 4 of the Calibration
procedure.

Click Redo and repeat Steps 2 — 5 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

200
70 B0 B0 |
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Seated, left hand in water

6. Subject remains seated and relaxed, facing Warm water should be approximately 40° C (104 deg F,) cold water
away from monitor. approximately 20° C (68 deg. F.)

e Review recording steps.

7. Put Subject’s left (non-recording) hand
into a plastic bucket filled with water (Fig.
7.9).

WARNING
The container for the water must not

be metal, as this poses the potential
danger of bypassing the electrical
isolation of the MP unit.

Fig. 7.9 Positioning

8. Once Subiject is still, click Record. In order to capture the heart rate and pulse variation, click Record as
quickly as possible after Subject’s hand is in water and they are still.
9. Record for 30 seconds. Subject remains seated, relaxed with left hand in water.

10. Click Suspend.
11. Subject removes hand from water.

12. Verify recording resembles the example

data.

o If similar, click Continue and proceed

to the next recording. i e

1o
S A Y & O P |V S |G S S SO S L U o Sy S S A S N S
. — - - .. fam
T M0 X0 W00 00 L0 B0 MDD B0 BN TE B0 N0 W0 0 G0 90 M0 50 60
secorch

Fig. 7.10 Example Left hand in water data

i

e If necessary, click Redo. The data description is similar to that outlined in Step 4 of the Calibration
« If all required recordings have been procedure; however the pulse signal will most likely have a different
completed, click Done. amplitude and shape.

Click Redo and repeat recording if necessary. Note that if cold water was
used; wait for the Subject’s hand to return to normal temperature before
repeating Steps 7 — 12. Once Redo is clicked, the most recent recording
will be erased.

Recording continues...
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Seated, right hand above head

13. Subject remains seated, relaxed, facing
away from monitor.

e If cold water was used, wait for
Subiject’s hand to return to normal
temperature before continuing.

e Subject raises right hand above head,
arm extended, pulse transducer
attached (Fig. 7.11).

e Review recording steps.

14. Click Record.
15. Record for 60 seconds.
16. Click Suspend.

17. Verify recording resembles the example
data.

o If similar, click Continue to proceed to
the optional recording section, or Done
to finish the lesson.

e If necessary, click Redo.

Recording continues...

L07 - ECG & Pulse

Fig. 7.11
Adjust any leads or cables that are pulling on the electrodes or transducer.

Subject remains seated with right arm extended above head.

There could be more EMG artifact in the ECG recording and there could
be more baseline drift than in previous recordings. The pulse recording
will vary greatly between Subjects; some displaying greater pulse
amplitude and some less.

e e ”'f'w'i‘“'|"'*"'f' YLyt o

' W et

00 M) E00 OR00 W00 GRG0 WAG0 000 G100 BOOD MO0 400 0R00 J0SAC
rerrah

Fig. 7.12 Example Hand raised above head data
The data might be different for the reasons detailed in Step 4 of the
Calibration procedure.

Click Redo and repeat Steps 13 — 17 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

Page P-7
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OPTIONAL ACTIVE LEARNING PORTION

18. After clicking Done, choose an option and
click OK.

19. Remove the electrodes and the transducer.

END OF RECORDING

L07 - ECG & Pulse Biopac Student Lab 4

With this lesson you may record additional data by clicking Continue
following the last recording. Design an experiment to test or verify a
scientific principle(s) related to topics covered in this lesson. Although
you are limited to this lesson’s channel assignments, the electrodes or
transducers may be moved to different locations on the Subject.
Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each step to
make it easy to follow during recording.

Run Your Experiment
D. SetUp

Set up the equipment and prepare the subject for your experiment.
E. Record

Use the Continue, Record and Suspend buttons to record as much
data as necessary for your experiment.

Click Done when you have completed all of the recordings required
for your experiment.

Analyze Your Experiment
F. Set measurements relevant to your experiment and record the results
in a Data Report.
If choosing the Record from another Subject option:
=  Repeat Setup Steps 5 — 10, and then proceed to Calibration.
Remove the electrode cable pinch connectors and peel off all electrodes.
Discard the electrodes (BIOPAC electrodes are not reusable.) Wash the

electrode gel residue from the skin, using soap and water. The electrodes
may leave a slight ring on the skin for a few hours which is quite normal.
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V. DATA ANALYSIS

FAST TRACK DATA ANALYSIS

1. Enter the Review Saved Data mode and
choose the correct file.

¢ Note Channel Number (CH)
designations:
Channel Displays
CH1 ECG
CH 40 Pulse
« Note measurement box settings:

Channel Measurement

CH1 Delta T (time interval)
CH1 BPM (rate)

CH1 P-P

CH 40 P-P

DETAILED EXPLANATION OF DATA ANALYSIS STEPS

If entering Review Saved Data mode from the Startup dialog or lessons
menu, make sure to choose the correct file.

The data window should resemble Fig. 7.13.

T EomT - TE W Py —
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Fig. 7.13 Example data
The measurement boxes are above the marker region in the data window.
Each measurement has three sections: channel number, measurement type,
and result. The first two sections are pull-down menus that are activated
when you click on them.
Brief definition of measurements:

Delta T: Displays the amount of time in the selected area (the
difference in time between the endpoints of the selected area.)

BPM: The Beats Per Minute measurement first calculates the
difference in time between the beginning and end of the selected area
(seconds/beat,) and divides this value into 60 seconds/minute.

P-P (Peak-to-Peak): Subtracts the minimum value from the maximum
value found in the selected area.

Rate Mean: If CH 40 Heart Rate data was recorded, use the Rate Mean
measurement, which is designed specifically for rate data and calculates
accurate statistical means using one value only for every cardiac cycle.
This avoids any unintentional weighting due to time variation in heart
rate, unlike the amplitude "Mean" measurement.

The “selected area” is the area selected by the 1-Beam (including
endpoints.)

Note: The append event markers 4 mark the beginning of each recording.
Click on (activate) the event marker to display its label.

Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom Back,
Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)
Cursor Tools: Zoom Tool
Buttons: Overlap, Split, Show Grid, Hide Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click” (Mac)
the channel number box to toggle channel display.

2. Zoom in on a small section of the “Seated Be sure to zoom in far enough so that you can easily measure the intervals

and relaxed” data.

Data Analysis continues...

Page P-1

between peaks, approximately 4 cardiac cycles.
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3. Using the I-Beam cursor, select the area
between two successive R waves (one
cardiac cycle).

g a

4. Repeat the above measurements for each
of the data recordings.

g A

5. Using the I-Beam cursor, select the area
between two successive pulse peaks (one
cardiac cycle).

g A

6. Repeat the above measurements for each
of the data recordings.

g A

7. Select individual pulse peaks for each

recording and determine their amplitudes.

gl

Data Analysis continues...

L07 - ECG & Pulse Biopac Student Lab 4

Try to go from R wave peak to R wave peak as precisely as possible (Fig.
7.14).

e Tl s L S i MRS H- come EEiee -0

Fig. 7.14 R-R interval selected

T HomT - twoom DM - s | S Lo BEEEE- Lo e

Fig. 7.15 Area between two successive pulse peaks

Use the P-P (CH 40) measurements.

Note: It is best to take measurements on data immediately following the
start of the recording (after marker) because the body’s homeostatic
regulation of blood pressure and volume occurs quickly. The increase or
decrease in your results will be dependent on the timing of your data
relative to the speed of physiological adjustments.

e Tl e N L 5. oones  WEES H- oo e - on

'\Marker

Fig. 7.16 Selection for amplitude measurements
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8. Using the I-Beam cursor, select the
interval between the R-wave and pulse
peak.

gc

9. Answer the questions at the end of the
Data Report.

10. Save or Print the data file.
11. Quit the program.

END OF DATA ANALYSIS
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Record two time intervals (Delta T;) one from “Seated and Relaxed” data
and “Seated, right hand above head” data.

TET W can= LEE B oo T - o GEEE- wme EEee - o

Fig. 7.17 R-wave to next pulse peak

An electronically editable Data Report can be found in the journal
(following the lesson summary,) or immediately following this Data
Analysis section. Your instructor will recommend the preferred format for
your lab.

END OF LESSON 7

Complete the Lesson 7 Data Report that follows.
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ECG & PULSE

e Mechanical Action of the Heart, Peripheral Pressure Pulse, and Plethysmography

DATA REPORT
Student’s Name:
Lab Section:
Date:

I. Data and Calculations

Subject Profile
Name: Height:

Age: Gender: Male / Female Weight:

A. Comparison of ECG with Pulse Plethysmogram

Complete Table 7.1 with data from three cycles from each acquired recording and calculate the Means.

Table 7.1

Condition Selected Area Measurement Cyclel |Cycle2 | Cycle3 Mean
Arm Relaxed R-R Interval DeltaT CH1
Heart Rate BPM CH1
Pulse Interval DeltaT CH1
Pulse Rate BPM CH1
Temp. Change R-R Interval DeltaT CH1
Heart Rate BPM CH1
Pulse Interval DeltaT CH1
Pulse Rate BPM CH1
Arm Up R-R Interval DeltaT CH1
Heart Rate BPM CH1
Pulse Interval DeltaT CH1
Pulse Rate BPM CH1

B. Relative Volume Changes

Complete Table 7.2 with data from each acquired recording.

Table 7.2
Arm Resting | Temperature Arm Up
Measurement
QRS Amplitude
CH1 P-P

Relative Pulse Amplitude (mV)
CH 40 P-P
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C.

Calculation of Pulse Speed

Distance between Subject’s sternum and shoulder? cm
Distance between Subject’s shoulder and fingertip? cm
Total distance? cm

Data from ‘Arm relaxed’ recording of the recording (measure with I-Beam)
Time between R-wave and Pulse peak? Secs

Speed? cm/sec

Data from ‘Arm up’ recording of the recording (measure with 1-Beam)

Time between R-wave and Pulse peak? Secs
Speed? cm/sec
Questions

Referring to data in table 7.1, are the values of heart rate and pulse rate similar for each condition? Yes / No

Explain why the values might differ or be similar.

Referring to Table 7.2 data, how much did the amplitude of the QRS complex change between conditions?

Extreme temp — Arm Resting? mVv
Arm up — Arm Resting? mVv
Referring to Table 7.2 data, how much did the pulse amplitude change between arm positions?
Extreme temp — Arm Resting? mV
Arm up — Arm Resting? mV

Referring to Table 7.2 data, does the amplitude of the QRS complex change with the pulse amplitudes? Why or why not?

Describe one mechanism that causes changes in blood volume to your fingertip.

Referring to data from section C of this report, how would you explain the difference in speed, if any?

Which components of the cardiac cycle (atrial systole and diastole, ventricular systole and diastole) are discernible in the
pulse tracing?
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K. Would you expect the calculated pulse wave velocities of other students to be very close if not the same as yours? Why
or why not?

L. Explain any amplitude or frequency changes that occurred with arm position.

I11. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials
C. Method
D. SetUp

E. Experimental Results

End of Lesson 7 Data Report



n B’OPAC® Biopac Student Lab® Lesson 9 Richard Pflanzer, Ph.D.
Associate Professor Emeritus
Sysfems InC ELECTRODERMAL ACTIVITY & Indiana University School of Medicine
Rupiatered 15150 0001:2008 POLYGRAPH Purdue University School of Science

42 Aero Camino, Goleta, CA 93117

Introduction William McMullen

www.biopac.com Rev. 01152013 Vice President, BIOPAC Systems, Inc.

SRR - conew G - o VAR e 0 mrie aw e 5 R o

[EEE 56 W Sn 6e WS T e e W DU TS S B SaE S Tie i B e |

INTRODUCTION

Electricity flows through an electrical circuit because of a difference in electrical pressure between the beginning and the
end of a circuit. Electrical pressure or electromotive force (E) is measured in volts (V). The flow of electricity, called
current (1,) is measured in amperes (A) or amps for short. As electricity flows through the circuit, resistance to flow
occurs. Electrical resistance (R) is measured in ohms (€2).

In a simple circuit of direct electrical current, the relationship between the electromotive force causing the electrical
current, the resistance to flow of electricity and the resultant magnitude of the current is described by Ohm’s Law.

Ohm’s Law: | (Amps) = E (Volts) / R (Ohms)

If two of the three variables are known, the unknown third variable can be calculated.

For example, if voltage and resistance values for a simple circuit are known,
the above formula can be used to calculate the value for current; if the values
for current and resistance are known, then the formula for computing voltage
is E=IR.

Ohm’s Law implies that if a constant current is applied across a resistance, changes in the resistance will produce a
voltage change directly proportional to the resistance change.

For example, if a constant current of 1.0 ampere is applied across a
resistance of 2.0 ohms, the measured voltage would be 2.0 volts (I = E/R, 1.0
ampere = 2.0 volts/2.0 ohms). If the resistance dropped to 0.5 ohm, the
voltage would also fall to 0.5 volt (I = E/R, 1.0 amperes = 0.5 volt/0.5 ohm).

In this lesson, you will apply principles of Ohm’s Law and record changes in the electrical resistance of the skin.

The human skin displays several forms of bioelectric phenomena, especially in areas of the extremities such as the
fingers, palms of the hands, and soles of the feet.

e Galvanic skin resistance (GSR) — When a feeble electric current is steadily applied between two electrodes
placed about an inch apart, the recorded electrical resistance between them, referred to as the galvanic skin
resistance (GSR,) varies in accordance with the emotional state of the subject.

e Galvanic skin potential (GSP) — Similarly, if the electrodes are connected to a suitable voltage amplifier, but
without any externally applied current, the voltage measured between them, referred to as the galvanic skin
potential (GSP,) varies with the emotional state of the subject.

The combined changes in the GSR and GSP related to the emotion of the subject constitute the galvanic skin response
(GSR).

Electrodermal activity (EDA) has replaced galvanic skin response (GSR) as the collective term used to describe
changes in the skin’s ability to conduct electricity. The preferred measure of EDA is conductance (inverse of resistance)
in units of microsiemens. Conductance is preferred over resistance because the skin does not act as a single resistor, but
rather a series of many resistors in parallel. The normal human EDA range is from 1 to 20 microsiemens.

Page I-1 ©BIOPAC Systems, Inc.
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The physiological basis of EDA is a change in autonomic tone, largely sympathetic, occurring in the skin and
subcutaneous tissue in response to a change in the affective state of the subject. Changes in peripheral autonomic tone
alter sweating and cutaneous blood flow, which in turn change EDA.

For example, if a painful stimulus such as a pinprick is applied to the skin in
an area distant to the electrode, the stimulus will reflexively elicit a general
phasic sympathetic discharge to sweat glands, increasing secretion. The
increase in sweat, although generally small, lowers the electrical resistance
of the skin because sweat contains water and electrolytes, both of which
increase electrical conductivity of the skin.

As in the case of somatic sensory stimuli (e.g., pain, pressure, touch,) changes in emotion elicit changes in peripheral
autonomic tone and hence the EDA. A common example is the vasodilation of cutaneous blood vessels of the face
(blushing) and increased sweating that often occurs in the emotional state of embarrassment.

Special sensory stimuli (vision, hearing, equilibrium, taste, smell) also affect a person’s emotional state, as any
aficionado of classical music or hard rock can attest. Interestingly, although highly subjective, the perception of color
may elicit changes in autonomic tone, which in turn, affect the subject’s mood and behavior. Warm colors such as red,
orange, and yellow evoke emotions of warmth and comfort in some persons, feelings of anger and hostility in others. The
phrase “seeing red” refers to an angry person. Cool colors such as green, pink, and blue evoke feelings ranging from
enviousness (“green with envy”,) tranquility, and sadness or indifference (“feeling blue™).

The influence of color on the affective state was well known to ancient Egyptians, Chinese, and other cultures who used
colors to promote healing. The therapy, called chromotherapy, is still used today in holistic medical practice. It must be
noted that most clinicians are skeptical of color therapy. The effects of color therapy vary from person to person and tend
to be short-lived or temporary. In this lesson we will explore the short-term influence of color on the affective state of the
subject as revealed by changes in EDA.

The detection and recording of the EDA is often combined with the detection and recording of other autonomic-
dependent psychophysiological variables such as heart rate, respiratory rate, and blood pressure. The device that detects
and records these variables is called a polygraph. Although many people think polygraph is synonymous with lie
detector, the literal meaning is “many measures” (poly - many, graph — write).

This lesson is a polygraph in the true sense of the word since it uses three types of measures: (a) EDA, (b) respiration,
and (c) heart rate.

One of the underlying principles involved in using the polygraph as a lie detector is that autonomic nervous system
control of heart rate, respiratory rate, blood pressure and flow, and sweating cannot consciously be altered. Another
principle is that changes in emotion associated with intentional falsification of answers to carefully selected and worded
questions involuntarily and subconsciously alters autonomic output in such a way as to cause recognizable changes in
recorded physiological variables.In the experiments that follow, you will record respiration, EDA, and heart rate under
various experimental procedures so as to gain a better understanding of polygraphy, its applications, and its limitations.

The BIOPAC EDA transducer works by placing one electrode at ground (0 Volts) and the other at a constant 0.5 Volts
DC. The internal circuit measures the amount of current required to maintain .5 Volts across the two electrodes. These
two electrodes are connected to two different fingers, so there will be an effective resistance (R) placed across the
electrodes. The current measured (I = E/R) is proportional to the conductance (1/R) because the voltage (E) is constant.
Normal human EDA ranges from 1 to 20 microsiemens, so the maximum current flow would be approximately 10 micro
amps. For this lesson we are only interested in changes in EDA over short periods of time (after a question is asked, etc.)
To help in interpreting the data, the software applies a .05 Hz High Pass filter to allow the baseline to always settle to 0.
For this reason the units for EDA are “delta microseimens” to indicate that it is measuring changes in EDA.

| Itis important to keep in mind that although the recording procedures and measures used are similar

_ to those that might be used in a real polygraph recording, this is not a “lie detector test.” All you will do
_here is record the subject’s physiological responses to certain questions. Some types of physiological
. responses are typically associated with “lying,” although even under the best conditions about one-third of |
- innocent people “fail” lie detector tests. The best you can hope for here is to get a better understanding of
| how these types of procedures work.
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II. EXPERIMENTAL OBJECTIVES

1) To become familiar with procedures for recording electrodermal activity.

2) To observe and record changes in respiratory rate, heart rate, and skin resistance associated with somatic and special
sensory stimuli.

3) To observe and record changes in respiratory rate, heart rate, and skin resistance associated with cognitive behavior
and emotion.

4) To analyze a 3-channel polygram recorded under various experimental conditions to gain a better understanding of
polygraphy and its potential for use and misuse.

III. MATERIALS

e BIOPAC Disposable Electrodes (EL503,) 3 electrodes per Subject
e BIOPAC Electrode Lead Set (SS2L) or BIOPAC Pulse Transducer (SS4LA/L)
e BIOPAC EDA setup
o Disposable setup: EDA Lead (SS57L) and EDA Electrodes (EL507 x 2)
o Reusable setup: EDA Transducer (SS3LA/L) and Electrode gel (GEL101)
e BIOPAC Respiratory Transducer (SS5LB or older SSSLA or SS5L)

e BIOPAC PAPERI or nine sheets of different colored paper. Recommended: 8-1/2x 11” sheets in white, black,
green, red, blue, yellow, orange, brown, pink

e Biopac Student Lab System: BSL 4 software, MP36 or MP35 hardware
e Computer System (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP
FAST TRACK Setup Detailed Explanation of Setup Steps

1. Turn the computer ON.
2. Turn OFF MP36/35 unit.

3. Plug the transducers in as follows:
Respiratory Transducer (SSSLB) — CH 1
Electrode Lead Set (SS2L) or Pulse
Transducer (SS4L)* — CH 2
EDA (SS3LA OR SS57L) — CH 3

4. Turn ON the MP36/35 unit.

*Qptional: A Pulse Transducer can be used in
place of the default SS2L Electrode Lead Set by
selecting the “SS4LA/L: PPG-Pulse” option in
the “Cardiac Signal” Preference. This option is
available in BSL 4.1.1 and higher only. (See Figs.
9.2 and 9.3)

Setup continues... Fig. 9.2 Hardware Connections with SS4L (Pulse)

Page P-1 ©BIOPAC Systems, Inc.
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5. Attach the Respiratory Transducer (SS5L)
around the Subject’s chest (Fig. 9.4).

6. Place the EDA Transducer on the index and
middle finger of the left hand.

o If using SS57L EDA Lead and ELS507

e If using SS3LA and GEL101

- Clean and fill both cavities of the EDA
Transducer (SS3L/SS3LA) with isotonic
gel and then attach to the Subject. (Do not
abrade skin for EDA.)

(Fig. 9.7)

Setup continues...

L09 - EDA & Polygraph

If using the optional SS4L
Pulse Transducer, attach it to
the Subject’s right index finger
(Fig. 9.3).

Wrap the Velcro strap tightly
around the index finger, but not
too tightly.

Instead of an ECG waveform,
the SS4L measures a pulse
photoplethysmogram signal,
and very accurately detects
small changes in pulse rate and
pressure.

Transducer should be placed
below the armpits and above
the nipples.

IMPORTANT: The tension
must be slightly tight at the
point of maximal expiration
(chest contracted).

If using the SSSLA, loop the
nylon straps through the
corresponding slots in the
transducer to hold it in place
when tightened (Fig. 9.5).

IMPORTANT: The SS5LA is
fragile. Do not pull hard on the
ends of the rubber portion.

Attach two EL507 electrodes
to the Subject’s fingertips
and clip the SS57L Lead, as
shown in Fig. 9.6.

If electrode is dry, apply a
drop of gel.

Biopac Student Lab 4

Fig. 9.3 SS4L Placement

Fig. 9.4 SS5L Placement

s

Fig. 9.5 SS5LA

Fig. 9.6 SS57L and EL507 Setup

= CLEAN: Each cavity of the EDA Transducer should be carefully
cleaned with an abrasive pad to remove any residue from the
electrode. Data quality may suffer if the transducer becomes
gummed with dried gel from previous uses.

=  FILL: Fresh isotonic gel (GEL101) must fill the cavity to create
contact between the skin and the electrodes.

Fig. 9.7 SS3L/SS3LA attachment and connection

Position the electrodes are over the pads of the fingers and wrap the
Velcro® tape so the electrodes fit snugly but not so tight that blood

circulation is cut off.
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7. Set up the LEAD II recording. If the skin is oily, clean electrode sites with soap and water or alcohol
a) Clean and abrade skin. before abrading.
Co . . .
) Al s o ek om SrET A If the Subject’s hands are excessively dry or cold, instruct the Subject

sl i B, 049 arid 9.0, to rub har}ds together to warm them.and slightly activate the sweat
glands prior to calibration or recording.
¢) Connect the Electrode Lead Set (SS2L) to

El;eigelgcggodes Lo e EelEr et Remove any jewelry on or near the electrode sites.

If electrode is dry, apply a drop of gel.

Place one electrode on the medial surface of each leg, just above the
ankle. Place the third electrode on the right anterior forearm at the
wrist (same side of arm as the palm of hand).

For optimal electrode contact, place electrodes on skin at least 5
minutes before start of Calibration.

e WHITE = RIGHT wrist
e RED =LEFT ankle
e BLACK = RIGHT ankle

Fig. 9.8 Lead Il Setup Fig. 9.9 Electrode Leads

The pinch connectors work like a small clothespin, but will only latch
onto the nipple of the electrode from one side of the connector.

8. Start the Biopac Student Lab program. Start Biopac Student Lab by double-clicking the Desktop shortcut.
Choose “L09 — EDA & Polygraph” and
click OK.
10. Type in a unique filename and click OK.
Biopac
Student Lab
4.0

No two people can have the same filename, so use a unique identifier,
such as Subject’s nickname or student ID#.

A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a common folder.

Important: The Respiratory Transducer model number must be
specified in Lesson Preferences or the recorded signal may be out of
range or too low or too high. See Step 12 below.

11. If you will be recording “Colored Squares,” Ordering from top to bottom: white, black, red, blue, green, yellow,

get colored paper in the proper order. orange, brown, pink.
12. Optional: Set Preferences. This lesson has optional Preferences for data and display while
e Choose File > Lesson Preferences. recording. Per your Lab Instructor’s guidelines, you may set:

Grids: Show or hide gridlines

Respiratory Transducer: Specify the model as SSS5LB, SSS5LA, or SS5L.
o Select the desired setting and click OK. Cardiac Signal: Specify the cardiac transducer model as SS2L (ECG) or
SS4LA/L (Pulse).

END OF SETUP I._esson Recordings: Specific recordings may be omitted based on
instructor preferences.

e Select an option.
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B. CALIBRATION
The Calibration procedure establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for
optimal performance. Pay close attention to Calibration.

FAST TRACK Calibration Detailed Explanation of Calibration Steps
1. Subject is seated, relaxed, breathing normally,
and facing away from monitor.

o IMPORTANT: Subject must be at resting
heart rate prior to recording.

A\ Iﬂ(
Fig. 9.10 Calibration Seating
The Subject should sit with arms relaxed at side of body and hands apart
2. Click Calibrate. in lap, with legs flexed at knee and feet supported.

3. Three seconds after Calibration begins, a beep The program needs to see a change in the EDA during Calibration. The
will sound. When heard, Subject will inhale Subject should try to minimize chest movement, as this may cause
once quickly and deeply, and then return to excessive EMG artifact. NOTE: If using the SS57LA EDA transducer
normal breathing. (BSL 4.1 only) you will see the following prompts during Calibration:

Biopar Student Lah

Fnpcrath diponectcos kad o Ao andtten ok, || Focanmectthe £58 s andthm ek i
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4. Wait for Calibration to stop. Calibration lasts ten seconds.

5. Verify recording resembles example data. The Respiration channel should show variations, particularly during deep

inhale/exhale. The ECG waveform should have a baseline at or near 0
mV, no excessive EMG artifact, and no excessive baseline drift before or
after the deep inhale/exhale. The EDA data should increase a few

o Ifnecessary, click Redo Calibration. seconds after the deep inhale/exhale, and then slowly return to baseline.

o If similar, click Continue and proceed to
Data Recording.

Fig. 9.11 Example Calibration data
If recording does not resemble Example Data...

= Ifno beep was heard, redo Calibration and begin deep, quick, inhale
after three seconds.

= [If data is noisy or flatline, check all connections to MP unit.
= [f Respiration channel shows no variation:
o Verify Respiratory Transducer has not slipped and strap is snug.
o Verify preference is set correctly (after Redo — see setup Step 12).
= Ifthe ECG displays excessive baseline drift or EMG artifact:

o Verify electrodes are making good contact with the skin and that
the leads are not pulling on the electrodes.

O Make sure Subject is in a relaxed position.

= Despite your best efforts, it may not be possible to obtain measurable
END OF CALIBRATION EDA from some Subjects. If this occurs, move on to another Subject.
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C. DATA RECORDING

1.

FAST TRACK Recording

Subject faces Director and listens for
instructions.

o Carefully review upcoming steps.

Count and touch
Click Record.

Five seconds into recording, Director asks
Subject to say full name.

4. Recorder presses F2 and waits five seconds.

8.
9.

Director asks Subject to count backwards
from 10.

Recorder presses F3 and waits five seconds.

Director asks Subject to count backwards
from 30 by subtracting increasing odd
numbers: (30, 29, 26, 21, etc.)

Recorder presses F4 and waits five seconds.
Director touches Subject on side of face.

10. Recorder presses F5 and waits five

seconds.

11. Click Suspend.

12. Verity recording resembles the example data.

Recording continues...

L09- EDA & Polygraph Page P-5

Detailed Explanation of Recording Steps

Three recordings will be acquired* while the Subject is: performing
mental math, being touched, looking at colored paper, and answering a
series of “yes” or “no” questions.

*IMPORTANT

This procedure assumes that all lesson recordings are enabled in lesson
Preferences, which may not be the case for your lab. Always match the
recording title to the recording reference in the journal and disregard any
references to excluded recordings.

Hints for obtaining optimal data:
= Subject must be relaxed, still, and facing away from monitor.

= Subject should be at his/her resting heart rate in a relaxed mental and
physical state, and should not have performed any recent physical or
mental exertion.

= The environment must be quiet, and unrelated sensory input kept at a
minimum.

= Subject should answer questions quietly, with minimal movement of
the mouth.

= Only Redo a recording if it is absolutely necessary as the Subject
would most likely habituate and elicit less of a response to a repeated
procedure.

= Make sure to insert event markers at the right time during the
recording. If an event marker is missed, manually insert it after the
recording has stopped, rather than Redoing. To add a marker, right
click in the marker region and choose “Insert New Event” then type in
the event label. You can move the marker by holding down the “Alt”
key while dragging the marker.

The 5-second wait intervals are important to re-establish the baseline.

Recorder must insert an event marker at the precise moment that
Subject answers each question. Each event marker has a pre-assigned
label:

F2—Name
F3—Count from 10
F4—Count from 30
F5—Face touched

Suspend will halt the recording, allowing time to review the data.
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13.

14.
15.

16.

17.

18.

o If similar, click Continue and proceed to

the next recording.

e Ifnecessary, click Redo.

o Ifall required recordings have been
completed, press Done.

Colored squares
Director arranges colored paper in specified
sequence.
e Subject faces Director.

e Recorder prepares to insert event
markers at color changes.

o Carefully review upcoming steps.
Click Record.
Director holds colored paper in front of
Subject.

Director instructs Subject to concentrate on
each colored square for about 10 seconds,
and then lowers paper for five seconds
before presenting next color.

Recorder inserts an event marker (F9 key)
each time paper color is changed.

Click Suspend.

Recording continues...

L09 — EDA & Polygraph

Biopac Student Lab 4

All three channels should show variations in the data and all four event
markers should be present. Use the horizontal scroll bar to look at
different portions of the recording.

mT

T T Rt |

Fig. 9.12 Example Count and touch data

If recording does not resemble Example Data...

= If data is noisy or flatline, check all connections to MP unit.
= If Respiration channel shows no variation:

o Verify Respiration Transducer has not slipped and that strap is
snug.

o Verify preference is set correctly (after Redo — see setup Step 12).
= Ifthe ECG displays excessive baseline drift or EMG artifact:

o Verify electrodes are making good contact with the skin and that
the leads are not pulling on the electrodes.

O Make sure Subject is in a relaxed position
= Despite your best efforts, it may not be possible to obtain measurable
EDA from some Subjects. If this occurs, move on to another Subject.

Click Redo and repeat Steps 2 — 12 only if absolutely necessary as the
Subject would most likely habituate and elicit less of a response to the
repeated procedure.

Note that once Redo is clicked, the most recent recording will be erased.

Arrange colors in this sequence: White, black, red, blue, green, yellow,
orange, brown, pink. This ordering is important as pre-assigned event
marker labels will be inserted.

Recorder must listen for Director’s instructions to Subject in order to
know when to press F9 to place event markers.

The paper should be held close enough to the Subject to cover a
significant part of the field of view.

The 5-second time intervals between paper presentations are important
to re-establish the baseline.

Fig. 9.
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19. Verify recording resembles the example data.

o If similar, click Continue and proceed to
the next recording.

e Ifnecessary, click Redo.

e Ifall required recordings have been
completed, click Done.

Yes-No Questions

20. Subject faces the Director and listens for
instructions.

¢ Subject remains seated and relaxed.
o Carefully review upcoming steps.
21. Click Record.

22. Director asks Subject ten prepared questions
and notes Subject’s response.

23. Subject responds “yes” or “no.”
24. Recorder inserts event markers by pressing:

e F6 when question is asked
e F7 if answer is “Yes”
e F8 if answer is “No”

25. Director waits five seconds after question is
answered before asking next question.

Recording continues...

All three channels should show variations in the data and all nine event
markers should be present. Use the horizontal scroll bar to look at
different portions of the recording.

WM Bem WEW WO Snm 36 MRG  Sam  FAm Z0m  Dem R0 Sem  Sem S
Rtk

Fig. 9.14 Exampﬁe Colored squares data
The data could be different for the reasons detailed on Page 6.

If a mistake is made in the paper ordering (see Step 13,) manually change
the event marker labels rather than redoing the recording.

If an event marker is missing, manually enter it at the approximate
location rather than redoing. See Step 1 “Hints.” for more information.

Click Redo and repeat Steps 13 — 19 only if absolutely necessary as the
Subject would most likely habituate and elicit less of a response to the
repeated procedure.

Note that once Redo is clicked, the most recent recording will be erased.

Each question-answer should take about 10 seconds.
Subject may answer truthfully or dishonestly.

The 5-second time interval between Subject answering the question
and Recorder asking the next question is important to re-establish the
baseline.
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Questions:

a) Are you currently a student? Y N
b) Are your eyes blue? Y N
¢) Do you have any brothers? Y N
d) Did you earn an “A” on the last Y N

physiology exam?

e) Do you drive a motorcycle? Y N
f) Are you less than 25 years ofage? Y N

g) Have you ever traveled to another Y N
planet?

h) Have aliens from another planet Y N
visited you?

i) Do you watch “Survivor”? Y N
j) Have you answered all of the Y N
preceding questions truthfully?
26. Click Suspend. All three channels should show variations in the data and all event
27. Verify recording resembles example data. markers should be present. Use the horizontal scroll bar to look at

.. . different portions of the recording.
o If similar, click Continue to proceed to P 8

optional recording section, or Done to
finish the lesson.

Fig. 9.15 Example Yes-No data
The data could be different for the reasons detailed on Page 6.
If an event marker is missing, manually enter it at the approximate
location rather than redoing. See Step 1 “Hints” for more information.

e Ifnecessary, click Redo. Click Redo and repeat Steps 20 — 26 only if absolutely necessary as the
Subject would most likely habituate and elicit less of a response to the
repeated procedure.

Note that once Redo is clicked, the most recent recording will be erased.

28. Ask Subject whether or not each question
was answered honestly and note this in the
Data Report.

g c

Recording continues...
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OPTIONAL Active Learning Portion

29. After clicking Done, choose an option and
click OK.

30. Carefully remove all transducers and
electrodes.

END OF RECORDING

L09- EDA & Polygraph Page P-9

With this lesson you may record additional data by clicking Continue
following the last recording. Design an experiment to test or verify a
scientific principle(s) related to topics covered in this lesson. Although
you are limited to this lesson’s channel assignments, the electrodes or
transducers may be moved to different locations on the Subject.
Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hpypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each step to
make it easy to follow during recording.

Run Your Experiment
D. Set Up

Set up the equipment and prepare the subject for your experiment.
E. Record

Use the Continue, Record and Suspend buttons to record as much
data as necessary for your experiment.

Click Done when you have completed all of the recordings required
for your experiment.

Analyze Your Experiment

F. Set measurements relevant to your experiment and record the results
in a Data Report.

After clicking Done, a dialog with options will be generated. Make a

selection, and continue as directed.

If choosing the Record from another Subject option:
=  Repeat Setup Steps 5 — 7, and then proceed to Calibration.

If using the SS57L EDA transducer, remove the electrode pinch

connectors and peel off all electrodes. Discard the electrodes. (BIOPAC
electrodes are not reusable.)

If using the SS3LA EDA transducer, clean the electrode gel from each
cavity.

Wash the electrode gel residue from the skin, using soap and water.
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V. DATA ANALYSIS

FAST TRACK Data Analysis Detailed Explanation of Data Analysis Steps

1. Enter the Review Saved Data mode and Enter Review Saved Data from the Lessons menu.
choose the correct file.

o Note Channel Number (CH) designations: - - — . .
Channel Displays
CH3 EDA
CH 40 Respiration
CH 41 Heart Rate 5
Fig. 9.16'Example data
o Note measurement box settings: The measurement boxes are above the marker region in the data window.

Each measurement has three sections: channel number, measurement

Channel  Measurement type, and value. The first two sections are pull-down menus that are

CH 41 Value activated when you click them.
CH 40 BPM Brief definition of measurements:
CH 3 Value Value: Displays the amplitude value at the selected point. If an area is

selected, the value is the endpoint of the selected area.

BPM: The Beats or Breaths Per Minute measurement first calculates
the difference in time between the beginning and end of the selected
area (seconds,) and divides this value into 60 seconds/minute.

The “selected area” is the area selected by the I-Beam tool (including the

endpoints).
2. S.et up your display window for optimal Note: The append event markers # mark the beginning of each
viewing of the first 5 seconds of the recording. Click on (activate) the event marker to display its
recording. label.

Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom
Back, Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)
Cursor Tools: Zoom Tool
Buttons: Overlap, Split, Show Grid, Hide Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click” (Mac)
the channel number box to toggle channel display.

Data Analysis continues...

Page P-1 ©BIOPAC Systems, Inc.
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3. Using the [-Beam cursor, choose a point at
the 2-second mark and record the heart rate
and EDA values (Fig. 9.17).

g A

Using the [-Beam cursor, select an area from
the start of one inhale to the start of the next
inhale (Fig. 9.18,) and record the respiration
rate (BPM).

g a

Scroll to view a 10-second interval beginning
at the first event marker inserted in Data
Recording Step 4.

Find the point of maximal EDA within this
10-second recording and record the heart rate
and EDA values at this point.

g a

Using the [-Beam cursor, select an area from
the start of one inhale to the start of the next
inhale, closest to the point used in Step 6,
and record the respiration rate (BPM).

g A

Repeat Steps 6 — 7 for each condition in
“Count and touch” recording of your data.

g A

8.

Data Analysis continues...

— EDA & Polygraph Biopac Student Lab 4
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Fig. 9.17 Measurement at 2 second mark

The respiration transducer records chest expansion (inhalation) as
positive values and chest deflation (exhalation) as negative values.
Therefore, the start of inhalation is recorded as the beginning of the
ascending positive waveform.

Note This measurement may be difficult to perform, depending on your
data, because small dips in chest expansion can occur within the
normal cycle and when the Subject answers questions. It may help
to zoom further out on the data or to first scroll to better data to get
an idea of the expected respiration rate.

AU - ot S
e ey e E

Tol | oot o 5 AR IR] 10057 ek rermees B B O T -

|._‘1. T

EL) |

Fig. 9.18 Onéwrespiratory cycle

This 10-second interval in the Respiration data (CH 40) should show the
Subject’s response to the first instruction of the recording.
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Fig. 9.19 Point of maximal EDA
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Fig. 9.20 Measurement of respiration rate
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9. Perform Steps 5 — 7 for “Colored squares”
data.

Sl s

10. Perform Steps 5 — 7 for “Yes-No questions”  Measurements should be taken in the interval that begins when the
data, using a 5-second interval beginning at Subject started to answer.

the “A” marker. An electronically editable Data Report is located in the journal

C (following the lesson summary,) or immediately following this Data
Analysis section. Your instructor will recommend the preferred format
11. Answer the questions at the end of the Data for your lab.
Report

12. Save or Print the data file.
13. Quit the program.

END OF DATA ANALYSIS

END OF LESSON 9
Complete the Lesson 9 Data Report that follows.
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ELECTRODERMAL ACTIVITY & POLYGRAPH
DATA REPORT

Student’s Name:
Lab Section:

Date:
Subject Profile
Name: Height:
Age: Gender: Male / Female Weight:

I. Data and Calculations

A. Complete Table 9.1 with “Count and touch” data.

Mark I for increase, D for decrease, and NC for no change relative to baseline. (Add or paste results into the
Measurement column.)

Table 9.1 “Count and touch” Data

Heart Rate Respiratory Rate EDA
Procedure [a0] [ e

Mark Meas Mark Meas Mark Meas

Resting (baseline)

Quietly say name

Count from 10

Count from 30

Face touched

B. Complete Table 9.2 with “Colored squares” data.
Mark I for increase, D for decrease, and NC for no change relative to baseline. (Paste measurements in cells on right)

Table 9.2 “Colored squares” Data

Heart Rate Respiratory Rate

EDA
Square Color g | | [3][ vaue ]

Mark Meas Mark Meas Mark Meas

white

black

red

blue

green

yellow

orange

brown

pink
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C. Complete Table 9.3 with “Yes-No questions” data.
Mark I for increase, D for decrease, and NC for no change relative to baseline. (Paste measurements to cells on right)

Table 9.3 “Yes-No questions” Data

Heart Rate Respiratory Rate

EDA
Question Answer | Truth BPM | 3]

Mark Meas Mark Meas Mark Meas

Student?

Blue eyes?

Brothers?

Earn “A”?

Motorcycle?

Less than 25?

Another planet?

Aliens visit?

“Survivor’?

<| < <| <| <| <| <| <| <] <
Z Z| Z| Z| Z| Z| Z| Z| Z| Z
<| <| <| <| <| <| <| <| <] <
Z Z| Z| Z| Z| Z| Z| Z| Z| Z

Truthful?

II. Questions

D. Of what practical value is the EDA information obtained from the color experiment?

E. What major physiological changes account for the electrodermal activity?

F. Give three reasons why polygraph testing of a person’s sincerity and honesty may yield inconclusive results.
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III. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials

C. Method

D. Set Up

E. Experimental Results

End of Lesson 9 Data Report
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l. INTRODUCTION

A cross-section of the eye is illustrated in Fig. 10.1. Together the cornea and the lens act like the lens of a camera. They bend
the light rays entering the eye and focus them on the retina.

Superior rectus muscle

Ciliary muscle ==
L Ciliary body
- Ciliary process

Central f
entral, ovea g x—Suspensory ligament of lens

Visual axis  Light

Pupil
Iris

Retina
Choroid
Sclera

Inferior rectus muscle

Fig. 10.1 The Eye

Focusing a camera changes the distance between the lens and the film. Our eyes accomplish this feat by changing the shape
of the lens. The ciliary muscle, a circular muscle attached to the lens by a suspensory ligament, contracts, reducing tension on
the suspensory ligament thereby allowing the lens to thicken, when focusing on nearby objects. The ciliary muscle relaxes to
make the lens thinner and focus on objects that are far away. The retina contains a layer of two kinds of light-sensitive
photoreceptors: cones and rods. Cones are used for day vision and color vision. They are most concentrated in the fovea,
where focused light produces the sharpest image. Rods are used for vision in dim light and for the detection of movement in
the visual field. Rods are concentrated in the periphery of the retina, hence, the tendency to focus away from the fovea (“look
to the side of the eye”) in darkness.

Muscular control of the eye works to keep the image on the fovea, regardless of whether the object is stationary or moving.
This process is called visual fixation. Two primary mechanisms are used to fixate on objects in the visual field, defined as the
field of view without moving your head: 1. Voluntary fixation, 2. Involuntary fixation.

Voluntary fixation involves a conscious effort to direct your gaze to a selected object in your visual field and “lock on” to it.
This mechanism is used to initially select objects in your visual field. Involuntary fixation involves subconscious mechanisms
that operate to keep the selected object in your field of view once you have locked on to it. After you have visually locked on
to an object, your eyes continue to move in repetitive, involuntary, imperceptible, minute, jerky movements called
microsaccades (micro-small, saccade-jerky movement). These movements counteract perceptual fading, a consequence of
rapid adaptation of retinal receptor systems to constant input, by slightly shifting the position of the retinal image within the
fovea. Microsaccades also sharpen visual acuity. The recording and measurement of microsaccades is difficult and beyond
the scope of this lesson.

Page I-1 ©BIOPAC Systems, Inc.
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The movement of each eyeball in its orbit is caused by the individual contractions of six small voluntary muscles attached to
the surface of the eyeball. Four of the six muscles run straight from origin to insertion, and thus are termed recti muscles
(rectus, straight): the superior rectus, the inferior rectus, the medial rectus, and the lateral rectus. The remaining two
muscles are obliquely attached to the eyeball surface and are called the superior oblique and the inferior oblique (Fig. 10.2).
Collectively, the four recti muscles and the two oblique muscles are called extrinsic eye muscles.

S.R. Muscle Eye Direction
Inferior Rectus Downward
(LR.)
S.0 # Left Eye Superior Rectus Upward
\ (S.R)
- Lateral Rectus Laterally
(L.R.)
%L'R' Medial Rectus Medially
o (M.R.)
Superior Oblique Down and
(8.0) Laterally
Inferior Oblique Up and Laterally
(1.0

Fig. 10.2 Extrinsic Eye Muscles

Contractions of the extrinsic muscles are controlled by way of motor pathways in the brain and three pairs (one right, one left) of
cranial nerves. Cranial Nerve 111, the oculomotor nerve, supplies all extrinsic eye muscles except the superior oblique and the
lateral rectus. Cranial Nerve 1V, the trochlear nerve, supplies the superior oblique. Cranial Nerve VI, the abducens nerve,
innervates the lateral rectus.

When a normal person gazes at an adequately illuminated object, the fixation point of the gaze is projected onto corresponding
sensory areas in the foveas of the retinas. The occipital lobe cortex integrates the sensory information from each retina, producing
normal, single, sharp image of the object. If there is a disruption in the alignment of the eyes, as may occur, for example, in
weakness of one or more extraocular muscles, there is a loss of retinal correspondence and the result may be diplopia or double
vision. Nine cardinal directions of gaze in concerted eye movement and the extraocular muscles moving the eyes to the gaze
position are shown in Fig. 10.3.

I— ___I
<Right Gaze 5tra'rghi' Ahead | Left Eaze/
| |

Superior | Inferiar

Superior rectus Infericr | Superior
rectus ohligus Inferior ubllque ohligue rectus
Lateral Medial J:qntr.._ul Eazu Medial Lateral
rescbus rectus rectus rectus

=
| .
n
5
| =
3
o Inferior 5up-enmr Infermr rectus Superlur Inferu:lr
rectus abligue Superior ablique abligue rectus

Fig. 10.3 Nine Cardinal Directions of Gaze

As a person voluntarily fixates on a moving object and then involuntarily maintains the visual fix without moving the head,
such as in watching the swinging pendulum of a clock, each eye must move precisely and in concert with the other for the
brain to receive the sensory information required to produce a clear, single image of the moving object. The eyeball
movement involves the extraocular muscles, associated cranial nerves, and motor control centers in the brain. For example, as
the clock pendulum swings from left to right, the left eye moves medially (medial rectus / cranial nerve 111) and the right eye
moves laterally (lateral rectus / cranial nerve VI). When the pendulum swings back, the eye movements are reversed.
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The brain subconsciously grades the contractions of extraocular muscles so as to maintain the visual fixation point as the
pendulum slows and speeds up during its swing by using visual sensory information regarding change of position of the
moving pendulum. The oscillating, or back and forth involuntary movements of the eyes are a form of tracking movement in
which the eyes maintain a visual fix on an object moving within the visual field.

Coordinated voluntary and involuntary eye movements are controlled by motor centers in the frontal lobe cortex and the
motor centers of cranial nerves I, IV, and VI in the brainstem. Cortical activity associated with motor control of the
extraocular muscles can be detected and recorded using conventional EEG techniques.

The human eye is an electrical dipole with the positive terminal in front at the cornea, and the negative terminal behind at the
retina of the eyeball (Fig. 10.4). The potential between the front and the back of the eyeball, called the corneal — retinal
potential (CRP,) is about 0.4 — 1.0 mV, and is primarily due to hyperpolarizations and depolarizations of nerve cells in the
retina. Electrooculography is a technique for recording voltage changes as the eyeballs move in their orbits. The
electrooculogram (EOG,) is an electroencephalographic record of the voltage changes obtained while the subject, without
moving the head, moves the eyes from one fixation point to another within the visual field.

Right — Left
Tamparal Temporal

Elsctrode Ebectrode

{7 —

Right Eye
Looking Right

Right Eye
Looking Straight

Right Eye
Looking Left

Fig. 10.4 Dipole Model of the Eye and EOG

By placing an electrode on the temporal side of each orbit to detect horizontal eye movement, and another pair above and
below the right eye to detect vertical movement, eye movement up to + 70° can be measured, where 0° is in front and + 90° is
directly lateral or vertical to the eye. The electrodes detect changes in the potential as the cornea moves nearer or further from
the recording electrodes (Fig. 10.4). When the eye is looking straight ahead, it is about the same distance from either
electrode, so the signal is essentially zero. When the front of the eyeball, the cornea, is closer to the positive electrode, a
positive difference in voltage is recorded. The EOG signal is linearly proportional to eye movement, changing approximately
20 microvolts for each degree of eye movement. The EOG signal ranges from 0.05 — 3.5 mV in humans, and is the result of a
number of factors, including eyeball rotation and movement, eyelid movement, EEG, head movement, and changing
luminescence.

The EOG measurement is susceptible to baseline drift due to minor electrode/skin offset potential changes occurring over
several minutes as well as potential baseline shifts due to electrode displacement on the skin surface (typically from electrode
leads tugging on the electrodes). To help minimize baseline changes, for this lesson, a 0.05 Hz High Pass filter is used. This
filter has minimal effect on the recorded data because the filter’s 3.18 second time constant is large compared to the signal
variations recorded in this lesson. This filter limitation should be kept in mind when designing additional experiments
(optional active learning section); if the eyes fixate on a position for several seconds, the recorded signal will slowly return to
baseline (0 mV).

Any movement of the facial muscles or jaw can introduce EMG (muscle) artifact or cause slight baseline shifts due to
movement of the EOG electrodes. For this reason it is important to minimize facial and jaw movement when recording EOG
data.

An EOG recorded from temporal electrodes placed at the lateral margin of the orbits of a subject visually tracking the
movement of a pendulum is shown in Fig. 10.5. The sinusoidal nature of the tracing disappears when the pendulum, and
hence the visual tracking, is stopped.
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Fig. 10.5 EOG Recording

If the subject, with eyes open, imagines a swinging pendulum and attempts to visually track it, the EOG again becomes
sinusoidal but jerky, suggesting a reduction in neuromuscular control of the eyes due to the loss of visual sensory input to the
brain.

Other changes in the EOG may be recorded when a subject is asked to silently read a brief paragraph, pause, then reread
aloud the same paragraph. As the words in each sentence are read, the eyes move quickly and in a jerky manner from one
fixation point (a word) to another. Quick, jerky, voluntary movements of the eyes are called saccades (saccade- jerky). The
time interval between saccades is the time spent looking at the word. When the reading is silent, the eyes move quickly from
word to word as a line is read, and the interval between saccades is short. When the lines are read aloud, the auditory input
slows eye movement to allow time for each seen word to be spoken, and the interval between saccades is longer. Generally,
the interval between saccades is longer when reading a difficult passage than when reading an easy passage because more
time is required by the brain for information processing.

Electrooculography is commonly used to assess visual defects involving neuromuscular control of the eyes, such as in
diagnosis and treatment success of sixth nerve palsy (paralysis of the lateral rectus). Similar eye movement/cranial nerve tests
using other cardinal gazes (Fig. 10.3) may be employed in diagnosis and assessment of eye disorders. In addition, recent
applications include the use of electrooculography in the design of robotics, such as motorized wheelchairs and other devices
that can be guided or otherwise controlled by movement of the subject’s eyes.
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Il. EXPERIMENTAL OBJECTIVES

1)
2)

3)

Record EOG and compare eye movements during real and simulated tracking of a pendulum.
Record EOG and compare eye movements during real and during simulated tracking of an object in the vertical
plane.

Record and compare the “saccadic” eye movements when reading three different ways; silently (easy,) silently
(challenging) and aloud (challenging).

I11. MATERIALS

2 x BIOPAC Electrode Lead Set (SS2L)

BIOPAC Disposable Electrodes (EL503,) 6 electrodes per subject

BIOPAC Electrode Gel (GEL1) and Abrasive Pad (ELPAD)

Optional: BIOPAC Adhesive Tape (TAPE 2)—use to tape wires to reduce cable strain

Pendulum: Can be made by attaching any object (i.e. 50 gm force calibration weight) to approx. 61 cm (24
inches) of string.

Pen or other real object for vertical tracking

Passages for reading: Passage 1 — easily understandable (i.e., entertainment article)
Passage 2 — challenging material (i.e., scientific article)

Note A sample reading passage in printable PDF format is available in the lesson Help menu.

Biopac Student Lab System: BSL 4 software, MP36, MP35 or MP45 hardware
Computer System (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP

1. Turn the computer ON.
o If using an MP36/35 unit, turn it OFF.

e If using an MP45, make sure USB cable is
connected and “Ready” light is ON.

2. Plug the Electrode Lead Sets (SS2L) in as
follows:

Horizontal lead — CH 1
Vertical lead — CH 2
3. Turn ON the MP36/35 unit.

Page P-1

FAST TRACK Setup Detailed Explanation of Setup Steps

Fig. 10.6 MP3X (top) and MP45 (bottom) equipment connections
Setup continues...

©BIOPAC Systems, Inc.
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4. Gently clean and abrade skin.

5. Attach six electrodes to Subject’s face as
shown in Fig. 10.7.

IMPORTANT
For accurate recordings, attach the
electrodes so they are horizontally and
vertically aligned.

6. Clip CH 1 Electrode Lead Set (SS2L) in the
horizontal placement, following the color
code (Fig. 10.8).

7. Clip CH 2 Electrode Lead Set (SS2L) in the
vertical placement, following the color code
(Fig. 10.9).

Setup continues...

L10 - EOG-I Biopac Student Lab 4

= |f the skin is oily, clean
electrode sites with soap and
water or alcohol before
abrading.

= |f electrode is dry, apply a drop
of gel.

= Attach one electrode above the
right eye and one below, such
that they are aligned vertically.

= Attach one electrode to the
right of the right eye and one to
the left of the left eye, so they
align horizontally.

7

Fig. 10.7 Proper electrode placement

= The other two electrodes are
for ground, and alignment is
not critical.

For optimal electrode contact, place electrodes on skin at least five
minutes before start of Calibration.

= Drape the electrode lead cables
behind the ears, as shown, to
give proper cable strain relief.

GNI . Connect the electrode cable clip
to a convenient location to help
relieve cable strain.

= Electrodes must lay flat on
skin.

Fig. 10.8 Horizontal (CH 1) Lead
Placement

Fig. 10.9 Vertical (CH 2) Lead
Placement
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8. Start the Biopac Student Lab Program. Start Biopac Student Lab by double-clicking the Desktop shortcut.

A=

9. Choose lesson “L.10 — Electrooculogram ’
(EOG) I and click OK. Biopac
. . . . Student Lab
10. Type in a unique filename and click OK. 4.0

No two people can have the same filename, so use a unique identifier,
such as Subject’s nickname or student ID#.

11. Optional: Set Preferences. A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a common folder.

This lesson has optional Preferences for data and display while
recording. Per your Lab Instructor’s guidelines, you may set:

Grids: Show or hide gridlines

Lesson Recordings: Specific recordings may be omitted based on
instructor’s preferences.

e Choose File > Lesson Preferences.
o Select an option.
o Select an option and click OK.

END OF SETUP
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B. CALIBRATION

The Calibration procedure establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for
optimal performance. Pay close attention to Calibration.

FAST TRACK Calibration Detailed Explanation of Calibration Steps
1. Subiject is seated, relaxed, breathing = Subject should sit with arms relaxed at side of body, legs flexed at
normally, and facing away from monitor. knee and feet supported.
o Carefully review upcoming steps. = Subject prepares to move eyes horizontally and vertically for
Calibration procedure.
2. Click Calibrate. = Subject must try to keep head still and avoid blinking.
3. Subject must: = Calibration lasts 20 seconds.

o Complete four horizontal eye movement
cycles (extreme left-extreme right-return
to center) and four vertical eye
movement cycles (extreme up-extreme
down-return to center).

o Wait for Calibration to stop.

Fig. 10.10 Proper head positioning

4. Verify recording resembles example data. The four cycles of horizontal and vertical eye movement should be
« If similar, click Continue and proceed to clearly visible in the appropriate data channel.
Data Recording. =
e If necessary, click Redo Calibration. = e L2
g 3 o

sireh

| |on0 20 am 600 B00 000 [EIT) ) 16,00

Fig. 10.11 Example Calibration data
If recording does not resemble Example Data...
= |f data is flatline, check all connections to MP unit.

= |f there is excessive noise or baseline drift, check that electrodes
are making good contact with the skin (lying flat) and that leads
are not pulling on the electrodes.

= |f Subject blinked, resulting in a large data spike, redo the
calibration.

END OF CALIBRATION
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C. DATA RECORDING

1.

2.

FAST TRACK Recording

Prepare for the recordings.

Pendulum

Prepare for the recording.

e Director holds pendulum in front of
Subiject, ready to release (Fig. 10.12).

e Subject must focus on pendulum.

e Review recording steps.

Recording continues...

L10 - EOG-I Page P-5

Detailed Explanation of Recording Steps

Seven data recordings will be acquired™*:

Recording 1 — 2: real and simulated pendulum
Recording 3 — 4: real and simulated vertical tracking
Recording 5 — 6: read silently (easy and challenging)
Recording 7: read aloud (challenging)

*IMPORTANT

This procedure assumes that all lesson recordings are enabled in lesson
Preferences, which may not be the case for your lab. Always match the
recording title to the recording reference in the journal and disregard any
references to excluded recordings.

For all recordings, the Subject is seated and relaxed, facing away from
the monitor.
Hints for obtaining optimal data:
= Review recording steps in advance.
= Make sure all electrodes are making good contact with skin (lying
flat) and that leads are not pulling on the electrodes.
= Subject must remain in a seated, relaxed state for all recordings.
= Subject must keep head still, move only eyes and try to avoid
blinking.
= |n order to record sufficient amplitude variation, eye movements
should be as large as possible. When tracking a moving object, eye
movements should cover a significant portion of the visual range

along at least one axis. When reading, the reading material must be
held as close to the Subject as possible, while maintaining focus.

Fig. 10.12 Pendulum positioning

Details...

= Subject should be seated about 25 cm (10 inches) from pendulum—
adjust as necessary to maintain focus.

= Bottom of pendulum swing should align with bottom of Subject’s
nose.

= Pendulum should be lifted approximately 45 degrees to Subject’s
right while maintaining a taut string, ready to release when recording
starts.

= Director must hold pendulum string at a constant position.
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10.

11.

12.

Click Record.
 Director releases pendulum.

Subiject tracks pendulum with eyes only.
Wait for pendulum to stop swinging.
Click Suspend.

Verify recording resembles the example
data.

o |f similar, click Continue and proceed to
the next recording.

o If necessary, click Redo.
o If all required recordings have been
completed, click Done.
Simulate Pendulum

Prepare for the recording.

o Subject prepares to simulate eye-
tracking an imaginary pendulum.

o Subject places eyes at the 2 o’clock
position
* Review recording steps.
Click Record.

Subiject tracks an imaginary pendulum with
decreasing swing cycles.

Director observes horizontal channel until
there is little or no eye movement.

Click Suspend.

Recording continues...

L10 - EOG-I Biopac Student Lab 4

There should be cyclical variation in the data and the amplitude should
progressively decrease. The Horizontal data should display greater
amplitude variation than the Vertical data.

4
|

Fig. 10.13 Example Pendulum data
If recording does not resemble Example Data...
= |f data is flatline, check all connections to MP unit.

= |f there is excessive noise or baseline drift, check that electrodes are
making good contact (lying flat) and that leads are not pulling on the
electrodes.

= |f there is not sufficient amplitude variation, make sure that the
horizontal range of the pendulum swing covers a large portion of the
Subject’s visual range.

= |f Subject blinked, resulting in a large data spike, redo the recording.

Click Redo and repeat Steps 2 — 7 if necessary.
Note that once Redo is clicked, the most recent recording will be erased.

This simulates the starting position of the pendulum.

Subject must try to visualize the pendulum movement of the previous
recording and track the imaginary pendulum with the eyes only. The
initial swing should take up a large portion of the Subject’s visual range
along the horizontal axis and each successive swing should be reduced in
amplitude until the eyes are still.
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13. Verify recording resembles the example There should be cyclical variation in the Horizontal data and the
data. amplitude should progressively decrease.

o |f similar, click Continue and proceed to __
the next recording.

WO 00 MO0 A0 W00 M0 M0 W0 B0 MO0 W0 G0 S0 w0 480 W0 Wm Wm0 w0 S
rrrah

Fig. 10.14 Example Simulated Pendulum data

e If necessary, click Redo. Data would be different for reasons detailed in Step 7.
Click Redo and repeat Steps 8 — 13 if necessary.
Note that when Redo is clicked, the most recent recording will be erased.

Vertical Tracking

14. Prepare for the recording Director holds pen centered with the eyes - adjust as necessary to
Director positions a pen about 25 cm (10 maintain focus (Fig. 10.15). Subject must pick a focal point on the pen
inches) from Subject. and track its movement WITHOUT moving head.

« Subject tracks pen. Director determines (and mentally notes) the upper and lower edges of

. . the Subject’s visual field by moving the pen up and down until Subject
« Director moves pen vertically up and indicates it is out of view.

down to determine the limits of the
Subject’s visual range.

Director returns pen to a center position (eyes looking straight ahead)

g ] and the recording is ready to begin.
¢ Review recording steps. .

Fig. 10.15 Vertical tracking positioning

Recording continues...
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15.

16.

17.
18.

19.

20.
21.

22.

23.

Click Record.

Subiject tracks pen while Director moves it

from center to upper and lower edges of
visual field.

o Repeat for a total of five cycles.
Click Suspend.

Verify recording resembles the example
data.

o If similar, click Continue and proceed to

the next recording.

o |If necessary, click Redo.

o If all required recordings have been
completed, click Done.

Simulate Vertical Tracking

Prepare for the recording.

o Subject centers eyes and prepares to
simulate vertical eye-tracking.

¢ Review recording steps.
Click Record.

Subiject tracks an imaginary pen moving
vertically through visual field for five
cycles.

Director observes vertical channel until
there is little or no eye movement.

Click Suspend.

Recording continues...
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Subject must track pen movement with the eyes only, trying not to move
head or blink.

Director moves the pen through five vertical tracking cycles as follows:

= From center to upper then lower edges of visual field and then back
to center.

The five cycles should be clearly visible in the Vertical channel data.

[#m %00 @00 w00 =00 Sa00 SA00 00 A000 AR00 SADD  SAD0  8ADD TG00 700 MA00  TA00 TRO0 M0 20|

Fig. 10.16 Example Vertical Tracking data
If recording does not resemble Example Data...
= |f data is flatline, check all connections to MP unit.

= |f there is excessive noise or baseline drift, check that electrodes are
making good contact (lying flat) and that leads are not pulling on the
electrodes.

= |f there is not sufficient amplitude variation, make sure that the
vertical range of the pen covers the Subject’s visual range.

= |f Subject blinked, resulting in a large data spike, redo the recording.

Click Redo and repeat Steps 14 — 18 if necessary.
Note that once Redo is clicked, the most recent recording will be erased.

Subiject tracks the imaginary pen with eyes only, imagining the pen
moving to the upper then lower edges of visual field, then returning to
center. This upper/lower cycle should be repeated five times.
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24. Verify recording resembles the example
data.

o |If similar, click Continue and proceed to
the next recording.

o If necessary, click Redo.

Read Silently (Easy)

25. Prepare for the recording

o Director holds reading material centered
in front of Subject as close as possible,
while maintaining focus (Fig. 10.18).

o Review recording steps.

26. Click Record.

27. Subject reads material silently and
announces when finished.

28. Click Suspend.

Recording continues...
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The five cycles should be clearly visible in the Vertical channel data.

B0 600 A0 J000 A00 TADD A00 TRO0  DODD G200 MO0 BB00 DROD G000 GO0 BA00  SA00 G000 J0000 30300
1 reerah

Fig. 10.17 Example Simulated Vertical Tracking data

Data would be different for reasons detailed in Step 18.
Click Redo and repeat Steps 19 — 24 if necessary.
Note that when Redo is clicked, the most recent recording will be erased.

This passage should be easy to read. The upper passage will be used for
this recording. You may hide the lower passage by folding the paper in
half.

Fig. 10.18 Reading material positioning

Details...

= Subject must be able to read entire passage without moving head.

= Subject must keep head still, move only eyes, and try to avoid
blinking.

= Director must hold the reading material as still as possible.
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29. Verify recording resembles the example
data.

o If similar, click Continue and proceed to
the next recording.

o |If necessary, click Redo.

o If all required recordings have been
completed, click Done.

Read Silently (Challenging)

30. Prepare for the recording.

o Director holds reading material centered
in front of Subject as close as possible,
while maintaining focus.

o Review recording steps.

31. Click Record.

32. Subject reads material silently and
announces when finished.

33. Click Suspend.

34. Verify recording resembles the example
data.

o [f similar, click Continue and proceed to
the next recording.

o |If necessary, click Redo.

o If all required recordings have been
completed, click Done.

Recording continues...
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There should be a visible “saw tooth” pattern in the Horizontal data.

Moo W00 B0 M0 W07 W W00 W A0 w00 00 10000 WS 10 e i000 1000 LEG0 LA60 1600
s 1

Fig. 10.19 Example Read Silently (Easy) data

If recording does not resemble Example Data...

If data is flatline, check all connections to MP unit.

If there is excessive noise or baseline drift, check that electrodes are
making good contact (lying flat) and that leads are not pulling on the
electrodes.

If there is not sufficient amplitude variation, make sure that the
reading material was held as close as possible to the Subject’s face
while maintaining focus.

Make sure the Director held the reading material as still as possible.

If Subject blinked, resulting in a large data spike, redo the
recording.

Click Redo and repeat Steps 25 — 29 if necessary.
Note that once Redo is clicked, the most recent recording will be erased.

This passage should be more challenging then that from “Read Silently
(Easy).” You may hide the upper passage by folding the paper in half.

Review the “Details” listed in Step 25.

There should be a visible “saw tooth” pattern in the Horizontal data.

RO WD MO0 W0 NOW WS MM 60 D 1eM N0 400 AN IR0 D00 100 DM Lm0 10 0|

Fig. 10.20 Example Read Silently (Challenging) data

Data would be different for the reasons detailed in Step 29.
Click Redo and repeat Steps 30 — 34 if necessary.
Note that when Redo is clicked, the most recent recording will be erased.
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35.

36.

37.
38.

39.

Read Aloud (Challenging)

Prepare for the recording

e Director holds reading material centered
in front of Subject as close as possible,
while maintaining focus.

¢ Review recording steps.
Click Record.

Subiject reads passage aloud.
Click Suspend.

Verify recording resembles example data.

o If similar, click Continue to proceed to
optional recording section, or Done to
finish the lesson.

o |If necessary, click Redo.

Recording continues...
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This passage should be the same as that used in “Read Silently
(Challenging).”
Review the “Details” listed in Step 25.

Subject reads passage aloud until material is complete. Subject should
try to minimize mouth and jaw movement as this can add signal artifact
to the EOG.

The Horizontal data will most likely show less of a consistent pattern
than in the Read silently recordings.

RD0 AD0 14600 1MM00 1000 (500 10D 1SS0 MO0 18000 JG00 16400 8600 MO0 17000 17200 1900 1TE00|
rrch

Fig. 10.21 Example Read Aloud (Challenging) data

Data might be different for the reasons detailed in Step 29.

If the signal is too difficult to interpret, redo and have the Subject use
less mouth and jaw movement.

Click Redo and repeat Steps 35 — 39 if necessary. Note that when Redo
is clicked, the most recent recording will be erased.
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OPTIONAL ACTIVE LEARNING PORTION  With this lesson you may record additional data by clicking Continue

40. After clicking Done, choose an option and
click OK.

41. Remove the electrodes.

END OF RECORDING

following the last recording. Design an experiment to test or verify a
scientific principle(s) related to topics covered in this lesson.
Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each step
to make it easy to follow during recording.

Run Your Experiment
D. SetUp

Set up the equipment and prepare the subject for your experiment.
E. Record

Use the Continue, Record and Suspend buttons to record as much
data as necessary for your experiment.

Click Done when you have completed all of the recordings
required for your experiment.

Analyze Your Experiment
F. Set measurements relevant to your experiment and record the
results in a Data Report.
If choosing the Record from another Subject option:
= Repeat Setup Steps 4 — 7, and then proceed to Calibration.

Remove the electrode cable pinch connectors and peel off all electrodes.
Discard the electrodes. (BIOPAC electrodes are not reusable.) Wash the
electrode gel residue from the skin, using soap and water. The electrodes
may leave a slight ring on the skin for a few hours which is quite normal.
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V. DATA ANALYSIS
FAST TRACK Data Analysis

1. Enter the Review Saved Data mode.

¢ Note Channel Number (CH) designations:

Channel Displays
CH40 Horizontal
CH 41 Vertical
o Note measurement box settings:

Channel Measurement
SC Delta T
CH 40 P-P
CH41 P-P

2. Set up your display window for optimal
viewing of the “Pendulum tracking” data.

Data Analysis continues...
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Detailed Explanation of Data Analysis Steps

If entering Review Saved Data mode from the Startup dialog or Lessons
menu, make sure to choose the correct file.

Example data:

e T P A —- e @ o T
3041 vorwored

e

Fig. 10.22 Example data

The measurement boxes are above the marker region in the data window.
Each measurement has three sections: channel number, measurement
type, and result. The first two sections are pull-down menus that are
activated when you click them.

SC is the Selected Channel; the one with the darkened channel label.
Channels are selected clicking on the channel selection box or by clicking
within the channel display region.

Brief definition of measurements:

Delta T: Displays the amount of time in the selected area (the
difference in time between the endpoints of the selected area).

P-P (Peak-to-Peak): Subtracts the minimum value from the
maximum value found in the selected area.

The “selected area” is the area selected by the 1-beam tool (including
endpoints).

Note: The append event markers 4 mark the beginning of each
recording. Click on (activate) the event marker to display its
label.

Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom
Back, Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)
Cursor Tools: Zoom Tool
Buttons: Overlap, Split, Show Grid, Hide Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click”
(Mac) the channel number box to toggle channel display.

©BIOPAC Systems, Inc.
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3. Referencing the Horizontal data, select the
area of the first tracking cycle. Record the
Delta T (period) and P-P measurements.
Repeat for each successive tracking cycle.

A (Table 10.1)

4. Scroll to “Simulate pendulum” data and
record the measurements for each
successive cycle as in Step 3.

g A

5. Scroll to “Vertical tracking” data.

6. Referencing the Vertical data, select the area
of the first tracking cycle. Record the Delta
T (period) and P-P measurements. Repeat
for each successive tracking cycle.

Sl B (Table 10.2)

Data Analysis continues...
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At the start of the tracking cycle, the eyes were looking straight ahead

and the data was approximately centered between minimum and
maximum values.

Biopac Student Lab 4

| T e O
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Fig. 10.23—Selection of first Horizontal tracking cycle.
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Fig. 10.24—Selection of second Horizontal tracking cycle.
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Fig. 10.25—Selection of first Horizontal cycle.
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Fig. 10.26—Selection of first Vertical tracking cycle.
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7. Scroll to “Simulate vertical tracking” data
and record the measurements for each
successive cycle as in Step 6.

Sl s

8. Set up your display window for optimal
viewing of the “Read silently 1” data.

9. Record the number of words in line 1 and
line 2 of each passage.

C (Table 10.3)

10. Zoom in on the data recorded during the
reading the first line.

11. Count and record the number of saccades that
occurred while reading the line.

Sc

12. Measure and record each time interval
(period) between saccades (Delta T).

gc

13. Scroll to the data recorded during the reading
of the second line and repeat Steps 11 and 12.

gc

Data Analysis continues...

L10 - EOG-I Page P-3
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Fig. 10.27—Selection of first Vertical tracking cycle.
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Fig. 10.28—Example Read Silently 1 data.

In the following examples, the Vertical channel is hidden since all
measurements are made on the Horizontal data.

The data for the reading of each line should be easy to discern as there is
a large, fast transition when the eyes move from the end of one line to the
beginning of the next.

Saccades are the fast transitions in the positive trending data. The period

between saccades is the time the Subject looked at each word.

EEET W e DEEE BE- vonmev 4100 - 0 ey SO e - oo (] horw - o
[0 L1, Howorea

Saccades— 12 3 45 6 7 8 9 <~—Back tobeginning
of next line

L— Reading one line ——|

| e = W
o

Fig. 10.29—Highlight shows saccade intervals.

B s D e P
30 L1a] Howored

£ = 00 oo
secoreh

Fig. 10.30—Example of interval between saccades.
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Scroll to “Read silently 2” data and repeat
Steps 10 through 13.

gc

14. Scroll to “Read Aloud” data and repeat Steps
10 through 13.

gc

15. Answer the questions at the end of the Data
Report.

16. Save or Print the data file.
17. Quit the program.

END OF DATA ANALYSIS
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It may be more difficult to distinguish the saccades and the interval
between saccades because eye movement is more complex when reading
aloud. The movement of the facial muscles can also create signal artifact.
The following example shows typical data with an interval selected. It is
only necessary to measure the intervals between saccades that are clearly
distinguished.

ERpET - o DR - sy 4100 R G ey SO e - o 5 (3] horw - o

(30 L1 Howored

Fig. 10.31—Example of interval between saccades.

An electronically editable Data Report can be found in the journal
(following the lesson summary,) or immediately following this Data
Analysis section. Your instructor will recommend the preferred format
for your lab.

END OF LESSON 10

Complete the Lesson 10 Data Report that follows.
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ELECTROOCULOGRAM

DATA REPORT

Student’s Name:

L10 - EOG-I

Lab Section:

I. Data and Calculations

Subject Profile

Name:

Age:

Gender:

A. Pendulum Tracking—Complete Table 10.1.

Male / Female

Height:
Weight:

Note: Your data may have more or fewer cycles than the 7 allotted in the tables.
Table 10.1 Pendulum Tracking vs. Simulation Tracking (using Horizontal data)

Cycle Pendulum Simulation
DetaT || [20][ PP ]| [so] [oetaT | [s0][ PP ]
1
2
3
4
5
6
7

B. Vertical Tracking—Complete Table 10.2.

Table 10.2 Vertical Tracking vs. Simulation

- Real Object Simulation

cle

y (6] [oehaT ] | ] re ] | (2] [oetat || @E][Fr ]
1

N o g B~ O WDN

Page P-5
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C. Saccades—Complete Table 10.3.
Table 10.3 Saccades

Read Silently 1 Read Silently 2 Read Aloud
1% line 2" line 1*line 2" line 1*line 2" line

Measurement

Number of words

Number of saccades

Time interval between
saccades

#1

#2

#3

#4

#5

#6

#7

#8

#9

Average time interval
between saccades
(Calculate)

I1. Questions

D. Focusing a camera changes the distance between the lens and the film. Does the eye focus by changing the distance
between the lens and the retina? Explain your answer.

E. Define the following terms:
Cone

Rod

Fovea

Visual Field

Visual Fixation

Saccade / Microsaccade

F.  Why is vision in darkness more effective when focusing away from the fovea rather than focusing directly on the fovea?




©BIOPAC Systems, Inc. L10 - EOG-I Page P-7

G. Explain the difference between “voluntary fixation” and “involuntary fixation”:

H. Examine the data in Table 10.1 and answer the following questions

a.) Did the amplitude continue to decrease with each successive swing cycle during pendulum tracking? Explain

b.) Did the amplitude continue to decrease with each successive swing cycle during simulated pendulum tracking?
Explain

c.) Did the time interval (period) of each successive swing cycle increase, decrease, or remain constant during
pendulum movement? Explain

d.) Did the time interval (period) of each successive swing cycle increase, decrease, or remain constant during
simulated movement? Explain

e.) Are the waveform shapes different between tracking and simulated tracking data? Explain

I.  Examine the data in Table 10.2 and answer the following questions:
a.) Do the cycle amplitudes increase, decrease, or remain constant during vertical tracking? Explain

b.) Do the cycle amplitudes increase, decrease, or remain constant during simulated vertical tracking? Explain

c.) Do the cycle periods increase, decrease, or remain constant during vertical tracking? Explain

d.) Do the cycle periods increase, decrease, or remain constant during simulated vertical tracking? Explain

e.) Are the waveform shapes different between vertical tracking and simulated vertical tracking data? Explain

J. Examine the data in Table 10.3 and answer the following questions:
a.) Did the number of saccades match the number of words for each line? Explain any differences.
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b.) Isthe average time interval between saccades different when reading an easy passage vs. a challenging passage?
Explain

c.) Isthe average time interval between saccades different when reading the same passage silently vs. aloud?

d.) Are the waveform shapes different between Read Silently 2 and Read Aloud data? Explain

K. Name the cranial nerves tested and the extraocular muscles tested when the subject is asked to follow the eraser on a
pencil when moved in a one foot circle, two feet from face.

Cranial Nerves Extraocular Muscles

L. Define corneal-retinal potential (CRP) and explain its relation to electrooculography and the electrooculogram.
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I1l. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials
C. Method
D. SetUp

E. Experimental Results

End of Lesson 10 Data Report
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Sample Readings

Easy:

You put your right foot in, you put your
right foot out, you put your right foot in
and you shake it all about. You do the
Hokey Pokey and you turn yourself around,
that’s what it’s all about!

Difficult:

O proud right foot, that ventures quick
within, then soon upon a backward journey
lithe. Anon, once more the gesture, then
begin: Command sinistral pedestal to
writhe. Commence thou then the fervid
Hokey Poke. A mad gyration, hips in wanton
swirl. To spin! A wilde release from
heaven’s yoke, Blessed dervish! Surely
canst go, girl. The Hoke, the Poke -
banish now thy doubt. Verily, I say, ‘tis
what it’s all about!
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I. Introduction

All animals require oxygen to carry out cellular processes of energy transformation essential for life. During cellular
metabolism, oxygen is consumed when nutrients such as protein, carbohydrate, and fat are oxidized, and carbon dioxide is
produced as a gaseous waste product. Collectively, the processes whereby oxygen is taken up from the atmosphere, delivered

to body cells, and consumed, and the processes of producing carbon dioxide and delivering it to the lungs for excretion into
the atmosphere constitute respiration.

Processes of respiration fall into one of three categories: external respiration, gas transport, and internal respiration. External
respiration refers to mechanisms by which a person obtains oxygen from the external environment and eliminates carbon
dioxide into the external environment. Gas transport refers to mechanisms used to distribute oxygen to and remove carbon

dioxide from cells. Internal respiration refers to the chemical reactions of cellular metabolism in which oxygen is consumed
and carbon dioxide is produced. In this lesson we will focus on mechanisms of human external respiration.

/"m\ E Trachea

= Bronchial tree

Nasal cavity

' _Pharynx

Oral cavity (mouth)
[ (throat)

Upper Division

Larynx (voice box) Bronchioles

Trachea o ~ Terminal
& (windpipe) ) bronchioles
@ Bronchus——— |
5 LuNgs ———+ { -
a i i Respiratory #
% Diaphragm———17 2k l bronchioles

1

et

v Alveolar sacs &
Fig. 12.1 The Respiratory System Fig. 12.2 The Respiratory Tree

The human respiratory system (Fig. 12.1) consists of an upper

division and a lower division. The upper division is made up of

the nasal and oral cavities, the pharynx (throat,) and the larynx B

(voice box). The lower division consists of a system of :

sequentially arranged and progressively smaller airways that T

resemble an inverted tree. Often called the respiratory tree (Fig. —

| / Awveolar Space . |

4
12.2,) it consists of the trachea (wind pipe,) a right and a left | (i . | Alveolar
primary bronchus, the lobar bronchi, segmental bronchi, sub- '\|j LA SPIENElu
segmental bronchi, terminal bronchioles, respiratory bronchioles, 'é\‘_';l‘;‘i’l?;‘-:; 4 .‘ /&, a : Cﬁ; ”\r IInterstitial
alveolar ducts, alveolar sacs, and individual alveoli. Gas membrane ! N st s / fluid
exchange with the blood occurs only in the smaller, thin-walled A - 4
terminal parts of the tree beginning with the respiratory : o
bronchioles. The remainder of the respiratory tree, and the entire Capillary “———  Capillary

S . . . Red cell endothelium

upper division, collectively comprise anatomical dead space, _
space that is ventilated but plays no direct role in gas exchange. Fig. 12.3 Pulmonary Gas Exchange
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Gas exchange between the air in the lung and the blood is a process of simple diffusion (Fig. 12.3). A gas diffuses from a
region of higher concentration to a region of lower concentration, or, from an area of higher partial pressure to an area of
lower partial pressure. Partial pressure is simply a way of expressing the concentration of gas molecules. It is the pressure
exerted by a gas when it is in a mixture with other gases, and is equal to the pressure the same volume of the gas would exert
if no other gases were present. The partial pressure of a gas is easily computed if its percentage of the gas mixture and the
total pressure of the mixture is known. For example, the atmosphere at sea level exerts a pressure of 760 mm of Hg. If
oxygen were to make up 20% of the atmosphere, its partial pressure would be 20% of 760 mm of Hg, or 152 mm of Hg.

Blood transports gases to and from the body’s cells. The respiratory system supplies oxygen to the blood, and removes
carbon dioxide from the blood. Most of the gas exchange occurs at the level of the alveoli and the process is completely
dependent on the maintenance of gas partial pressures favorable for adequate diffusion of oxygen and carbon dioxide. During
inspiration (inhalation) the alveoli enlarge and take in fresh air. During expiration (exhalation) the alveoli get smaller, forcing
some of the air back out into the atmosphere. The process of continually and cyclically moving air into and back out of the
respiratory tree is called pulmonary ventilation. This process serves to maintain favorable partial pressures of oxygen and
carbon dioxide in the alveoli, thereby facilitating oxygen uptake by the blood and carbon dioxide removal from the blood.

The mechanics of pulmonary ventilation are best understood by applying Boyle’s law, which states the volume of a given
quantity of gas at a constant temperature varies inversely with the pressure of the gas. In other words, as the volume of a gas
at constant temperature increases, the pressure of the gas decreases. If the volume instead decreases, then the pressure
increases. Mathematically, the product of the pressure and volume of a gas at constant temperature is itself a constant (PV =
K). Ignoring units, if P = 6 and V = 3, then K = 18. If P decreases to 2, then V must increase to 9 because the value of K is 18
and constant as long as the temperature is constant.

The lungs are enclosed by the thoracic cage, which is comprised of
the sternum, ribs, vertebral column, and the diaphragm (Fig. 12.1).
The tissues of the thoracic cage form the thoracic cavity that is
partitioned into smaller cavities by membranes. Each lung is

covered with a thin membrane called the visceral pleura. At the Yy Left Bronchus
root of each lung, where the bronchi enter, the visceral pleura is 4 :

. Root of 4
reflected back around the lung to form the parietal pleura, a the Lung 7)

lubricating membrane which lines the thorax and covers part of the
diaphragm (Fig. 12.4). Normally, each lung completely fills its
pleural cavity formed by the reflection of the visceral pleura. The
pleural membranes allow the lung to slide freely within the pleural
cavity during the respiratory cycle. The space between visceral and
parietal pleura, called the pleural space, is only a potential space.
Normally, only a thin layer of lubricating fluid separates the two
layers of pleura. The pleural cavities are airtight and form part of
the thoracic cavity; however, the interior of the lungs is open to the
atmosphere via the airways. Therefore, whenever the thoracic
cavity enlarges, the pleural cavities along with the lungs also Fig. 12.4 Pleural Cavities (frontal aspect)
enlarge.

Changes in the volume of the thorax are produced by contraction of

skeletal muscles collectively called respiratory muscles. They are arbitrarily divided into two groups. Inspiratory muscles
contract and increase thoracic volume. The diaphragm and the external intercostals muscles are examples. Expiratory muscles
contract and decrease thoracic volume. Examples include the internal intercostals muscles and the abdominal muscles.

At the beginning of inspiration, the thoracic cavity is enlarged by contraction of the diaphragm and the external intercostals
(Fig. 12.5). The diaphragm, normally dome-shaped at rest, becomes flatter when its muscle fibers contract, thereby increasing
thoracic volume. The external intercostals elevate the ribs, a kind of bucket-handle lift that increases the diameter, and hence
the volume of the thorax. An increase in thoracic volume is accompanied by an increase in intrapulmonic volume, and,
according to Boyle’s law, a decrease in intrapulmonic pressure. As soon as intrapulmonic pressure falls below atmospheric
pressure, air flows down the pressure gradient from the atmosphere through the airways and into the expanded air spaces in
the lungs, continuing to flow until intrapulmonic pressure is again equal to atmospheric pressure (Fig. 12.5). At the end of
inspiration, intrapulmonic pressure equals atmospheric pressure and airflow ceases even though intrapulmonic volume is
larger than at the beginning of inspiration.

Visceral
¥~ Pleura

Parietal
Pleura

Pleural |
Space
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Fig. 12.5 Intrapulmonic pressure and volume changes
during one respiratory cycle

Expiration begins when the inspiratory muscles relax. The diaphragm returns to its resting dome shape, decreasing thoracic
and intrapulmonic volume. Relaxation of the external intercostals allows the ribs to fall to their resting position, thereby
reducing the diameter, and thus the volume of the thorax and lungs (Fig. 12.5). A reduction in intrapulmonic volume is
accompanied by an increase in intrapulmonic pressure. As soon as intrapulmonic pressure increases above atmospheric
pressure, air flows down the pressure gradient from the expanded air spaces in the lung through the airways and back into the
atmosphere, continuing to flow until intrapulmonic pressure is again equal to atmospheric pressure (Fig. 12.5).

The volume of air a person inhales (inspires) and exhales
(expires) can be measured with a spirometer (spiro =
breath, meter = to measure). A bell spirometer consists of a
double-walled cylinder in which an inverted bell filled with
oxygen-enriched air is immersed in water to form a seal
(Fig. 12.6). A pulley attaches the bell to a recording pen
that writes on a drum rotating at a constant speed. During
inspiration, air is removed from the bell and the pen rises,
recording an inspired volume. As expired air enters the bell,
the pen falls and an expired volume is recorded. The
resultant record of volume change vs. time is called a
spirogram.

In this lesson, you will use the BIOPAC airflow transducer
and the software will convert airflow to volume, thus
approximating the volume measurements from a
spirometer. Air flows through a sealed head which is
divided in half by a fine mesh screen. The screen creates a
slight resistance to airflow resulting in a higher pressure on
one side than the other. A Differential Pressure Transducer
measures the pressure difference, which is proportional to
the airflow, and converts it to a voltage, which is then
recorded by the BIOPAC MP unit. After the airflow
recording is complete, the software calculates volume by
integrating the airflow data. This integration technique is a
simple method for obtaining volume but is very sensitive to
baseline offset. For this reason the calibration and recording
procedures must be followed exactly to obtain accurate
results.
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20

3 b 'I
Water [l
Fig. 12.6 Bell Spirometer
Screen
Airflow -’ Bl outict

Inlet i N

: T
Higher it Lower
Pressure Pressure

P4
Differential Pressure Transducer
Fig. 12.6b Airflow Transducer
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Fig. 12.7 Example of respiratory volumes and capacities

e Tidal Volume (TV) is the volume of air inspired or expired during a single breath. When a resting person breathes
normally, tidal volume is approximately 500 ml. During exercise, tidal volume can be more than 3 liters.

e Inspiratory Reserve Volume (IRV) is the volume of air that can be maximally inhaled at the end of a tidal
inspiration. Resting IRV is approximately 3,300 ml in young adult males and 1900 ml in young adult females.

e Expiratory Reserve Volume (ERV) is the volume of air that can be maximally exhaled at the end of a tidal
expiration. Resting ERV is approximately 1,000 ml in young adult males and 700 ml in young adult females.

e Residual Volume (RV) is the volume of gas remaining in the lungs at the end of a maximal expiration. In contrast
to IRV, TV, and ERV, residual volume does not change with exercise. Average adult values for RV are 1,200 ml for
males and 1,100 ml for females. Residual volume reflects the fact that after the first breath at birth inflates the lungs,
they are never completely emptied during any subsequent respiratory cycle.

Pulmonary Capacity is the sum of two or more primary lung volumes. There are five pulmonary capacities, which can be
calculated as shown below:

1. Inspiratory Capacity (IC) IC=TV +IRV

2. Expiratory Capacity (EC) EC=TV +ERV

3. Functional Residual Capacity (FRC) FRC = ERV + RV

4. Vital Capacity (VC) VC=IRV +TV + ERV

5. Total Lung Capacity (TLC) TLC=IRV+TV +ERV + RV

Each of these capacities is represented graphically in Fig. 12.7 above.

Pulmonary volumes and capacities are generally measured when assessing health of the respiratory system because the
volume and capacity values change with pulmonary disease. For example, inspiratory capacity is normally 60-70% of the
vital capacity.
In this lesson, you will measure tidal volume, inspiratory reserve volume, and expiratory reserve volume. Residual volume
cannot be measured using a spirogram or airflow transducer. You will then calculate inspiratory capacity, vital capacity, and
the % observed vital capacity to the average values for comparison. Next, you will compare your observed vital capacity with
the predicted vital capacity.
The following equations can be used to obtain the predicted vital capacities for men or women of your height and age. Vital
capacities are dependent on other factors besides age and height. Therefore, 80% of the calculated values are still considered
normal.

Table 12.1

Equations for Predicted Vital Capacity
(Kory, Hamilton, Callahan: 1960)

Male V.C. = 0.052H - 0.022A — 3.60
Female V.C. =0.041H - 0.018A — 2.69
Where V.C. Vital Capacity in liters

H Height in centimeters
A Ageinyears
Using the equation in Table 12.1, you can estimate the vital capacity of a 19 year old female who is 167 centimeters tall
(about 5’6”) as 3.815 liters:
0.041 x (167) — 0.018 x (19) — 2.69 = 3.815 liters
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Il. EXPERIMENTAL OBJECTIVES

1.) To observe experimentally, record and/or calculate selected pulmonary volumes and capacities.
2.) To compare the observed values of volume and capacity with average values.
3.) To compare the normal values of pulmonary volumes and capacities of subjects differing in sex, age, weight, and

height.

I11. MATERIALS

BIOPAC Airflow Transducer (SS11LA or SS11LB for BSL 4.1.1 and higher only)

BIOPAC Bacteriological Filter (AFT1): one per subject. If using calibration syringe, one dedicated to syringe.
BIOPAC Disposable Mouthpiece (AFT2)

BIOPAC Noseclip (AFT3)

BIOPAC Calibration Syringe: 0.6-Liter (AFT6 or AFT6A+AFT11A) or 2-Liter (AFT26)

Optional—BIOPAC Autoclavable Mouthpiece (AFT8) or combination mouthpiece/filter (AFT36, for SS11LB
only)
Biopac Student Lab System: BSL 4 software, MP36, MP35 or MP45 hardware

Computer System (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP

FAST TRACK Setup Detailed Explanation of Setup Steps

1. Turn your computer ON.
2. Turn OFF MP36/35 unit.

o |fusing an MP45, make sure USB cable is
connected and “Ready” light is ON.

3. Plug the Airflow Transducer (SS11LA or
SS11LB) into Channel 1.

4, Turn ON the MP36/35 unit.

Page P-1

Fig. 12.8 MP3X (top) and MP45 (bottom) equipment connections

Setup continues...

©BIOPAC Systems, Inc.
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5. Start the Biopac Student Lab program.

6. Choose “L12 — Pulmonary Function I” and
click OK.

7. Type in aunique filename and click OK.

8. Enter the “Subject Details” and click OK.
(BSL 4.0.1 and higher only.)

9. Optional: Set Preferences.
e Choose File > Lesson Preferences.
e Select an option.
o Select the desired setting and click OK.

END OF SETUP

Start Biopac Student Lab by double-clicking the Desktop shortcut.

Biopac
Student Lab
4.0

No two people can have the same filename, so use a unique identifier,
such as Subject’s nickname or student 1D#.

A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a commaon folder.

Subject Details records the gender, age and height of the Subject
prior to beginning the lesson. Domestic or metric units may be
selected. These details are displayed in the Journal following the
lesson. (BSL 4.0.1 and higher only.)

Enter Subject vitals:

Gender: + Male  Female
Age: 122 years

Height: IG 'IZ - Ifeet+inches ;]

This lesson has optional Preferences for data and display while
recording. Per your Lab Instructor’s guidelines, you may set:
Residual Volume: RV cannot be determined using a normal
spirometer or airflow transducer, so the BSL
software sets a value between 0 and 5 liters
(defaultis 1 L).
Grids: Show or hide gridlines.
Calibration Syringe Values:
“Set each time lesson is launched”: Syringe (Stage 2) calibration is
required the first time the lesson is run. After the lesson is re-run
without closing the application, Syringe calibration is not required.
“Set once and use stored values”: After Syringe calibration is
performed once, it will not be performed again. This is only
recommended when specific SS11LA Airflow Transducers are
matched to specific MP units.
Calibration Syringe Size:
0.61 L (AFT6A/6,) 1L, 2L (AFT26,)3L,4L,0or5L

SS11LB Calibration Option

““Use factory calibration”: Bypasses the Syringe (Stage 2)
calibration and uses factory settings.

“Require calibration syringe’’: Follows the “Calibration Syringe
Values” protocol described above.

The SS11LB Airflow Transducer is supported in BSL versions 4.1.1
and higher only.
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Stage 1 — Always required

Stage 2 — If required

B. CALIBRATION

Calibration establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for optimal
performance. Calibration will vary based on the Preference set by your lab instructor.

1.

2.

3.

FAST TRACK Calibration

Hold the Airflow Transducer upright and
still, making sure no air is flowing
through it (Fig. 12.9).

Click Calibrate.
e Wait for Calibration to stop
Check Calibration data:

o Verify data is flat and centered. If
necessary, click Redo Calibration.

e To proceed, click Continue.

IF CALIBRATION STAGE 2 IS
REQUIRED—Attach Calibration
Syringe and filter to SS11LA Airflow
Transducer. The filter is not required if
using the SS11LB Airflow Transducer.
(Fig. 12.11).

IMPORTANT!

Always insert on the
side labeled “Inlet.”

o Pull Calibration Syringe plunger all
the way out.

e Hold syringe horizontally. Airflow
Transducer must be vertical and
unsupported.

¢ Review Calibration procedure.

Calibration continues...

L12 — Pulmonary Function |
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Detailed Explanation of Calibration Steps

Calibration Stage 1 precisely
zeroes the baseline. Any baseline
shift during this calibration can
cause errors in the subsequent
recordings. Baseline shift can
occur from:

a) Airflow through the
transducer from movement, an
HVAC duct or even from
breathing close to the unit.

b) Changes in transducer
orientation. The transducer
should be held still and in the
same orientation that will be
used during the recording.

Fig. 12.9

Calibration lasts from 4 to 8 seconds.

L |
Fig. 12.10 Example calibration stage 1 data

Based on Lesson Preference settings, the calibration syringe may not
be required. If not required, proceed to Step 9.

Notes:

= |f using the SS11LA transducer, a bacteriological filter must be used
between the transducer and syringe in order for calibration to be
accurate. The SS11LB calibration does not require this filter.

= Different syringe sizes are supported via File > Lesson Preferences
> Calibration Syringe Size. Check the pictures in the SET UP >
Calibration tab to make sure they match your setup. If incorrect, the
lesson must be re-run and the preference changed prior to
calibration Stage 1. If you are using a non-BIOPAC syringe, always
check the Preference setting prior to beginning calibration Stage 1.

SS11LA  AFT1 AFT11A AFTEA
E i }

S511LB  AFT114

AFTEA

AFTE

S511LB

Fig. 12.11 Example AFT6A/6 connections (SS11LA and SS11LB)
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Fig. 12.12 Example AFT26 connections (SS11LB)
Never hold onto the Airflow Transducer handle when using the
Calibration Syringe or the syringe tip may break. Always insert syringe
assembly on the transducer side labeled “Inlet” so that the transducer
cable exits on the left.

5. Click Calibrate.

Fig. 12.13 AFT6A calibration stage 2 starting position

kS
=) i &
£ Fig. 12.14 AFT26 calibration stage 2 starting position
§ 6. Cycle plunger in and out five times (10 Important:
o strokes total). = Complete exactly five cycles. Less or more cycles will result in
o o Wait two seconds between each inaccurate volume data.
g stroke. = Syringe must be pushed in and pulled out all the way.
= Hold the assembly as still as possible.
7. Click End Calibration. = Use a rhythm of about one second per stroke with two seconds

rest between strokes.

8. Verify recording resembles the example  There must be five downward deflections and five upward deflections.
data. The first deflection must be downward. If the first stroke (push)
« If similar, click Continue to proceed. resulted in an upward data deflection, the syringe/filter assembly must
be reversed by inserting the assembly into the other port of the airflow
transducer and rerunning the Calibration.

o |f necessary, click Redo Calibration.

Calibration continues... il
Fig. 12.15 Example calibration (stage 2) data
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9. Optional Validate Calibration.
a) Click Record.
b) Cycle the syringe plunger in and out
completely 3 times (6 strokes,)

waiting about two seconds between
strokes.

c) Click Stop.

d) Measure P-P on CH2 Volume (Fig.
12.15) to confirm the result matches
the syringe volume:

e AFT6 =0.61 L acceptable range:
0.57 to 0.64 liters

e AFT26 =2 L acceptable range: 1.9 to
2.1 liters

e) If measurements are correct, click
Redo and proceed with Subject
recording.

f) If measurements are not correct:
¢ Click Redo then choose File > Quit.

10. Re-launch the application and re-run the
lesson.

OPTIONAL

END OF CALIBRATION

C. DATA RECORDING
FAST TRACK Recording

1. Prepare for the recording.

e Remove calibration syringe/filter
assembly (if used).
IMPORTANT!

Subject must be relaxed to
obtain accurate measures.

2. Insert the filter into the “Inlet” side of the
transducer, and then attach the mouthpiece
(Fig. 12.17).

o If your lab does not use disposable
filters, attach a sterilized mouthpiece
(AFTS8) directly to the “Inlet” side of the
transducer (Fig. 12.18).

Recording continues...

It is advisable to validate calibration once per lab session. Syringe must
be pushed in and pulled out all the way.

Fig. 12.16 Calibration validation shows P-P result 0.6 liters
If recording does not resemble the Example Data

= |f the data is noisy or flatline, check all connections to the MP
unit.

Clicking Redo will erase the validation data and allow the Subject
recording to continue.

It is necessary to re-launch the application in order to allow a new
Stage 2 (Syringe) calibration. Prior to the next recalibration, make sure
the lesson preference setting “Calibration Syringe Values” is assigned
“Set each time lesson is launched” (see Setup Step 8).

Detailed Explanation of Recording Steps

The filter used during calibration should not be re-used by the Subject
as it will not be sterile.

Hints for obtaining optimal data:

= Subject should wear loose clothing so clothing does not inhibit
chest expansion.

= Subject must try to expand the thoracic cavity to its largest
volume during maximal inspiratory efforts.

= Air leaks will result in inaccurate data. Make sure all connections
are tight, noseclip is attached and that Subject’s mouth is sealed
around the mouthpiece.

= Keep the Airflow Transducer vertical and in a constant position
(Fig. 12.20).

= |f recording is started on an inhale, try to stop recording on an
exhale, or vice versa. (A breath is considered a complete inhale-
exhale cycle.)

IMPORTANT: Each Subject must use a personal filter, mouthpiece
and noseclip. The first time they are used, the Subject should
personally remove them from the plastic packaging. It is advisable to
write Subject’s name on the mouthpiece and filter with a permanent
marker so they can be reused later (i.e. Lesson 13).

If your lab sterilizes the airflow heads after each use, make sure a
clean head is installed prior to Subject use.
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"Inlet” label
on this side

Disposable
mouthpiece (AFT2)

I\d
Fig. 12.17 SS11LA with unsterilized head

Fig. 12.18 SS11LA/LB with sterilized head

Fig. 12.19 SS11LB with reusable filter/mouthpiece combination

3. Prepare the Subject: Verify there are no air leaks; mouthpiece and filter are firmly attached,
. the noseclip is snug and the Subject’s mouth is tightly sealed around
e Subject must be seated, relaxed and mouthpiece.

still, facing away from the monitor.
e Place noseclip on Subject’s nose.

e Subject holds airflow transducer
vertically, breathing through
mouthpiece.

» Before recording, Subject acclimates by
breathing normally for 20 seconds.

e Review recording steps.

Fig. 12.20 Keep Airflow Transducer vertical at all times
4. Click Record. 1 cycle = inspiration + expiration

« Breathe normally for five cycles. If a recording is started on an inhale, try to stop recording on an exhale,

) or vice versa. (A breath is considered a complete inhale/exhale cycle.)
¢ Inhale as deeply as possible then exhale

completely.
o Breathe normally for five more cycles.

5. Click Stop. After clicking Stop, the Biopac Student Lab software will
automatically calculate volume data based on the recorded airflow data.
At the end of the calculation, both waveforms will be displayed on the

Recording continues... screen (Fig. 12.21).
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6. Verify that Volume channel reading
resembles the example data.

o |f similar, proceed to Step 7.

o If necessary:
Click Redo and repeat Steps 4 — 6
OR

Re-run the lesson and perform Stage 1
Calibration.

7. Click Done.
8. Choose an option and click OK.
END OF RECORDING

L12 — Pulmonary Function | Page P-7

The deep inhale/exhale should be clearly seen in the Volume data and
there should be five normal breathing cycles both before and after deep
breathing. It is common to have some “tilt” in the volume data as
shown in Fig. 12.21. If the volume data exhibits excessive tilt (Fig.
12.22)) redo the recording.

Fig. 12.21 Example Data

Fig. 12.22 Excessive tilt in the Volume data

If recording does not resemble Fig. 12.21:

= |f the data is noisy or flatline, check all connections to the MP
unit.

= |f there is excessive “tilt” in the data (Fig. 12.22):

= Make sure there are five normal breathing cycles on either side of
the deep inhale/exhale.

= Verify there are no air leaks; mouthpiece and filter are firmly
attached, the noseclip is snug and the Subject’s mouth is sealed
around mouthpiece.

= [f arecording is started on an inhale, try to stop recording on an
exhale, or vice versa.

= Verify the airflow transducer is kept vertical and still for the entire
recording.

Click Redo and repeat Steps 4 — 6 if necessary.

If redoing the recording does reduce data “tilt,” Stage 1 calibration
(baseline adjust) must be repeated. To re-run lesson and redo stage 1
calibration:

= Click Redo.
= Choose “L12 — Pulmonary Function I” from the Lessons menu.
= Re-enter your name and proceed with calibration and recording.

Note that once Redo is clicked or the lesson is re-run, the most recent
recording will be erased.

When Done is clicked, a dialog with options will be generated. Make a
selection and click OK.

If choosing the Record from another Subject option:
= Repeat Calibration Steps 1 — 3, and then proceed to Recording.
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V. DATA ANALYSIS

FAST TRACK Data Analysis Detailed Explanation of Data Analysis Steps
1. Enter the Review Saved Data mode. If entering Review Saved Data mode from the Startup dialog or
« Note channel number (CH) designations: Lessons menu, make sure to choose the correct file.
Channel  Displays oz o ———— __
CH1 Airflow (hidden)
CH?2 Volume

¢ Note the measurement box settings:
Channel Measurement
CH?2 P-P
CH?2 Max

CH?2 Min
CH?2 Delta

|:-|-.:<(- 400 600 L0 1600 1200 400 3600 1000 000 2240

Fig. 12.23 Example data

All measurements will be performed on the Volume (CH 2) data. The
Airflow (CH 1) data, used to calculate volume, is hidden to avoid
confusion. It can be shown by “Alt + click” (Windows) or “Option +
click” (Mac) the channel number box.

The measurement boxes are above the marker region in the data
window. Each measurement has three sections: channel number,
measurement type, and result. The first two sections are pull-down
menus that are activated when you click them.

Brief definition of measurements:

P-P (Peak-to-Peak): Subtracts the minimum value from the
maximum value found in the selected area.

Max: Displays the maximum value in the selected area.
Min: Displays the minimum value in the selected area.

Delta: Computes the difference in amplitude between the last point
and the first point of the selected area.

The “selected area” is the area selected by the I-Beam tool (including
endpoints).

Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom
Back, Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)
Cursor Tools: Zoom Tool
Buttons: Overlap, Split, Show Grid, Hide Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click”
Data Analysis continues... (Mac) the channel number box to toggle channel display.

Page P-1 ©BIOPAC Systems, Inc.
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2.

Review the measurements described in the
Introduction to identify the appropriate
selected area for each.

Calculate the Predicted Vital Capacity, then
measure VC and then compare the two.

g A

Take two measures on the third TV cycle:

a) Use the I-beam cursor to select the
inhalation of cycle 3 and note the P-P
result (Fig. 12.26). The selected area
should be from the valley to the peak of
the third cycle.

g s

b) Use the I-beam cursor to select the
exhalation of cycle 3 and note the P-P
result (Fig. 12.27). The selected area
should be from the peak to the valley of
the third cycle.

g s

Data Analysis continues...

L12 — Pulmonary Function |
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Fig. 12.24 Measurement areas for respiratory volumes and capacities

The selected area should start just prior to the maximum peak and end
just after the minimum peak. The P-P (peak to peak) measurement
displays the VVC.
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Fig. 12.25 Example selected area; P-P measures VC

The P-P measurement in Fig. 12.26 represents the first value required
for the averaged TV calculation.
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Fig. 12.26 Example of cycle 3 — Inhale selection to measure TV

The P-P measurement in Fig. 12.27 represents the second value
required for the averaged TV calculation.
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Fig. 12.27 Example of cycle 3 — Exhale selection to measure TV
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5. Repeat TV measurements, as in Step 4, but
on cycle 4 data. Calculate average value of
all four TV measurements.

g s

6. Use the I-beam cursor and measurement Note that the Delta measurement requires precise placement of the
tools to record the volumes and capacities selected area.
required by the data report (defined in Fig. D R e R e
12.24). — -

g s

7. Answer the questions at the end of the Data
Report.

8. Save or Print the data file.
9. Quit the program.

BHIE AW AW LI B0 GE WD B0 BD BD SK S0 S0 S0 G5 DD NS I R0 Gm Un A0 e
I ey 1

Fig. 12.28 Example selection for measurements of TLC (Max) and IRV
(Delta)
An electronically editable Data Report is located in the journal
(following the lesson summary,) or immediately following this Data
Analysis section. Your instructor will recommend the preferred
format for your lab.

END OF DATA ANALYSIS

END OF LESSON 12
Complete the Lesson 12 Data Report that follows.
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PULMONARY FUNCTION I

e Volumes and Capacities
DATA REPORT

Student’s Name:

Biopac Student Lab 4

Lab Section:

Date:

Subject Profile

Name:

Height: Gender:

Age:

Weight:

I. Data and Calculations
A. Vital Capacity

i ) Predicted: Use the equation below to calculate your Predicted Vital Capacity:

Male / Female

Equations for Predicted Vital Capacity
(Kory, Hamilton, Callahan: 1960)

Male V.C. =0.052H - 0.022A - 3.60

Female V.C.=0.041H - 0.018A - 2.69

Where
V.C. Vital Capacity in liters
H Height in centimeters
A Age in years

ii) Observed: Use the P-P result to note Observed Vital Capacity:

iii) Observed vs. Predicted

=S PN |

What is Subject’s observed Vital Capacity to predicted Vital Capacity as a percentage?

Observed/Predicted VC =

%

Note: Vital capacities are dependent on other factors besides age and height. Therefore, 80% of predicted values

are still considered “normal.”
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B. Volume & Capacity Measurements

Complete Table 12.2 with the requested measurement results and calculate results per the formulas provided.

Table 12.2 Measurements

Title Measurement Result Calculation
Tidal Volume ™V la= Cycle 3 inhale: (a+g)72i

b= Cycle 3 exhale:
c= Cycle 4 inhale:
d= P-P I Cycle 4 exhale:

Inspiratory Reserve Volume IRV

Expiratory Reserve Volume ERV

Residual Volume RV Default = 1
(Preference setting)

Inspiratory Capacity IC TV +IRV =

Expiratory Capacity EC TV + ERV =

Total Lung Capacity TLC bl IRV +TV +
ERV + RV =

C. Observed vs. Predicted Volumes

Using data obtained for Table 12.2, compare Subject’s lung volumes with the average volumes presented in the
Introduction.

Table 12.3 Average Volumes vs. Measured Volumes

Volume Title Measured

Average Volume

Volume

TV can be more than 3 liters

Tidal Volume TV Resting subject, normal breathing: greater than
TV is approximately 500 ml. equal to
During exercise: less than

Inspiratory Reserve Volume IRV

Resting IRV for young adults is
males = approximately 3,300 ml
females = approximately 1,900 ml

greater than
equal to
less than

Expiratory Reserve Volume

ERV

Resting ERV for young adults is
males = approximately 1,000 ml
females = approximately 700 ml

greater than
equal to
less than
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I1. Questions

D. Why does predicted vital capacity vary with height?

E. Explain how factors other than height might affect lung capacity.

F. How would the volume measurements change if data were collected after vigorous exercise?

G. What is the difference between volume measurements and capacities?

H. Define Tidal Volume.

I.  Define Inspiratory Reserve Volume.

J.  Define Expiratory Reserve Volume.

K. Define Residual Volume.

L. Define Pulmonary Capacity.

M. Name the Pulmonary Capacities.

End of Lesson 12 Data Report
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I. Introduction

The respiratory or pulmonary system performs the important functions of supplying oxygen (O,) during inhalation,
removing carbon dioxide (CO,) during exhalation, and adjusting the acid-base balance (pH) of the body by removing acid-
forming CO,. Because oxygen is necessary for cellular metabolism, the amount of air that the pulmonary system provides is
important in setting the upper limits on work capacities or metabolism. Therefore, the measurement of lung volumes and the
rate of air movement (airflow) are important tools in assessing the health and capacities of a person.

In this lesson, you will measure:

e Forced Vital Capacity (FVC,) which is the maximal amount of air that a person can forcibly exhale after a
maximal inhalation.

e Forced Expiratory Volume (FEV,) which is the percentage of FVVC that a person forcibly expels in intervals of 1,
2, and 3 seconds. (FEV 1, FEV,, FEV3y)

e« Maximal Voluntary Ventilation (MVV,) which is a pulmonary function test that combines volume and flow rates
to assess overall pulmonary ventilation.

These measurements indicate the upper limit of work that the person can do based on the capabilities of his or her respiratory
system. When a person takes in maximal inhalation and then follows this with maximal exhalation the volume of expired air
is that person’s Single Stage Vital Capacity (SSVC). The time required to achieve maximal exhalation is not a factor in
determining SSVC.

Because the lungs reside in the thoracic cavity, vital capacity is ultimately restricted by the size of a person’s thoracic cavity.
Therefore, size-related variables (e.g., age, gender, weight) affect the capacities of the respiratory system (Table 13.1).

Using the equation in Table 13.1, you can estimate the vital
capacity of a 19 year old female who is 167 centimeters tall

Table 13.1

Equations for Predicted Vital Capacity
Kory, Hamilton, Callahan: 1960)

(about 5°6”) as 3.815 liters:
0.041 x (167) — 0.018 x (19) — 2.69 = 3.815 liters

Male V.C. =0.052H - 0.022A - 3.60

For adults, the average pulmonary capacities decrease with age.

Female V.C.=0.041H - 0.018A — 2.69

Women tend to have smaller volumes than men of the same age

and weight. As weight increases, volumes increase, with the
exception that overweight people tend to have decreased
volumes.

Even within one person, respiratory supply and demand differs with activity levels and health. Accordingly, the rate and
depth of ventilation (the volume of gas you breathe in and out per minute) are not static but rather must constantly adjust to
the changing needs of the body. As you increase your activity levels from rest, the volume and rate of air flowing in and out
of your lungs also changes. The changes in volume and how fast those changes in volume (airflow) are effected can be used
to assess the health of a person’s respiratory system.

Pulmonary volumes, pulmonary capacities, and pulmonary airflow rates are often measured in diagnosing and assessing the
health of the respiratory system (Fig. 13.1).

V.C. Vital Capacity (L) H Height (cm)

Page I-1 ©BIOPAC Systems, Inc.

A Age in years
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8.0

70

Vital Cap'acity (VC)

Inspiratory Reserve i
Volume (IRV) Inspiratory Capacity (IC)
50
40 E
Tidal Volume (TV) 38
Functional Residual
Capacity (FRC)
Total Lung : : &
Capacity (TLC) Expiratory Expiratory
Reserve Capacity (EC) Residual 10
Volume (ERV) Volume (RY)
0o
oo 4.0 g0 120 160 200 : 240 280 320 360 400
<«——normal breathing ITI }—] } normal breathing ——
maximal inhale recovery

maximal exhale
Fig. 13.1 Examples of commonly measured pulmonary volumes and capacities

In this lesson, you will perform two tests to measure pulmonary flow rates:
1. Forced Expiratory Volume (FEV)
2. Maximal Voluntary Ventilation (MVV)

Test #1: Forced Expiratory Volume (FEV)

Forced Expiratory Volume (also referred to as forced vital capacity or timed vital capacity) is a test in which a limit is placed
on the length of time a Subject has to expel vital capacity air. FEV, FEV,, FEV3 are defined as the percentage of vital
capacity that can be forcibly expelled after a maximal inhalation in the period of one second, two seconds, and three seconds,
respectively (Fig. 13.2).

1 second

—,"—'—'_-_ .

Liters

Vital Capacity (VC)
air exhaled in 1 second 2

1 2 3

seconds

volume of air expired in 1 second
Vital Capacity (VC)

x 100

FEVy o(%) =

Fig. 13.2 Section of arecord of Forced Expiratory Volume in one second (FEV1,)

The normal adult is able, with maximal effort, to expire about 66-83% of his/her vital capacity in one second (FEV,)
75-94% of vital capacity in the second second (FEV,,4,) and 78-97% of vital capacity by the end of the third second
(FEV3o).

A person with asthma may have a normal or near-normal vital capacity as measured in a Single
Stage Vital Capacity test, which allows as long as necessary to maximally inhale and exhale.
However, when an asthmatic exhales vital capacity with maximal effort, FEV measurements are all
reduced because heavy mucus secretion and smooth muscle action reduces airway diameter and it
takes longer to completely exhale vital capacity against increased airway resistance.
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Test #2 Maximal Voluntary Ventilation (MVV)

The Maximal Voluntary Ventilation (also known as maximal breathing capacity) measures peak performance of the lungs
and respiratory muscles. MVV is calculated as the volume of air moved through the pulmonary system in one minute while
breathing as quickly and deeply as possible (hyperventilation). In performing this test, Subject inspires and expires as deeply
and as rapidly as possible (> 1 breath/sec) while the tidal volume and the respiratory rate are measured. Because the maximal
breathing rate is difficult to maintain, Subject hyperventilates for a maximum of 15 seconds. Then, to calculate MVV, the
average volume per respiratory cycle (liters) is multiplied by the number of cycles per minute (liters/min).

MVV can also be extrapolated from the total volume of air moved in a 12-sec period (total volume in 12-sec X 5 = MVV).

-——Number of cycles in 12 seconds——

Liters

Average Yolume
A ﬂ A — per cycle

EiT 200 =0 20 240 ET 20 0 ET =0 0.0 ) E) 0 ETY] e e

seconds

Number of cycles/minute = Number of cycles in 12 seconds x 5

MVV = (Average Volume per cycle) x (Number of cycles/minute)
Fig. 13.3 MVV example

Normal values vary with sex, age and body size. MVV is a measure of how much your pulmonary system limits your
capacity to work or exercise.

You can rarely exceed your MVV, even for brief periods of time. Therefore, MVV ultimately limits how
much oxygen is available for exercising muscles. In general, a maximum of 50% of your MVV can be
used for exercise beyond 10 minutes. Most people have trouble breathing when only using the
available 30-40% MVV. MVV tends to be reduced in both restrictive and obstructive pulmonary
diseases.
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Il. EXPERIMENTAL OBJECTIVES
1.) To observe experimentally, record, and/or calculate forced expiratory volume (FEV) and maximal voluntary
ventilation (MVV).
2.) To compare observed values of FEV with predicted normals.
3.) Compare MVV values with others in your class.

I11. MATERIALS

e BIOPAC Airflow Transducer (SS11LA) or SS11LB for BSL 4.1.1 and higher only)

e BIOPAC Bacteriological Filter (AFT1): one per subject. If using calibration syringe, one dedicated to syringe.
e BIOPAC Disposable Mouthpiece (AFT2)

e BIOPAC Noseclip (AFT3)

e BIOPAC Calibration Syringe: 0.6-Liter (AFT6 or AFT6A+AFT11A) or 2-Liter (AFT26)

e Optional—BIOPAC Autoclavable Mouthpiece (AFT8) or combination mouthpiece/filter (AFT36, for SS11LB
only

e Biopac Student Lab System: BSL 4 software, MP36, MP35 or MP45 hardware
e Computer System (Windows or Mac)

IV. EXPERIMENTAL METHODS

A. SETUP
FAST TRACK Setup Detailed Explanation of Setup Steps
1. Turn your computer ON.
2. Turn OFF MP36/35 unit.

e If using an MP45, make sure USB cable is
connected and “Ready” light is ON.
3. Plug the Airflow Transducer (SS11LA) into
Channel 1.
4. Turn ON the MP36/35 unit.

Fig. 13.4 MP3X (top) and MP45 (bottom) equipment connections

Page P-1 ©BIOPAC Systems, Inc.
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Setup continues...

5. Start the Biopac Student Lab program. Start Biopac Student Lab by double-clicking the Desktop shortcut.
6. Choose “L.13 — Pulmonary Function I11”
and click OK.
7. Type in a unique filename and click OK. ,
Biopac
Student Lab
4.0

No two people can have the same filename, so use a unique identifier,
such as Subject’s nickname or student ID#.

A folder will be created using the filename. This same filename can
be used in other lessons to place the Subject’s data in a common

folder.
8. Optional: Set Preferences. This lesson has optional Preferences for data and display while
» Choose File > Lesson Preferences. recording. Per your Lab Instructor’s guidelines, you may set:

Residual Volume: RV cannot be determined using a spirometer or
] ) ) airflow transducer, so the BSL software sets a default value of 1
* Select the desired setting and click OK. liter. This can be changed to any value between 0 and 5 liters.

Grids: Show or hide gridlines
Calibration Syringe Values:

“Set each time lesson is launched”: Syringe (Stage 2) calibration is
required the first time the lesson is run. If the lesson is re-run
without closing the application, Syringe calibration is not required.

“Set once and use stored values”: After Syringe calibration is
performed once, it will not be performed again. This is only
recommended when specific SS11LA Airflow transducers are
matched to specific MP units.

Calibration Syringe Size:

0.61 L (AFT6A/6,) 1L, 2L (AFT26,)3L,4L,0r5L

SS11LB Calibration Option
““Use factory calibration”: Bypasses the Syringe (Stage 2)
calibration and uses factory settings.
“Require calibration syringe’’: Follows the “Calibration Syringe
Values” protocol described above.

The SS11LB Airflow Transducer is supported in BSL versions
4.1.1 and higher only.

e Select an option.

END OF SETUP
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B. CALIBRATION

Calibration establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for optimal
performance. Calibration will vary based on the Preference set by your lab instructor.

Stage 1 — Always required

Stage 2 — If required

FAST TRACK Calibration

Hold the Airflow Transducer upright and
still, making sure no air is flowing
through it (Fig. 13.5).

Click Calibrate.
e Wait for Calibration to stop

3. Check Calibration data:

 Verify data is flat and centered. If
necessary, click Redo Calibration.

e To proceed, click Continue.

IF CALIBRATION STAGE 2 IS
REQUIRED—Attach Calibration

Syringe and filter to Airflow Transducer .

The filter is not required if using the

SS11LB Airflow Transducer. (Fig. 13.7).

IMPORTANT!
Always insert on the
side labeled “Inlet.”

e Pull Calibration Syringe plunger all
the way out.

¢ Hold syringe horizontally. Airflow
Transducer must be vertical and
unsupported.

e Review Calibration procedure.

Calibration continues...

L13 — Pulmonary Function Il

Detailed Explanation of Calibration Steps

Calibration Stage 1 precisely
zeroes the baseline. Any baseline
shift during this calibration can
cause errors in the subsequent
recordings. Baseline shift can
occur from:

a) Airflow through the
transducer from movement, an
HVAC duct or even from
breathing close to the unit.

b) Changes in transducer
orientation. The transducer
should be held still and in the
same orientation that will be
used during the recording.

Fig. 13.5

Calibration lasts from 4 to 8 seconds.

Fig. 13.6 Example Calibration Stage 1 data

Based on Lesson Preference settings, the Calibration Syringe may not
be required. If not required, proceed to Step 9.

Notes:

= |f using the SS11LA transducer, a bacteriological filter must be
used between the transducer and syringe in order for calibration to
be accurate. The SS11LB calibration does not require this filter.

= Different syringe sizes are supported via File > Lesson Preferences
> Calibration Syringe Size. Check the pictures in the SET UP >
Calibration tab to make sure they match your setup. If incorrect, the
lesson must be re-run and the preference changed prior to
calibration Stage 1. If you are using a non-BIOPAC syringe, always
check the Preference setting prior to beginning calibration Stage 1.

S511LB  AFT114 AFTEA

S511LA  AFT1 AFI'HA AFTEA
& 1 3

S511LA AFTH

Fig. 13.7 Example AFT6A/6 connections (SS11LA and SS11LB)

Page P-3
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Fig. 13.8 Example AFT26 connections (SS11LB)

5. Click Calibrate. Never hold onto the Airflow Transducer handle when using the
Calibration Syringe or the syringe tip may break. Always insert
syringe assembly on the transducer side labeled “Inlet” so that the
transducer cable exits on the left.

Fig. 13.9 AFT6A calibration stage 2 starting position

e)
()
=
£
=
]
@)
(\I' it £
% Fig. 13.10 AFT26 calibration stage 2 starting position
® 6. Cycle plunger in and out five times (10 Important:

strokes total). = Complete exactly five cycles. Less or more cycles will result in

e Wait two seconds between each inaccurate volume data.

stroke. =  Syringe must be pushed in and pulled out all the way.
= Hold the assembly as still as possible.
7. Click End Calibration. = Use a rhythm of about one second per stroke with two seconds

rest between strokes.

8. Verify recording resembles the example  There must be five downward deflections and five upward deflections.

data. The first deflection must be downward. If the first stroke (push)
o Ifsimilar. click Continue and resulted in an upward data deflection, the syringe/filter assembly must
proceed t;J Data Recording. be reversed by inserting the assembly into the other port of the airflow

. transducer and rerunning the Calibration.
e If necessary, click Redo

Calibration.
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OPTIONAL

10.

Calibration continues...

Optional Validate Calibration.

a)
b)

d)

€)

f)

Click Record.

Cycle the syringe plunger in and out
completely 3 times (6 strokes,)
waiting about two seconds between
strokes.

Click Stop.

Measure P-P on CH2 Volume (Fig.
12.16) to confirm the result matches
the syringe volume:

AFT6 = 0.61 L acceptable range:
0.57 to 0.64 liters

AFT26 =2 L acceptable range: 1.9 to
2.1 liters

If measurements are correct, click
Redo and proceed with Subject
recording.

If measurements are not correct:
Click Redo then choose File > Quit.

Re-launch the application and re-run the
lesson.

END OF CALIBRATION
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wm E no

—

Fig. 13.11 Example calibration Data

It is advisable to validate calibration once per lab session. Syringe
must be pushed in and pulled out all the way.

i 1

Fig. 13.12 Calibration validation shows P-P result 0.6 liters
If recording does not resemble the Example Data

= |f the data is noisy or flatline, check all connections to the MP
unit.

Clicking Redo will erase the validation data and allow the Subject
recording to continue.

It is necessary to re-launch the application in order to allow a new
Stage 2 (Syringe) calibration. Prior to the next recalibration, make
sure the lesson preference setting “Calibration Syringe Values” is
assigned “Set each time lesson is launched” (see Setup Step 8).
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C. DATA RECORDING
FAST TRACK Recording

1. Prepare for the recording.

e Remove Calibration Syringe/filter
assembly (if used).

2. Insert the filter into the “Inlet” side of the
transducer, and then attach the mouthpiece
(Fig. 13.13).

« If your lab does not use disposable
filters, attach a sterilized mouthpiece
(AFT8) directly to the “Inlet” side of the
transducer (Fig. 13.14).

Setup continues...

L13 — Pulmonary Function Il

Biopac Student Lab 4

Detailed Explanation of Recording Steps
In this recording, two conditions will be performed to measure
pulmonary flow rates:
Forced Expiratory Volume (FEV)
Maximal Voluntary Ventilation (MVV)
Each test will be saved as a separate data file.
Hints for obtaining optimal data:

= Review onscreen “Tasks” to prepare for the recording steps in
advance.

= Subject should wear loose clothing so clothing does not inhibit
chest expansion.

= Subject must try to expand the thoracic cavity to its largest
volume during maximal inspiratory efforts.

= Air leaks will result in inaccurate data. Make sure all connections
are tight, noseclip is attached and that Subject’s mouth is sealed
around the mouthpiece.

= Keep the Airflow Transducer vertical and in a constant position.
(Fig. 13.16).

IMPORTANT: Each Subject must use a personal filter, mouthpiece
and noseclip. The first time they are used, the Subject should
personally remove them from the plastic packaging. It is advisable to
write Subject’s name on the mouthpiece and filter with a permanent
marker so they can be reused later (i.e. Lesson 12).

If your lab sterilizes the airflow heads after each use, make sure a
clean head is installed prior to Subject use.

"Inlet" label
on this side

Disposable
mouthpiece (AFT2)

Sl
Fig. 13.13 SS11LA with unsterilized head

Fig. 13.14 SS11LA/LB with sterilized head
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3. Prepare the Subject:

e Subject must be seated, relaxed and still,
facing away from the monitor.

e Place noseclip on Subject’s nose.
e Subject holds Airflow Transducer

vertically, breathing through mouthpiece.

o Before recording, Subject acclimates by
breathing normally for 20 seconds.

» Review recording steps.

Part1 — FEV
4. Click Record FEV.
5. Subject performs the following procedure:
» Breathe normally for three cycles.

¢ Inhale as deeply as possible (maximum
inspiration).
¢ Hold breath for just an instant.

o Forcefully and maximally exhale
(maximum expiration).

¢ Resume normal breathing for three more
cycles.

6. Click Stop.

7. Verify recording resembles the example
data.

o If similar, click Continue and proceed to
the next recording.

Recording continues...

L13 — Pulmonary Function Il

Fig. 13.15 SS11LB with reusable filter/mouthpiece combination
Verify there are no air leaks; mouthpiece and filter are firmly attached,
the noseclip is snug and the Subject’s mouth is tightly sealed around
mouthpiece.

Fig. 13.16 Keep Airflow Transducer upright
at all times

1 cycle = inspiration + expiration
After maximum inspiration, hold breath for an instant so that when
analyzing the data the beginning of the exhale can be clearly seen.

For the maximum expiration, it is important to expel all air, which
should take more than 3 seconds.

If a recording is started on an inhale, try to stop recording on an
exhale, or vice versa.

Upon Stop, the Biopac Student Lab software will automatically
convert the air flow data to volume data as shown in Fig. 13.17.

The maximal inhale and maximal exhale should be clearly visible in
the data and there should be three normal breathing cycles both before
and after.

T T T T T T T T Y TR Y T T T

Fig. 13.17 Example FEV Data

Page P-7
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o If necessary, click Redo.

8. Zoom in using the zoom tool, on the area of
maximal exhale.

9. Use the I-beam cursor to select the area of
from beginning of maximal expiration to the
end of maximal expiration. At least three
seconds must be selected (Fig. 13.18).

10. Click Calculate FEV.

11. Verify the FEV plot resembles the example
data.

o If similar, click Continue and proceed to
the MVV recording.

o If necessary, click Redo to reselect area
of maximal exhale and recalculate FEV.

e If you will not be recording MVV, click
Done and proceed to the Data Analysis
section.

Recording continues...

L13 -
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If recording does not resemble the Example Data

= If the data is noisy or flatline, check all connections to the MP
unit.

= |f there are not three normal breathing cycles on either side of the
maximal inhale/exhale, Redo the recording.

= |fitis difficult to determine the beginning of maximal expiration,
the Subject may not have held breath for an instant after maximal
inhalation; consider redoing the recording.

= If the maximal inhale/exhale data is not much greater in amplitude
than that during normal breathing; verify there are no air leaks;
mouthpiece and filter are firmly attached, the noseclip is snug and
the Subject’s mouth is firmly sealed around the mouthpiece.

Click Redo and repeat Steps 4 — 6 if necessary. Note that once Redo
is clicked the data will be erased.

The selected area should include some data both before and after
maximal exhale.

The left mouse button is held down while selecting with the I-beam
cursor.

The first measurement box will display Delta T so you can make sure
the selected area is longer than 3 seconds.

If Delta T is less than 3 seconds, the Subject may not have expelled

all air during maximum expiration. Click Redo and repeat Steps 4 — 6
if necessary.

3 Mot W vommae  F ks - on R oo 2 [ hore - on 2 e

Fig. 13.18 Selected érea for maximal exhale

The program will cut out the selected area, invert it, zero the offset,
and paste it into a new channel (Fig. 13.19). The original volume data
will be deleted.

If the data was selected properly in Step 8, the first data sample should
be the minimum (O Liters) and the data should continue to increase for
at least 3 seconds.

o

smerm

Fig. 13.19 Example FEV Plot

Upon Continue, the FEV data will be automatically saved for later
analysis.
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Part2 — MVV

12. Prepare the Subject.

e Subject must be seated, relaxed and still,
facing away from monitor.

e Place noseclip on Subject’s nose.

e Subject holds airflow transducer
vertically, breathing through mouthpiece.

e Subject breathes normally for 20
seconds prior to starting recording.

» Review recording steps.

13. Click Record MVV

14. Subject performs the following procedure:
o Breathe normally for five cycles.

o Breathe quickly and deeply for 12 — 15
seconds.

o Breathe normally for five additional
cycles.

15. Click Stop.

16. Verify that recording resembles the example
data.

o If similar, proceed to Step 15.

Recording continues...

1 cycle = inspiration + expiration

WARNING: This procedure can make Subject dizzy and light
headed. Subject should be sitting down and Director should
watch Subject. Stop the procedure if Subject feels sick or
excessively dizzy.

Upon Stop, the Biopac Student Lab software will automatically
convert the airflow data to volume data as shown in Fig. 13.20.

The rapid, deep breathing data should be clearly visible in the data.

i W B W 0 S 4 S W 0 = W) =

e

Fig. 13.20 Example MVV data

Note:

The software zeros the baseline after
each cycle, which can result in data
resembling the example to the right.
It is not necessary to redo the
recording, as data analysis will not be
affected.

£

[EDRI0 40 800 o0 000 L AW D 1800 08 B0

Fig. 13.21 Example of baseline
reset
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o If necessary, click Redo.

17. Click Done.
18. Choose an option and click OK.

END OF RECORDING

L13 — Pulmonary Function Il

If recording does not resemble the Example Data

= |f the data is noisy or flatline, check all connections to the MP unit.

= |f the rapid, deep breathing data is not much greater in amplitude
than that during normal breathing; verify there are no air leaks;
mouthpiece and filter are firmly attached, the noseclip is snug and
the Subject’s mouth is firmly sealed around the mouthpiece.

Click Redo and repeat Steps 13 — 15 if necessary. Note that once Redo

is clicked the data will be erased.

This lesson creates two data files; one for FEV data and one for MVV
data, as indicated by the file name extension.

When Done is clicked, a dialog with options will be generated. Make a
selection and click OK.

If FEV and MVV recordings were both performed, choosing the
“Analyze current data file” option will open the MV V file, but the FEV
data file should be opened first, as this file is referenced in Part 1 of the
Data Analysis section that follows.

To open the FEV file first, choose “Analyze another data file” from the
list of options and navigate to the correct “FEV — L13” file in the
Subiject’s folder.

Biopac Student Lab A

What would you like to do now?

Record from another Subject
Analyze current data file
{Analyze another data file
Record another Lesson
Copy to another location
Quit

If choosing the “Record from another Subject” option:
=  Repeat Calibration Steps 1 — 3, and then proceed to Recording.

Biopac Student Lab 4
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V. DATA ANALYSIS

FAST TRACK Data Analysis

1. Enter the Review Saved Data mode.

¢ Note channel number (CH)

designations:
Channel Displays
CH2 Volume

¢ Note measurement box settings:
Channel Measurement
CH2 Delta T
CH2 P-P

2. Use the I-beam cursor to select the area
from time zero to the end of the recording.

Record the Vital Capacity (VC).

g A

Data Analysis continues...
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Detailed Explanation of Data Analysis Steps

If entering Review Saved Data mode from the Startup dialog or Lessons
menu, be sure to choose the file with “FEV — L13” file name extension.

pare o

Im 0
ey

Fig. 13.22 Example FEV data

The measurement boxes are above the marker region in the data window.
Each measurement has three sections: channel number, measurement type,
and result. The first two sections are pull-down menus that are activated
when you click them. The following is a brief description of these specific
measurements.
Brief definition of measurements:
Delta T: Displays the amount of time in the selected area (the difference
in time between the endpoints of the selected area).
P -P (Peak-to-Peak): Subtracts the minimum value from the maximum
value found in the selected area.
The “selected area” is the area selected by the [-Beam tool (including
endpoints).
Useful tools for changing view:
Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom
Back, Zoom Forward
Scroll Bars: Time (Horizontal); Amplitude (Vertical)
Cursor Tools: Zoom Tool

Buttons: Show Grid, Hide Grid, -, +
The P-P measurement for the selected area represents the Vital Capacity
(VO).

Note: In the example, the Grids have been enabled to assist in data
selection.

oMt - e 5 e B e EEEs [F-o s 6o EEm w5 o

Gm o T

Fig. 13.23 All data selected

©BIOPAC Systems, Inc.
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10.

Use the I-beam cursor to select the first
one-second interval (Fig. 13.24). Record
the volume expired and calculate FEV .

Sll:!

Use the I-beam cursor to select the first
two-second interval (Fig. 13.25). Record
the volume expired and calculate FEV,,.

gl B

Use the I-beam cursor to select the first
three-second interval (Fig. 13.26). Record
the volume expired and calculate FEV; .

gl B

Answer the FEV-related questions in the
Data Report before continuing to the
MVV section.

Select File > Save Changes.

Pull down the Lessons menu, select
Review Saved Data, and choose the
correct MVV - L13 file.

Use the zoom tool to set up your display
window for optimal viewing of the deep,
fast breathing portion of the recording
(Fig. 13.27).

Use the I-beam cursor to select a twelve-
second area that is convenient to count the
number of cycles in the interval (Fig.
13.28).

gc

Data Analysis continues...

The selected area should be from Time

L13 — Pulmonary Function Il

0 to the one-second reading, as

displayed in the Delta T measurement.

The grid can be used as a reference.

The volume expired is indicated by the

P-P measurement.

Biopac Student Lab 4

Fig. 13.24 FEV,
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Fig. 13.25 FEV.,
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Choose the data file that was saved with “MVV — L13” extension.
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Fig. 13.27 Zoom in on rapid/deep breathing data

Use the Delta T measurement to determine the time interval. In the
example below, 13 cycles are in the 12 second interval.
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Fig. 13.28 Example of 12 second data selection
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11. Place an event marker at the end of the
12 second selected area (Fig. 13.29).

12. Use the I-beam cursor to select each
complete individual cycle in the 12-
second interval defined in Step 9. Record
the volume of each cycle.

gc

13. Calculate the average volume per cycle
(AVPC) and then the Maximal Voluntary
Ventilation (MVV).

gc

14. Answer the MV V-related questions at in
the Data Report.

15. Save or Print the data file.
16. Quit the program.

END OF DATA ANALYSIS

L13 — Pulmonary Function Il

It’s helpful to clearly mark

Page P-3

R e 3R SRR TP = —— ) e

the end of the individual
cycle measurement area by

placing an event marker at

the end of the selected 12
second interval. To place an
event marker, right-click in

Inserk Mew Event
Paste Event Summary ko Journal ‘

the marker region just
above the data display and
select “Insert New Event.”
If the event marker is not
placed correctly, it can be
moved by holding down the
Alt key and dragging with
the mouse.

You may also enter event
text in the field above the
marker.

Fig. 13.29 Event Marker insertion

The Volume is measured by the P -P (Peak-to-Peak) measurement.

Fig.13.30 shows the first cycle of the 12-second interval defined in Fig.

13.28 selected:

2 Wowt = Limee  EgES B~ 2areiine S0 | b

T ]

Fig. 13.30 Example of first cycle selection

An electronically editable Data Report is located in the journal
(following the lesson summary,) or immediately following this Data
Analysis section. Your instructor will recommend the preferred format

for your lab.

Complete the Lesson 13 Data Report that follows.

END OF LESSON 13
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PULMONARY FUNCTION II

e Pulmonary Flow Rates

e Forced Expiratory Volume (FEV)

» Maximal Voluntary Ventilation (MVV)
DATA REPORT

Student’s Name:
Lab Section:

Biopac Student Lab 4

Date:
Subject Profile
Name: Height:
Age: Gender: Male /Female Weight:

l. Data and Calculations

A. Vital Capacity (VC)

[ | -

B. Forced Expiratory Volumes: FEV; o, FEV,,, FEV3,

Table 13.2
Time Forced Expiratory Vital Capacity (FEVIVC) = Normal Adult
Interval Volume (vC) FEVIVC x 100 = % FEVy Range
(sec) from A calculate calculate
0-1 % | FEV1o | 66% - 83%
0-2 % | FEV2p0 75% - 94%
0-3 % | FEV30 | 78% - 97%
C. MVV Measurements (Note, all volume measurements are in liters)

1) Number of cycles in 12-second interval:
2) Calculate the number of respiratory cycles per minute (RR):
RR = Cycles/min = Number of cycles in 12-second interval x 5

Number of cycles in 12-second interval (from above): x5= cycles/min

3) Measure each cycle

Complete Table 13.3 with a measurement for each individual cycle. If Subject had only 5 complete cycles/12-

sec period, then only fill in the volumes for 5 cycles. If there is an incomplete cycle, do not record it. (The Table

may have more cycles than you need.)

Table 13.3
Cycle Me;/;)lljl:erznn?ent Cycle MeZsOLIJl:?n?ent
Number Number
[ rr ] [ re |
Cycle 1 Cycle 9
Cycle 2 Cycle 10
Cycle 3 Cycle 11
Cycle 4 Cycle 12
Cycle 5 Cycle 13
Cycle 6 Cycle 14
Cycle 7 Cycle 15
Cycle 8 Cycle 16

4) Calculate the average volume per cycle (AVPC):




©BIOPAC Systems, Inc. L13 — Pulmonary Function 11 Page P-5

Add the volumes of all counted cycles from Table 13.3.

Sum = liters

Divide the above sum by the number of counted cycles. The answer is the average volume per cycle (AVPC)

AVPC = / = liters
Sum # of counted cycles

5) Calculate the MVV,y
Multiply the AVPC by the number of respiratory cycles per minute (RR) as calculated earlier.

MVV = AVPC x RR = X = liters/min
AVPC RR

I1. Questions

D. Define Forced Expiratory Volume (FEV).

E. How do Subject’s FEV values compare to the average per Table 13.2?

FEV,, less than same as greater than
FEV,, less than same as greater than
FEV;, less than same as greater than

F. Isitpossible for a Subject to have a vital capacity (single stage) within normal range but a value for FEV |, below
normal range? Explain your answer.

G. Define Maximal Voluntary Ventilation (MVV.)

H. How does Subject’s MVV compare to others in the class? less than same as greater than

I. Maximal voluntary ventilation decreases with age. Why?
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J. Asthmatics tend to have smaller airways narrowed by smooth muscle constriction, thickening of the walls, and
mucous secretion. How would this affect vital capacity, FEV,y, and MVV?

K. Bronchodilator drugs open up airways and clear mucous. How would this affect the FEV and MVV measurements?

L. Would a smaller person tend to have less or more vital capacity than a larger person? [Less [ I More
M. How would an asthmatic person’s measurement of FEV; , and MVV compare to an athlete?

Explain your answer.

End of Lesson 13 Data Report
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l. INTRODUCTION
In this lesson, you will record your blood pressure, which is PULMONARY CIRCULATION

comprised of two numbers: systolic pressure (the force of
blood in your arteries as the heart contracts and pushes it out)
and diastolic pressure (the force of your blood between
heartbeats). Understanding circulation will help you
understand and accurately measure your blood pressure.

Circulating blood provides a transportation and

communication system between the body’s cells and serves to
maintain a relatively stable internal environment for optimum
cellular activity. Blood circulates because the heart pumps it Pulmonary
through a closed circuit of blood vessels (Fig. 16.1 and 16.2). Trunk y~ Veins

Blood flow through the heart and the blood vessels is
unidirectional, flowing into the heart from the pulmonary and
systemic veins, and out of the heart into pulmonary and

Artery.

systemic arteries. Vena Cava
8 o)
@ 5“—‘3 2 Vein w Artery
= [
@ = B
> @
=
@{ﬁ_@y - SYSTEMIC CIRCULATION
Fig. 16.1 Fig. 16.2

Page I-1 ©BIOPAC Systems, Inc.
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Blood flow through the chambers of the heart is
unidirectional because of the action of four valves
inside the heart (see Fig. 16.3) that normally prevent

Aortic

retrograde or backward flow during the cardiac cycle Pulmonary Semilunar Valve

(one heartbeat). Semilunar Valve L.

% The right atrioventricular valve (tricuspid) and —
th(_a left atrioventricular valve (bicuspid or Right Atrium Mitial \alve
mitral) prevent the backward flow of blood from (Atrioventricular)
the ventricles into the atria. Tricuspid Valve & \

% The pulmonary semilunar valve and the aortic (Atrioventricular) | X A —Left Ventricle

semilunar valve prevent the backward flow of

blood from arteries into the ventricles. ) )
Right Ventricle

Fig. 16.3 Heart valves

The left and right ventricles are the primary pumping chambers of the heart. During relaxation of the ventricles (ventricular
diastole) the atrioventricular valves open and the semilunar valves close, allowing the ventricles to fill with blood. During
contraction of the ventricles (ventricular systole) the atrioventricular valves close and the semilunar valves open, allowing
the ventricles to eject blood into the arteries.

As the heart works at pumping blood, the ventricles relax and fill with blood, then contract and eject blood, then repeat the
cycle of filling and ejecting. Due to the nature of the cardiac cycle the ejection of blood by the ventricles into the arteries is
not continuous. Therefore, both blood pressure and blood flow in the arteries is pulsatile, increasing during ventricular
systole and decreasing during ventricular diastole.

Fig. 16.4 represents a graphic recording of changes in systemic arterial blood pressure measured directly by inserting a small
catheter into an artery and attaching the catheter to a pressure measuring and recording device.

1 Pulse Interval
Pulse Pressure 9.8 seconds, :

e T e N e R VI Lo L I
o
¥ +
E
E -
[ A :
5 51 U, (N | IO ., S UL .. 0, IR0 W Mean Arterial
@ Pressure (MAP)
£
L 1 i e S Ll Ll Diastolic
£
S L
<

60+

———+—+—1+—+—+—+—+—+—+—Time (seconds)
1.0 2.0 3.0

Pulse Pressure (mmHg) = Systolic Pressure - Diastolic Pressure
Mean Arterial Pressure (mmHg) = 1/3(Pulse Pressure) + Diastolic Pressure
Heart Rate (BPM) = 60 seconds/minute + Pulse Interval (seconds/beat)

Fig. 16.4 Example of systemic arterial blood pressure changes

Systolic pressure is the highest arterial pressure reached during ventricular systole. The normal range of systolic pressures
for a resting adult is 100 - 139 mm Hg.

Diastolic pressure is the lowest arterial pressure reached during ventricular diastole. The normal range of diastolic pressures
for a resting adult is 60 - 89 mm Hg.
The mathematical difference between systolic pressure and diastolic pressure is called pulse pressure. Pulse pressure is
directly related to stroke volume of the heart and inversely related to heart rate and peripheral resistance.
«+ For example, when the volume of blood ejected per beat (called stroke volume) increases at the beginning

of exercise, systolic pressure increases more than diastolic pressure, resulting in an increase in pulse

pressure.
In the systemic circuit (refer back to Fig. 16.2,) blood flows out of the left ventricle into systemic arteries and then serially
through arterioles, capillaries, venules, and veins before returning to the heart to be pumped through the pulmonary circuit.
Flow through a closed circuit such as the systemic circuit is determined by the pressure energy causing the flow, and the
resistance to flow offered by the blood vessel walls (friction) and the internal viscosity of the blood.
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The relationship between flow (F,) pressure (P) causing the flow and resistance (R) to the flow is expressed as: F = P/R

Flow is expressed as liters/min., pressure is expressed as mm Hg (torr,) and resistance is expressed as peripheral resistance
units.

The pressure (P) is neither systolic nor diastolic but rather a pressure in between the two, called mean arterial pressure
(MAP). Mean arterial pressure converts a pulsatile pressure (systolic/diastolic) into a continuous pressure that determines the
average rate of blood flow from the beginning of the circuit (left ventricle) to the end of the circuit (right atrium).

During the cardiac cycle, or one heartbeat, the ventricle spends more time in diastole than it spends in systole. As a result,
mean arterial pressure is not the mathematical average of systolic and diastolic pressure but rather an approximation of the
geometric mean. Mean Arterial Pressure (MAP) can be calculated using either of the following equations:

+ diastolicpressure OR  MAP— (systolic pressure + 2 diastolic pressure)
3

If systolic pressure were 130 mm Hg and diastolic pressure were 80 mm Hg, then the mean arterial pressure would be 96.67
mm Hg, as calculated below:

MAP — pulse pressure

MAP = %Jrso —16.67 +80=96.67 MM Hg OR map - 130 +32(80)) _ (130 ;160) - ? —96.67 MM Hg
IMPORTANT CONCEPT!

Systemic arterial blood pressure is commonly measured with indirect methods because direct methods of measurement are
invasive and neither practical nor convenient for routine use. It is important to recognize the limitations of indirect
measurement:

.0

% Indirect methods can only give an approximation of the actual blood pressure.

®

« Indirect methods may be influenced by the person taking the measurement—for example, the person may not be
able to hear the sound changes accurately.

« Indirect methods can be influenced by the quality and calibration of the equipment being used.

The most common indirect method of measuring systemic arterial blood
pressure is referred to as an auscultatory method, which simply means
external diagnostic monitoring of the sounds made by internal organs. This
involves the use of a stethoscope and a sphygmomanometer. The

sphygmomanometer is comprised of an inflatable cuff to restrict blood flow, Sphygmomanometer Pressure Gauge
an inflation bulb with release valve, a pressure gauge (which can be a mercury Cuff £ | Mechanical or On Screen
or mechanical manometer,) or an on-screen gauge. The BIOPAC stethoscope

contains a microphone that picks up sounds traveling through the tubing. The Stethoscope

microphone is very sensitive and can pick up sounds that may not be heard. It

is useful to compare the sounds heard to those recorded by the microphone. i

The sounds detected during blood pressure measurement are .
referred to as Korotkoff Sounds and were first identified by bafintionteth J
Russian surgeon Nicolai Sergeivich Korotkov in 1905.

Avrterial pressure is determined by placing an inflatable rubber cuff, attached to -
a pressure gauge, around the arm, inflating it to collapse the underlying artery, Fig. 16.5 Blood pressure cuff placement
and listening over the vessel below the cuff with a stethoscope or microphone

(Fig. 16.5).

Sound is created by the turbulent flow of blood through the compressed vessel. When cuff pressure exceeds systolic arterial
pressure, the artery is collapsed, blood flow through it ceases, and no sound is produced. As cuff pressure is slowly reduced,
blood flow through the artery begins when cuff pressure falls just below systolic arterial pressure.

At this point, a sharp tapping sound (the first sound of Korotkoff) may be heard with the stethoscope or microphone over the
artery. The cuff pressure when this sound is first heard is taken as an approximation of systolic pressure.

As cuff pressure is further reduced, the sounds increase in intensity (and may resemble swishing,) then suddenly become
muffled (the second sound of Korotkoff) at the level of diastolic pressure, then disappear. Sounds disappear when the vessel
is no longer compressed by the pressure cuff and normal non-turbulent blood flow resumes.
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Since it is easier to determine when the sound disappears than when it becomes muffled, and since only a few millimeters of
mercury pressure differential exist between the two, the disappearance of sound is commonly used as an indicator of diastolic
pressure.

ECG Lead Il ~dddododdddddodddbddd bbb

Cuff Pressure
160

130

80
601

Pressure (mmHg)

Korotkoff Sounds R S
Z 4 10 20

’ Time (seconds) ;
Artery collapsed No arterial restriction
no sound no sounds
Diastolic Pressure

Slight blood flow through artery Artery less restricted
first sound heard louder sound
Systolic Pressure A

Fig. 16.6

Fig. 16.6 (above) is a graphic display that summarizes this concept. The diagram shows the relationship in time between the
ECG waveform, the Korotkoff sounds (as heard through the stethoscope,) the cuff pressure, the blood pressure pulse
waveform (at the arm,) and the condition of the brachial artery under the cuff. The pulse waveform represents the brachial
pressure in the artery above the cuff. The shaded area of the Aortic pressure wave represents the blood flow that can pass
below the cuff as soon as the aortic pressure exceeds the cuff pressure.

One concept that can be examined in this lesson is the timing of the Korotkoff sounds with respect to the ECG waveform.
The sounds appear at about the time of the T-wave. This sound occurs approximately near the time of peak pressure (systole,)
which, if measured at the heart, would occur immediately after the R-wave. However, there is a delay due to the time it takes
the pressure wave to reach the arm, so the sounds are shifted in time with respect to the R-wave. Although the ECG wave
will vary based on the experimental condition (i.e., pre-exercise, post-exercise,) the relationship of the P-wave to the sound
should be a consistent interval within each condition. Using this fact, you will be able to distinguish actual Korotkoff sounds
from extraneous noise.

In some cases (such as when a Subject has hypertension) you may notice what is called an “auscultatory gap.” This occurs
when you hear sound at a higher cuff pressure, but it fades out as the pressure is decreased, and then reappears at a still lower
pressure. This may require an alternate method of blood pressure measurement, using a strictly palpatory technique.

By convention, blood pressures determined by indirect methods are expressed in the form of a ratio: systolic
pressure/diastolic pressure. For example, if systolic pressure was measured as 135 mm Hg and diastolic pressure was
measured as 80 mm Hg, systemic arterial blood pressure would be expressed as 135/80, and pulse pressure would be 55 mm
Hg. If the sound became muffled at 85 mm Hg and disappeared at 80 mm Hg, the systemic arterial blood pressure would be
expressed as 135/85-80.

A note about your BP reading from this lab

There are many factors that influence blood pressure measurement, such as: genetics, age, body weight, state of physical
activity, level of salt, caffeine or other drugs in the system, monitor’s hearing, etc.

The Journal of the American Medical Association published the following blood pressure classification data (Table 16.1)
from the Seventh Report of the National High Blood Pressure Education Program’s Joint National Committee on Prevention,
Detection, Evaluation, and Treatment of High Blood Pressure (JNC 7):

CLASSIFICATION OF BLOOD PRESSURE
for Adults Aged 18 Years or Older

BP CLASSIFICATION Systolic mmHg Diastolic mmHg LIFESTYLE MODIFICATION

Normal <120 and <80 Encourage

Prehypertension 120-139 or 80-89 Yes

Stage 1 hypertension 140-159 or 90-99 Yes

Stage 2 hypertension > 160 or > 100 Yes

Note:Diagnosis of high blood pressure is based on the average of two or more readings taken at each of two or more visits
after initial screening. Unusually low readings should be evaluated for clinical significance. © 2003 AMA

Table 16.1 JNC 7 Blood Pressure Classifications
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If your blood pressure as determined from this lesson is “high,” you should not be too concerned. A mistake may have been
made in the measurement, or there may be other factors affecting your system that resulted in a temporarily high reading.

If you are concerned about it, please consult your doctor. Do not try to diagnose or treat yourself based on the laboratory

blood pressure readings.

Please review the following procedure before you come into the lab so recording can proceed quickly.

Blood Pressure Measurement
The following is a review of the basic clinical blood pressure measurement procedure using the sphygmomanometer and

stethoscope, with an explanation of the logic behind each step.

As discussed earlier, this is an indirect blood pressure measurement. It can be fairly accurate if performed exactly as

described, but will nonetheless provide only an approximation of the absolute blood pressure.
It is important that you try to minimize errors by following the measurement procedure as detailed, and it is also important

that you realize it is impossible to eliminate all errors.

Note: The actual procedure used in this lesson will have a few additional steps since you will be

simultaneously recording the parameters.

Basic measurement step

Reason

1. Select the proper size cuff for your Subject.

7

« The BIOPAC sphygmomanometer cuff is
designed for arms with a circumference from 25.4
cm (10 inches) to 40.6 cm (16 inches). This is the
standard adult range, and is marked on the cuff to
make sure you fall within it. If this cuff does not
fit your Subject, you should use another Subject
for this lesson so the readings are accurate.

Cuffs come in several sizes and it is important that you select
the right size cuff for Subject’s arm because if the cuff is too
large you may get incorrect low readings, and if it is too small
you may get incorrect high readings.

2. Make sure all the air in the sphygmomanometer cuff is
expelled before use.

¢ Turn the release valve fully counter-clockwise and
roll the cuff up while squeezing it.

If air is left in the cuff you may get a false high reading
because an excessive amount of pressure will be required to
occlude the brachial artery.

3. Close the valve.

7

«» Turn the release valve fully clockwise.

4. Position Subject’s arm at heart level.
Hold up Subject’s arm, or
Have Subject rest his/her arm on the lab table.

®,
0.0

7
0‘0

You need to minimize the effects of gravity. Arm above heart
level can give false low readings, and arm below heart level
can give false high readings.

5. Place the cuff so that the “Artery” label is over
Subject’s brachial artery (with the arrow on the label
facing down).

¢ There is an “Artery” label (with arrow) that is
sewn into the cuff.

The cuff pressure must be applied directly to the artery, which
requires the bladder inside the cuff to be in the proper position.

6. Position the cuff such that the lower edge of the cuff is
1.5 to 2 inches above the antecubital fossa (inner aspect
of elbow).

The cuff edge should be high enough to avoid covering any
part of the stethoscope diaphragm. This is to minimize any
extraneous noise cause by the cuff rubbing against the
diaphragm.

7.  Wrap the cuff evenly and snugly around Subject’s arm
and allow the Velcro® to hold it in place.

7

< After it is snugly in place, you may wish to inflate
the cuff slightly (10-20 mmHg) so that it will stay
in place.

A loose cuff can give a false high reading because of the
increased pressure required to occlude the brachial artery.

8. Make sure all the rubber tubing and cables of both the
sphygmomanometer cuff and stethoscope are not
tangled or pinched.

Any tubing on the sphygmomanometer that is pinched can
cause false pressure reading and if the stethoscope tubing is
pinched, it can greatly reduce the loudness of the Korotkoff
sounds.
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Basic measurement step Reason
9. Position the sphygmomanometer pressure dial indicator | Reading the dial at an angle can cause inaccurate readings due
such that you can read the face of the dial straight on. to parallax error.

¢+ The dial indicator can be clipped to the strap sewn
into the cuff above the “Artery” label.

Notes for the following steps:

a) Itis important to not inflate the cuff higher than is Besides causing pain for Subject, an overinflated cuff may
needed. produce a vasospasm, which can cause incorrect pressure
readings.
b) Itis important to not leave the cuff at a high pressure | Besides discomfort for Subject (which can elevate blood
for an extended period of time. pressure,) occlusion of blood caused by the cuff creates venous

congestion in the forearm. The blood must be allowed to drain
or it can lead to incorrect pressure readings. For the same
reason, it important to wait at least one (1) minute between
successive blood pressure measurements.

Step we will use: The stethoscope diaphragm needs to be placed over the
10. Palpate the brachial artery between the antecubital brachial artery where the Korotkoff sounds are best heard.
fossa and the lower edge of the cuff to find where the | Thjs procedure can be a bit tricky so take note: The pulse is felt
pulse is best felt. when the artery is compressed over bone or firm tissue. To feel
¢ Use your first and second fingers to feel the the pulse, compress the artery firmly then ease up on the
pulsation of the brachial artery on the inside of pressure slightly. After a few tries you should get the hang of
your elbow. it.

+«+ During the actual lesson, you can note this position
by marking the spot with a washable felt pen.

Alternate technique:
10. Inflate the cuff to 110 mmHg and place the stethoscope | This alternate procedure can result in optimal placement of the

diaphragm over the brachial artery between the stethoscope diaphragm, but it can take longer to find. As noted
antecubital fossa and the lower edge of the cuff and above, it is not safe to inflate the cuff for a long period of time,
move it around to find the place where the sounds are | sq this technique is not used in the lesson because when you
best heard. add the steps required to perform the recording, it simply takes
too long.
Step we will use:
11. Inflate the cuff to 160 mmHg. If cuff is not inflated high enough, true systolic pressure may
< Pump the cuff rapidly then release to reduce distal | be missed.
vasculatory engorgement. This technique has the advantage of being quick and easy, and
< Itis assumed that the majority of Subjects in the for reasons Qiscussed abpve, it' is preferable to mipimize the
physiology lab will have systolic pressures below | amount of time the cuff is at high pressure. The disadvantage
this pressure. of this technique is that it uses more pressure than most

Subjects probably need, and (in rare cases) it may miss the
point of diastolic pressure. However, because a simultaneous
recording will be per-formed, and time will be time spent
reviewing the recording procedure, this is the best technique
because it is fast.

Alternate technique:

11. Either by listening through the stethoscope, or by
palpating the radial artery (on flexor surface of wrist,)
inflate the cuff 20 to 30 mmHg above the point at
which the sounds or pulse disappear.

This technique makes sure the cuff pressure does not go
excessively high.

12. Place the stethoscope in the correct position. Excessive pressure could distort the artery and give incorrect
> Do not push down excessively on it and try to pressure indications (usually gives a diastolic pressure reading
maintain a constant pressure against the skin. that is too low). Also, excessive pressure can cause the

stethoscope to rub on Subject’s skin, which may generate
extraneous noise.
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Basic measurement step

Reason

13. Release the pressure at a rate of 2 to 3 mmHg/second.

Deflating too slowly produces venous congestion, which can
give false high diastolic pressure readings. Deflating too
rapidly leads to inaccuracies because the actual point of
systolic or diastolic pressure could lie between heartbeats. The
slower the heart rate, the more inaccurate the reading.

14. Note the pressure at which the Korotkoff sounds first
appear (systolic).

This sound indicates the pressure closest to the systolic
pressure.

15. Continue to listen and note the pressure when the
sounds completely disappear (diastolic).

This pressure is close to the point of diastolic pressure.

Note: The point at which the sounds become muffled is closer
to the diastolic pressure but since it’s easier to detect the
disappearance of sound—and the difference between the two is
small—we will use the point of disappearance of sound.

16. Deflate the cuff as rapidly as possible after all the
sounds disappear.

This will minimize patient discomfort and reduce venous
congestion.

When evaluating a patient or Subject, you will normally take blood pressure readings at different points in time and/or under
different circumstances (at rest vs. after exercise, etc). to see how the blood pressure changes. With this in mind, it becomes
important that your technique is consistent every time you do it. If two people use different techniques, they may get slightly
different readings, but the difference (or delta)—which can be the more important factor—will be very consistent for each

person.
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Il. EXPERIMENTAL OBJECTIVES

1.

To use an auscultatory method for an indirect determination of systemic arterial systolic and diastolic blood
pressures and to correlate the appearance and disappearance of vascular sound with systolic and diastolic
pressures respectively.

To measure, record, and compare systemic arterial blood pressure in the right arm and the left arm of the same
Subject under identical conditions.

To compare the systemic arterial systolic and diastolic blood pressures detected audibly to those recorded by the
stethoscope microphone.

To measure, record, and compare systemic arterial blood pressures in the same Subject under different
experimental conditions of rest and exercise.

To compute and compare pulse pressure and mean arterial pressure under different experimental conditions of
rest and exercise.

To compute the pulse pressure wave velocity by measuring the time between the R-wave of the ECG and the
Korotkoff sounds.

I11. MATERIALS

»  BIOPAC Pressure Cuff (SS19L with gauge e Biopac Student Lab System: BSL 4
dial or SS19LA/LB with onscreen gauge software, MP36, MP35 or MP45 hardware
display) e Computer System (Windows or Mac)

e BIOPAC Stethoscope (SS30L) .

e  Stopwatch or watch/clock with a second

e BIOPAC Electrode Lead Set (SS2L) hand.
electr_odes per Subject e Optional: BIOPAC Headphones

e Rubbing alcohol and swab (to clean (OUT1/OUT1A for MP3X or 40HP
stethoscope earpieces and stethoscope for MP45)
diaphragm)

e Optional: felt pen (to mark stethoscope
placement on arm)

1IV. EXPERIMENTAL METHODS
A. SETUP

FAST TRACK Setup Detailed Explanation of Setup Steps

Subject selected must not have had or

Lab Group Requirements:

You should work in a group of at least 3 people. One person will be

CAUTION! . .
Subject, one (Recorder) will operate the computer, and another

now have any disorder, hypertension, person (Director) will perform the blood pressure measurement.
hearﬁ surgery, stroke, or any history of Subject must meet the qualifications listed to the left.
cardiovascular degeneration. Recorder is responsible for starting and stopping the recording, and

Subject should not have consumed
caffeine, smoked, or performed heavy i )
exercise within one hour of the Director should perform the measurement normally, without regard to
recording. the recording aspect, but should call out the points of systolic and
diastolic pressure so that Recorder can add the markers to the data

1. Turn the computer ON. recording.

o [f using an MP36/35 unit, turn it OFF.

adding markers to the recording. Only Recorder should look at the
computer screen.

o [f using an MP45, make sure USB cable
is connected and “Ready” light is ON.

Page P-1

Setup continues...
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2. Plug the equipment in as follows (Fig.
16.7):

BP Cuff (SS19L/LA/LB) — CH 1*
Stethoscope (SS30L) — CH 2
Electrode Lead Set (SS2L) — CH 3 **

If MP45 is used for recording:
*The SS19L cuff must be used.
(SS19LB/A not compatible with MP45.)
** ECG is not recorded

OPTIONAL - BSL 4.0.2 and higher:
Korotkoff sounds transmitted through the
SS30L stethoscope may also be heard via
headphone connection with the MP device.
This can be useful when a second observer
wishes to monitor the stethoscope output.
(See page 8 for details.)

3. Turn ON the MP36/35 unit.
4. Select your lab group.

Fig. 16.7 MP3X (top) and MP45 (bottom) equipment connections

IF ECG is not used, proceed to Step 8. ECG may or not be recorded depending on hardware used and/or

5. Clean and abrade skin. lesson preference setting.

6. Attach three electrodes on the Subject as If the skin is oily, clean electrode sites with soap and water before
shown (Fig. 16.8). abrading.

If electrode is dry, apply a drop of gel.
Remove any jewelry on or near the electrode sites.

Place one electrode on the medial surface of each leg, just above
the ankle. Place the third electrode on the right anterior forearm at
the wrist (same side of arm as the palm of hand).

For optimal electrode contact, place electrodes on skin at least 5
minutes before start of Calibration.

Setup continues... Fig. 16.8 Standard Electrode placement
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7. Clip the Electrode Lead Set (SS2L) to
electrodes in a Lead Il setup as shown,
paying close attention to the lead colors (Fig.
16.9).

e RIGHT forearm = WHITE lead
e RIGHT leg = BLACK lead (ground)
e LEFT leg = RED lead

o VIN+

Fig. 16.9 Standard electrode lead attachment

The pinch connectors work like a small clothespin, but will only latch
onto the nipple of the electrode from one side of the connector.

8. Subject gets in a seated, relaxed, position. Subject should sit with arms relaxed at side of body and hands apart in
lap, with legs flexed at knee and feet supported.

Position the cables and leads such that they do not pull on the
electrodes; connect the electrode cable clip to a convenient location on
Subject’s clothes. Arrange leads so Subject’s arms can be easily
raised.

Do not place pressure cuff on Subject until after calibration.

Fig. 16.10 Calibration positioning

Setup continues...
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10.

11.
12.

13.
14.

15.

Clean the stethoscope earpieces and
diaphragm.

Open cuff valve, flatten and roll to remove all
air and close valve.

Start the Biopac Student Lab Program.

Choose lesson “L16 — Blood Pressure™ and
click OK.

Type in a unique filename and click OK.

Make sure the pressure cuff shown in the
journal (Hardware tab) matches your setup. If
it does not, change the “Blood Pressure Cuff
Type” preference as described in Step 15.

Optional Set Preferences.
e Choose File > Lesson Preferences.
o Select an option.
o Select the desired setting and click OK.

END OF SETUP

L16 — Blood Pressure Biopac Student Lab 4

Clean each earpiece with rubbing alcohol and allow it to dry
completely. You should also clean the surface of the stethoscope
diaphragm (the part that comes in contact with the skin) for each new
Subject.

The pressure release valve must be in the open (counter-clockwise)
position to allow air to be released.

Start Biopac Student Lab by double-clicking the Desktop shortcut.

Biopac
Student Lab
4.0

A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a common folder.

The SS19L uses a mechanical pressure gauge and the SS19LA/LB uses
an on-screen gauge.

This lesson has optional Preferences for data and display while
recording. Per your Lab Instructor’s guidelines, you may set:

Grids: Show or hide gridlines.

Blood Pressure Cuff Type: Select type of Blood Pressure Cuff
Transducer.

Gauge Color*:

Choose blue or white background
with contrasting dial

* Only available when default
SS19LA/LB Gauge Preference is
selected

Lesson Recordings: Specific recordings may be omitted based on
instructor’s preferences.

ECG Lead Il data: Set option to show or hide ECG Lead Il channel.
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B. CALIBRATION

Calibration establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for optimal
performance. Pay close attention to Calibration. (Click the Calibration tab to view example Calibration video.)

FAST TRACK calibration Detailed Explanation of Calibration Steps
Cuff is not on Subject during calibration. Calibration is only required once for multiple subjects.
Follow instructions for cuff type used.
(SS19LA/LB or SS19L)
1. Subject is seated, relaxed and still. Subject must remain relaxed and as still throughout calibration to
2. Click Calibrate. minimize baseline shift and EMG artifact.
o At the prompt, confirm cuff is The SS19LA/LB cuff uses the on-screen pressure gauge.

o completely deflated and click OK.
P « Continue to Step 3.
5
(7') Confirm cuffis completely deflated,
%)
g
-

Fig. 16.11 SS19LA/LB prompt

o At the first prompt, roll the cuff onto  The SS19L cuff uses the mechanical pressure gauge.

itself so the Velcro will prevent Make sure the pressure release valve is closed (fully clockwise).
unrolling when inflated.

o Inflate the cuff to 100 mmHg and Do not click OK until the pressure is stabilized at 100 mmHg.

click OK. Alternate method: Inflate
the rolled cuff slightly, and then -
squeeze to obtain the desired

calibration pressures. Inflate or squeeze the rolled up cuff to 100 mmHg according to the dial gauge, then didk 'Ok,

[ o |

Fig. 16.12 SS19L first prompt

o At the second prompt, deflate cuff to
40 mmHg and click OK.

o Continue to Step 3. Deflate or squeeze the rolled up cuff to 40 mmHg according to the dial gauge, then dick 'OK.'

If using SS19L (with mechanical gauge)

Fig. 16.13 SS19L second prompt
Slowly turn the pressure release valve counter-clockwise to deflate the
cuff pressure to 40 mmHg, and then close the valve (fully clockwise).
Do not click OK until the pressure is stabilized at 40 mmHg.

BSL 4.0.3 and earlier: The calibration recording will begin after
clicking OK in the second prompt (Fig. 16.13).

BSL 4.1 and later: The calibration recording will begin after clicking
Calibration continues. .. OK in an additional “lightly tap the stethoscope” prompt (Fig 16.14).
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3. Director lightly taps stethoscope diaphragm
twice. (Prompt at right will appear in
versions BSL 4.1 and later.)

Wait for Calibration to stop.
5. Verify recording resembles example data.

o |f similar, click Continue and proceed to
Data Recording.

NOTE*: The ECG channel may or not
be displayed depending on hardware
used and/or lesson preference setting.

o If necessary, click Redo Calibration.

END OF CALIBRATION
PRACTICE PRESSURE RELEASE

L16 — Blood Pressure

Biopac Student Lab 4

Biopac Student Lab }l

After the recording begins, lightly tap the stethoscope diaphragm twice,

Fig. 16.14 Stethoscope prompt (BSL 4.1 and later)

Calibration will stop automatically after 8 seconds.

The pressure data will be a flatline at either 0 (SS19LA/LB) or 40
mmHg (SS19L). The stethoscope data must show clear spikes to
indicate when it was tapped. If ECG is displayed*, it should be a
recognizable ECG waveform with baseline at or near 0 mV, no large
baseline drift and no significant EMG artifact.

om 0 ]
.......

Fig. 16.15 Example Calibration Data

If recording does not resemble the Example Data...
= |f data is noisy or flatline, check all connections to MP unit.

= [f indicated Pressure is less than 0 mmHg, redo calibration and
follow the steps precisely.

= |If the ECG displays baseline drift or excessive EMG artifact:

o Verify all electrodes are making good contact with the skin and
that the leads are not pulling on the electrodes.

0 Make sure the Subject is in a relaxed position. (Fig. 16.10)

Click Redo Calibration and repeat Steps 2 — 5 if necessary.

To obtain accurate measurements, it is important that the cuff pressure is released at a rate of 2 — 3 mmHg per second. You
are encouraged to practice pressure release several times before proceeding to the recording. To practice, you’ll need a watch
or clock with a second hand. The following steps will help you develop a consistent pressure release technique:

a) Open the cuff valve and roll the cuff in on itself, then press to flatten and close the valve.
o This will release all pressure from the cuff.
b) Pump the cuff bulb until the pressure dial reads 160 mmHg.
c) Tell the timer when you are ready, and slowly turn the valve counter-clockwise to begin releasing the cuff pressure.
« Open the valve slowly so that you don’t have a large pressure drop, and try to maintain an even release.
o To keep the release rate constant, you may need to open the valve more as the cuff pressure diminishes.
d) When pressure is at 100 mmHg, say “Stop” and ask the timer how much time elapsed.
e It should take you about 20 — 30 seconds to drop 60 mmHg.
e) Repeat as necessary until you can release cuff pressure at 2 — 3 mmHg per second.
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C. DATA RECORDING

FAST TRACK Recording

1. Prepare for the recording.

CAUTION!
Do not inflate the cuff higher than is

| needed. Never leave the cuff on the |

Subject at high pressure (more than 120
mmHg) for more than 1 minute.

2. Make sure all air is expelled from cuff and
close the pressure release valve.

3. Locate the brachial artery on each arm and
mark the stethoscope position with a felt
pen.

4. Review Cuff placement and positioning:

e “Artery” label should be positioned
over the brachial artery (with the arrow
on the label facing down).

o Lower edge of cuff should be 40 — 50
mm (1.5 — 2 inches) above the
antecubital fossa (inner aspect of
elbow).

e Wrap the cuff evenly and snugly on
Subject’s arm.

e When in the seated position, the arm
must rest at heart level; use books or a
pillow to raise arm if necessary (Fig.
16.17).

e Find a position that is comfortable for
Director and Subject (Fig. 16.17).

e Place stethoscope diaphragm over
brachial artery, with firm pressure.

L16 — Blood Pressure Page P-7

Detailed Explanation of Recording Steps

Seven data recordings will be acquired™*:

Recording 1 — 2: Left arm, seated.

Recording 3 — 4: Right arm, seated.

Recording 5 — 6: Right arm, supine.

Recording 7: Right arm, seated, after exercise.
*IMPORTANT
This procedure assumes that all lesson recordings are enabled in lesson
Preferences, which may not be the case for your lab. Always match the
recording title to the recording reference in the journal and disregard any
references to excluded recordings.

Hints for obtaining optimal data:
= Subject should relax for a few minutes before each recording begins.

= Director must be positioned to easily inflate cuff while viewing the
pressure dial indicator.

= For greater stethoscope comfort, twist the earpieces slightly forward
before inserting.

= Room must be quiet in order to easily hear sounds through
stethoscope.

= To minimize EMG artifact and baseline drift:
0 Subject’s arms and legs must be relaxed.

0 Subject must remain still and should not talk during any
recordings.

0 Make sure electrodes do not peel up and that the leads do not pull
on the electrodes.

Turn the release valve fully counter-clockwise and roll the cuff up while
squeezing it. Turn the pressure release valve fully clockwise.

Use your first (index) and second (middle) fingers to feel the pulsation
of the brachial artery on the inside of the elbow. This can be tricky, but
after a few tries you should get the hang of it. It may help if Subject
makes a fist while you are trying to locate the pulse.

Once you have located the pulse, mark the spot by tracing along the
edge of the top and bottom of the stethoscope diaphragm.

The cuff edge should be high
enough to avoid covering any part
of the stethoscope diaphragm.
The Velcro® wrap should hold the
cuff in place.

Make sure rubber tubing and
cables do not become tangled or
pinched.

Exert enough pressure on
stethoscope diaphragm to
establish good contact, but do not
press too hard.

Fig. 16.16 Cuff and stethoscope
placement

Recording continues...
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o Director should hold the pump bulb
with both fingers on the release valve
S0 it can be easily turned.

o For greater Stethoscope comfort, rotate
the ear tubes slightly forward (Fig.
16.18).

OPTIONAL - BSL 4.0.2 and higher:
Korotkoff sounds from the SS30L
stethoscope may also be heard via the
following MP headphone connections:

e OUT1 headphones into Analog Out
(MP35).

e OUTL1 headphones into Analog Out or
OUT1A into the headphone output jack
(MP36).

e 40HP headphones into the headphone
output jack (MP45).
This can be useful when a second observer
wishes to monitor the stethoscope output.

To enable or mute headphone output, toggle
the “Headphones ON/Headphones OFF”
buttons while data recording is in progress.

Suspend Headphones OM | Hesdphones OFF |

CAUTION:
Cuff pressure release sounds may be
very loud through the headphones. It's

advisable to toggle “Headphones OFF”
prior to pressure release. Then toggle
back ON during the next data recording.

Recording continues...

L16 — Blood Pressure

Fig. 16.18 Rotate ear tube for comfort

Problems you may encounter:
a) You can’t hear the Korotkoff sounds.

Some Subjects may not produce loud enough Korotkoff
sounds. This does not mean that anything is wrong with the
person’s physical state. If this is the case, wait one minute
and repeat the measurement using a slightly different
position for the stethoscope diaphragm and/or using the
other arm.

Another possibility is that your hearing is not acute enough
to detect the sounds, but the recording is picking them up,
which for the purposes of this lesson is ok. In a real clinical
setting, if you could not hear the sounds, you would need to
try a strictly palpatory method to get the reading. For this
lab, since you probably have a time constraint, consider
changing Subjects.

You hear an auscultatory gap.

Wait at least 1 minute, and then try the measurement again.
If this second reading fails, then use the palpatory method
with the brachial or radial artery while inflating the cuff and
note the point where the pulse is no longer felt. This value
will be Subject’s approximate systolic pressure value. The
diastolic value should be found the normal way
(disappearance of all sounds). The recording will not be
accurate, but it will allow you to finish the lessons and
answer the questions.

Biopac Student Lab 4
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5.

6.

7.

8.

9.

Left arm, Seated 1
Prepare for Recording:
e Subject is seated, relaxed and still.
o Left arm is positioned at heart level.

o Cuff and stethoscope are placed on left
arm following guidelines in Step 4.

e Review recording steps.
Inflate cuff to 160 mmHg.

Click Record.

CAUTION!

Do not leave the cuff at this pressure for
more than 1 minute.

Release pressure at a constant rate of 2 to 3
mmHg/second.

Director announces when Korotkoff sounds
first appear (systolic).

o Recorder presses F4 =V Systolic

10. Director continues listening, and announces

when sounds disappear completely
(diastolic).

e Recorder presses F5 = V Diastolic

11. Wait an additional five seconds, and then

click Suspend.

12. Deflate cuff as rapidly and completely as

13. Verify recording resembles the example data.

possible.

o |f similar, click Continue and proceed to
the next recording.

o |f necessary, click Redo.

o If all required recordings have been
completed, click Done.

Recording continues...

L16 — Blood Pressure

The majority of Subjects in the physiology lab will have systolic
pressures below this pressure.

Note that the gauge display (when using SS19LA/LB) may respond
slowly.

Upon start of the first recording, a confirmation prompt will appear.
Click OK to proceed.

Confirm cuff pressure is 160 mmHa.

Fig. 16.19 Confirmation prompt

If Korotkoff Sounds appear at the start of the recording, click
Suspend, Redo, inflate cuff to 180 mmHg.

The first sound (which may resemble a sharp tapping) indicates the
pressure closest to the systolic pressure.

This pressure is close to the point of diastolic pressure.

= |f sound diminishes but never disappears, note diastolic at the
point sound diminishes.

Waiting an additional five seconds will allow the stethoscope
microphone to pick up any final Korotkoff sounds that may be
inaudible to Director.

When the cuff is deflated rapidly, the stethoscope will pick up
significant noise artifact. Try to click Suspend before deflating the
cuff.

Release cuff pressure rapidly to reduce distal vasculatory engorgement
(reduce venous congestion) and minimize patient discomfort.

The pressure data should decline linearly, at approximately 2 — 3
mmHg/sec. To verify:

= Select one second of data (Delta T) and note Delta measurement
for rate of pressure release.

The Korotkoff sounds (data “spikes™) should be visible in the
Stethoscope data and there should be minimal noise artifact. IF ECG is
displayed, the waveform should show little baseline drift or EMG
artifact. Both event markers should be present (use horizontal scroll
bar to search all data).

Page P-9
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Left arm, seated 2
14. Repeat Steps 6 through 12.

15. Verify recording resembles the example data.

o If similar to Fig. 16.20, click Continue
and proceed to the next recording.

o |f necessary, click Redo.

o Ifall required recordings have been
completed, click Done.

Recording continues...

L16 — Blood Pressure Biopac Student Lab 4

Fig. 16.20 Example data
If recording does not resemble the Example Data...
= |f data is noisy or flatline, check all connections to MP unit.

= |f the cuff pressure was released before clicking Suspend, the
stethoscope data will include noise artifact from the rapidly
deflating cuff — this is normal.

= |f event markers are missing, redo and remind Recorder to press
F4 and F5 at the appropriate times.

= |f the Korotkoff sounds are not present, make certain the
diaphragm is properly located over brachial artery and try
applying more pressure.

= |f there is too much noise artifact in the stethoscope data, make
sure to hold the stethoscope with constant pressure and to
minimize movement of the Subject’s arm, the cuff, the tubing and
the stethoscope.

= |f the ECG baseline is not stable, or there is excessive EMG

artifact, verify electrodes are making good contact and that the
leads are not pulling on the electrodes.

If necessary, click Redo to repeat the last recording. Note that once
Redo is clicked, the most recent recording will be erased.

The Subject’s arm should rest for a few minutes after the first
recording (with no cuff pressure).

Data requirements are the same as described in Step 13.

If necessary, click Redo and repeat the last recording.

Note that when Redo is clicked, the most recent recording will be
erased.
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Right arm, seated 1
16. Subject remains seated and relaxed, with Data requirements are the same as described in Step 13.
cuff attached to right arm.
e Right arm is positioned at heart level.

o Cuff and stethoscope are placed on
right arm following guidelines in Step
4

17. Repeat Steps 6 through 12.

18. Verify recording resembles the example
data.

o If similar to Fig. 16.20, click Continue
and proceed to the next recording.

o If necessary, click Redo.

« Ifall required recordings have been Note that when Redo is clicked, the most recent recording will be
completed, click Done. erased.

Right arm, Seated 2

If necessary, click Redo and repeat the last recording.

19. Repeat Steps 6 through 12. The Subject’s arm should rest for a few minutes after the first recording
(with no cuff pressure).
20. Verify recording resembles the example Data requirements are the same as described in Step 13.
data.

o If similar to Fig. 16.20, click Continue
and proceed to the next recording.

o |f necessary, click Redo.

o If all required recordings have been

completed, click Done. If necessary, click Redo and repeat the last recording.

Note that when Redo is clicked, the most recent recording will be
erased.
Right arm, Supine 1
21. Subject is Supine (lying down, face up)
and relaxed with cuff attached to right arm.
e Right arm is positioned at heart level.

o Verify cuff and stethoscope placement
as described in Step 4.

22. Repeat Steps 6 through 12.

Fig. 16.21 Supine positioning (SS19LA/LB Shown)

Recording continues...
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23. Verify recording resembles example data.

o |f similar to Fig. 16.20, click Continue
and proceed to the next recording.

o If necessary, click Redo.

o |Ifall required recordings have been
completed, click Done.

Right arm, Supine 2
24. Repeat Steps 6 through 12.

25. Verify recording resembles the example data.

o If similar to Fig. 16.20, click Continue
and proceed to the next recording.

o |f necessary, click Redo.

o Ifall required recordings have been
completed, click Done.

Right arm, after exercise

26. Unclip leads and remove cuff to allow
Subject to perform moderate exercise to
elevate heart rate.

CAUTION!
Subject selected must not have had or
now have any disorder, hypertension,
heart surgery, stroke, or any history of

cardiovascular degeneration.
Subject must not have consumed
caffeine, smoked, or performed heavy
exercise within one hour of the recording.

27. After exercise, Subject sits down to recover.
28. Reattach leads and attach cuff to Subject’s
right arm.
e Right arm is positioned at heart level.

o Verify cuff and stethoscope placement as
described in Step 4.

29. Inflate cuff to 180 mmHg.
30. Repeat Steps 6 through 12.

31. Verify recording resembles the example data.

o |f similar to Fig. 16.20, click Continue
to proceed to optional recording section,
or Done to finish the lesson.

o |f necessary, click Redo.

Recording continues...

L16 — Blood Pressure Biopac Student Lab 4

Data requirements are the same as described in Step 13.

If necessary, click Redo and repeat the last recording.

Note that when Redo is clicked, the most recent recording will be
erased.

The Subject’s arm should rest for a few minutes after the first
recording (with no cuff pressure).
Data requirements are the same as described in Step 13.

If necessary, click Redo and repeat the last recording. Note that when
Redo is clicked, the most recent recording will be erased.

Confirm that Subject has no history of disorders and meets the
requirements listed to the left before performing any exercise.

Subject does 50 push-ups or runs in place for 5-minutes to elevate
heart rate to a moderate level.

The starting cuff pressure is higher than in previous recordings.

Data requirements are the same as described in Step 13.

If necessary, click Redo and repeat the last recording.

Note that when Redo is clicked, the most recent recording will be
erased.
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OPTIONAL ACTIVE LEARNING PORTION

32. After clicking Done, choose an option and
click OK.

33. Remove the Pressure cuff and electrodes.

END OF RECORDING
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With this lesson you may record additional data by clicking
Continue following the last recording. Design an experiment to test
or verify a scientific principle(s) related to topics covered in this
lesson. Although you are limited to this lesson’s channel
assignments, the electrodes or transducers may be moved to different
locations on the subject.

Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each
step to make it easy to follow during recording.

Run Your Experiment

D. SetUp

Set up the equipment and prepare the subject for your experiment.
E. Record

Use the Continue, Record, and Suspend buttons to record as
much data as necessary for your experiment.

Click Done when you have completed all of the recordings
required for your experiment.

Analyze Your Experiment

F. Set measurements relevant to your experiment and record the
results in a Data Report.

If choosing the Record from another Subject option: Repeat Setup
Steps 4 — 9 then proceed directly to Recording (re-calibration not
required*).

Note*: If Recalibration is desired, Quit then re-launch the application.

If ECG was recorded, remove the electrode cable pinch connectors
and peel off all electrodes. Discard the electrodes. (BIOPAC
electrodes are not reusable.) Wash the electrode gel residue from the
skin, using soap and water. The electrodes may leave a slight ring on
the skin for a few hours which is quite normal.
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V. DATA ANALYSIS

FAST TRACK Data Analysis Detailed Explanation of Data Analysis Steps

1. Enter the Review Saved Data mode and e e L T T T
choose the correct file. . . :

e Note Channel Number (CH)
designations:

Channel Displays Units
CH1 Pressure mmHg
CH2  Stethoscope mV
CH3* ECGLeadll mV

*ECG may not have been recorded.

i D00 A8 P60 3640 130 W00 SN0 1180
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Fig. 16.22 Example Data

The measurement boxes are above the marker region in the data window.

¢ Note measurement box settings: Each measurement has three sections: channel number, measurement type,

Channel  Measurement and result. The first two sections are pull-down menus that are activated
CH1 Value when you click them.
CH3 BPM Brief definition of measurements:
CH1 DeltaT Value: Displays the amplitude value for the channel at the point

selected by the I-beam cursor. If a single point is selected, the value is
for that point, if an area is selected, the value is the endpoint of the
selected area.

BPM: Beats Per Minute first calculates the difference in time between
the end and beginning of the area selected by the 1-Beam tool (same as
Delta T,) and then divides this value into 60 seconds/minute.

Delta T: Measures the difference in time between the end and
beginning of the selected area.

The “selected area” is the area selected by the I-Beam tool (including

endpoints).
2. Setup your display window for optimal Note: The append event markers 4 mark the beginning of each recording.
viewing of the first recording. Click on (activate) the event marker to display its label.

Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom Back,
Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)

Cursor Tools: Zoom Tool

Buttons: Overlap, Split, Show Grid, Hide Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click” (Mac)
the channel number box to toggle channel display.

3. Use the I-Beam cursor to select the point ~ This is the Systolic pressure that was audibly detected; event marker
at the first event marker and record the manually inserted.
pressure (CH 1 — Value).

g A

Data analysis continues...

Page P-1 ©BIOPAC Systems, Inc.
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Fig. 16.23 Point of audibly detected Systolic pressure

Note: In the figure, the Value measurement represents cuff pressure at the
selected point and the BPM measurement is not giving an accurate
reading because only one point is selected with the I-beam cursor.

4. Select the point that corresponds to the This is the Systolic pressure that was detected by the stethoscope.
first Korotkoff sound the stethoscope e
detected and record the pressure. =

g |
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Fig. 16.24 Point of first Korotkoff sound

IF ECG is recorded: To help distinguish a Korotkoff sound from noise
artifact, note that the sound normally appears near the time of the ECG T-
wave. If needed, zoom in the data to see the details.

S PII

H noise first sound

—’ .I. 4 - ,I . v

i nE nE A% Ze o0 o D0 DY N6 D6 DK ND N0 #e =8
vk

Fig. 16.25 Distinguishing Korotkoff sound from noise

ETT T |

5. Select the point that corresponds to the ~ This is the Diastolic pressure that was audibly detected.
second event marker and record the e N
pressure. —

B l == s

I% .‘.‘}‘.;*Fif -

[JJMWM %4%“4W4%—WJMA+M

F
|Ju|.A. 340 500 B0 830 980 1140 1100 1460 30 1780 HE0 D0 H00 N0 T N0 B0 N0 WA OX 4K

Data Analysis continues... Fig. 16.26 Point of audibly detected Diastolic pressure
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6. Select the point that corresponds to the
last Korotkoff sound the stethoscope
detected and record the pressure.

5B

7. Measure BPM.
e Using ECG signal:

In the region between Systolic and
Diastolic pressure, select one R-R
interval and record the BPM
measurement (Fig. 16.28).

e Using Korotkoff sounds:

If ECG was not recorded, select the
area between two successive
Korotkoff sound peaks and record the
BPM measurement (Fig. 16.29).

gc

Repeat this measurement on two
successive R-waves (or sound peaks).

Slc

8. If ECG was not recorded skip to Step 9.
Zoom in on one of the ECG complexes in
the time between systolic and diastolic
pressure.

9. Using the I-beam cursor, select the area
from the peak of the R-wave to the
beginning of the sound detected by the
stethoscope.

Note the Delta T measurement.

g e

Data Analysis continues...
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This is the Diastolic pressure that was detected by the stethoscope.

As in Step 4, the ECG — T wave can be used to distinguish a Korotkoff
sound from noise artifact.
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Fig. 16.29 Sound interval selection approximates R-to-R interval

BPM changes on a beat-by-beat cycle, so for more accurate measurement

you should take BPM (R-R) measurements on 3 successive R-waves and
find the average BPM.

TIP: You may hide CH 1 (Pressure) to make it easier to see the other

channels. (Alt + click on PC, option + click on Mac.)

=

[ == = i Fm =a oy 0 =0

Fig. 16.30 Timing of Korotkoff Sounds
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10. Repeat Steps 3 — 8 for each recording to
complete the Data Report.

11. Perform measurements and calculations
for Pulse Speed per Table 16.7.

12. Answer the questions at the end of the
Data Report.

13. Save or Print the data file.

14. Quit the program.
END OF DATA ANALYSIS

L16 — Blood Pressure Biopac Student Lab 4

This lesson acquired seven recordings (unless modified for your lab
session). Recordings are identified by their append event markers. #

An electronically editable Data Report is located in the journal
(following the lesson summary,) or immediately following this Data
Analysis section. Your instructor will recommend the preferred format for
your lab.

END OF LESSON 16

Complete the Lesson 16 Data Report that follows.
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BLOOD PRESSURE

e Indirect measurement

L16 — Blood Pressure

e Ventricular Systole & Diastole

DATA REPORT
Student’s Name:

o Korotkoff sounds
e Mean Arterial pressure

Lab Section:

Date:

I. Data and Calculations

Subject Profile
Name:

Age: Time:

A. Systolic Measurements

Gender: Male / Female

Height:

Page P-5

Weight:

Complete Table 16.2 with the systolic measurements for all data recordings. Note the pressure measurement at the event
marker insertion point (where Director audibly detected and marked systolic) and where the first Korotkoff sound was
detected with the stethoscope microphone. Calculate the Delta difference (A) between the trials for each condition, the
trial average pressure, and the Delta difference between the event marker and stethoscope microphone average pressure

measurements.

Table 16.2 Systolic Data

Systolic Pressure mmHg

Condition Trial | Audibly Detected Average Microphone Detected Average A Average
Pressure (Event Pressure Pressure (In data, Pressure Pressure B
marker) (Calculate) unmarked) (Calculate) minus
Average
A B Pressure A
Left arm, 1
seated 2
A
Right arm, 1
seated 2
A
Right arm, 1
lying down 2
A
Right arm, 1
after
exercise™

*For ‘Right arm, after exercise’ recording, calculate the Delta difference between the ‘Audibly Detected Pressure’ and the
‘Microphone Detected Pressure’ values, and record the result in the right column.
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B. Diastolic Measurements

Complete Table 16.3 with the diastolic measurements for all data recordings. Note the pressure measurement at the event
marker insertion point (where Director audibly detected and marked diastolic) and where the sound disappeared from the
stethoscope microphone. Calculate the Delta difference (A) between the trials for each condition, the trial average
pressure, and the Delta difference between the event marker and stethoscope microphone average pressure

L16 — Blood Pressure

Biopac Student Lab 4

measurements.
Table 16.3 Diastolic Data
Diastolic Pressure mmHg
Condition Trial Audibly Average Microphone Average A Average
Detected Pressure Detected Pressure Pressure Pressure B
Pressure (Calculate) (In data, unmarked) (Calculate) minus
(Event marker) Average

A B Pressure A
Left arm, seated 1
2
A
Right arm, 1
seated 2
A
Right arm, lying 1
down 2
A
Right arm, after 1

exercise™

*For ‘Right arm, after exercise’ recording, calculate the Delta difference between the ‘Audibly Detected Pressure’ and the
‘Microphone Detected Pressure’ values, and record the result in the right column.

C. BPM Measurements

Complete Table 16.4 with the BPM measurements from three cycles of each data recording and calculate the mean
BPM for each.

* Cycle measurements: If ECG was recorded, use ; if ECG was not recorded, use .

Table 16.4 BPM

D. Summary of Mean Blood Pressure Data

Right arm, after exercise ? ’////////////////////////////

Complete Table 16.5 with the average from sound data from tables 16.2 and 16.3 and then calculate the pulse pressure
and the mean Avrterial Pressure (MAP). Note the pressure measurements at the event marker insertion points (where
Director audibly detected and marked systolic and diastolic).

Pulse pressure = Systolic pressure — Diastolic pressure

MAP =

pulse pressure

+ diastolic pressure

OR

MAP =

(systolic pressure + 2 diastolic pressure )

3
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Table 16.5 Average Systolic Pressure/Average Diastolic Pressure

SYSTOLE DIASTOLE BPM Calculations:
NDITION
co o Table 16.2 Table 16.3 Table 16.4 Pulse MAP
Sound Average | Sound Average pressure
Left arm, seated
Right arm, seated
Right arm, lying down
Right arm, after exercise
E. Timing of Korotkoff Sounds NOTE: This table requires ECG data, which is not recorded on MP45 systems.
Complete Table 16.6 with the Delta T for each condition, and calculate the means.
Table 16.6
Timing of Sounds
Condition Trial Mean (calc)
1
Left arm, seated
2
1
Right arm, seated
2
1
Right arm, lying down
2
Right arm, after exercise 1

F. Calculation of Pulse Speed
Complete the calculation in Table 16.7 using “Right arm, seated” data.

Table 16.7
Distance | Distance between Subject’s sternum and right shoulder cm
Distance between Subject’s right shoulder and antecubital fossa cm
Total distance cm
Time | Time between R-wave and first Korotkoff sound secs
Speed | Speed = distance/time = cm/ sec cm/sec

. Questions:

1. Note the difference in systolic pressure value between when (a) the sound actually began, (b) was detected by the
stethoscope transducer, and (c) was recorded, and the time when the observer first heard the sound and pressed the event
marker keystroke. (Example: 141 mmHg — 135 mmHg = 6 mmHg.) What factors could account for this difference?
Would the observed difference be the same if measured by another observer? Explain your answer.

2. a) Does your systolic and/or diastolic arterial pressure change as your heart rate increases?
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b) How does this change affect your pulse pressure?

c) How would you expect the systolic, diastolic and pulse pressures to change in a normal healthy individual as the
heart rate increases?

3. Give three sources of error in the indirect method of determining systemic arterial blood pressure.

4. Use an equation that relates flow, pressure, and resistance to define mean arterial pressure:

5. Blood flow (liters per min). through the pulmonary circuit equals blood flow through the systemic circuit, but pulmonary
resistance to flow is 5 times less than the systemic resistance to flow. Using the equation in Question 4, show that mean
pulmonary pressure is 5 times less than mean systemic pressure.

6. Define the first and second sounds of Korotkoff. Which sound is used to approximate systolic pressure and which sound
is used to approximate diastolic pressure?

7. Why is mean arterial pressure not equal to (systolic pressure — diastolic pressure)/2?

8. Define pulse pressure. Explain, in terms of changes in systolic and diastolic pressures, why pulse pressure increases
during exercise.
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9. Give one reason why blood pressure in the left arm may be different than blood pressure in the right arm of a Subject at
rest.

10. Name an artery other than the brachial that could be used for an indirect measurement of blood pressure and explain your
choice.
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I11. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials
C. Method
D. SetUp

E. Experimental Results

End of Lesson 16 Data Report
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I. INTRODUCTION

In this lesson you will record sounds of the cardiac cycle, producing PULMONARY CIRCULATION
a record called a phonocardiogram, while simultaneously recording
Lead Il electrocardiogram. You will compare and correlate
electrical events of the cardiac cycle to mechanical events of the
cardiac cycle.

The human cardiovascular system consists ofs the heart and blood
vessels arranged to form a double circulation: the systemic Artery
circulation and the pulmonary circulation. The circulatory pattern

resembles a figure 8 with the heart located at the center (Fig. 17.1).

The primary function of the heart is to receive blood from the Pulmonary
pulmonary veins and pump it into the systemic arteries, and to Trunk

Pulmonary
Veins

receive blood from the systemic veins and pump it into the

pulmonary arteries. The sequence of electrical and mechanical Right Left
events of the heart associated with receiving blood from the venous

systems and pumping it out into the arterial systems during one Vena Cava Aorta

heartbeat is known as the cardiac cycle.
A simplistic mechanical analogy of the heart is that of a double-
pump. The left and right sides are separate, but pump in unison to
move blood through the heart.
The normal flow of blood through the heart and blood vessels is
unidirectional, and is as follows:
left ventricle - systemic arterial vessels - systemic capillaries -
systemic venous vessels - right atrium - right ventricle -
pulmonary arterial vessels - pulmonary capillaries - pulmonary
venous vessels - left atrium - left ventricle.
Blood flowing through the left side of the heart is kept separate
from blood flowing through the right side of the heart by the septa
(walls) between the atria and between the ventricles.

SYSTEMIC CIRCULATION

Fig. 17.1 Circulatory Pattern

Page I-1 ©BIOPAC Systems, Inc.
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The unidirectional flow of blood through the chambers on each
side of the heart is ensured by an atrioventricular valve and a
semilunar valve (Fig. 17.2).

On the left side of the heart the atrioventricular valve is called the Pulmonary
mitral valve, and the semilunar valve is called the aortic valve. Semilunar Valve
On the right side of the heart the atrioventricular valve is called the
tricuspid valve, and the semilunar valve is called the pulmonary Right Atrium
valve.
The atrioventricular valve opens into the ventricle, allowing blood Tricuspid Valve
to flow from the atrium into the ventricle but not in the reverse (Atrioventricular)
direction (retrograde flow). The valve is open when ventricular
pressure is less than atrial pressure, thereby allowing the ventricle Right Ventricle
to fill with blood. The valve is closed when ventricular pressure is
greater than atrial pressure, thereby preventing the backward flow Fig. 17.2 Heart valves
of blood.

Aortic
» -Semilunar Valve

\~—_ Left Atrium

y— Mitral Valve
(Atrioventricular)

Left Ventricle

The semilunar valve opens into the artery (pulmonary trunk or aorta) allowing blood to flow out from the ventricle when
ventricular pressure is greater than pressure in the artery. The valve is closed when ventricular pressure is less than arterial
pressure, thereby preventing the backward flow of blood. During the cardiac cycle, the semilunar valves (pulmonary and
aortic) open and close in unison, as do the atrioventricular valves (tricuspid and mitral). This is the “double-pump” action of
the heart.

Four major heart sounds are associated with the opening and closing of the valves and the flow of blood within the heart
during the cardiac cycle. These sounds may be heard by placing a stethoscope in the corresponding position on the anterior
surface of the chest over the heart.

1. The first heart sound occurs during ventricular systole (contraction of ventricular muscle) and is caused by closure of
the atrioventricular valves and opening of the semilunar valves. This sound is the “lub” of the characteristic “lub-dub”
that can be heard with each heartbeat.

2. The second heart sound occurs during ventricular diastole (relaxation of ventricular muscle) and is caused by closure
of the semilunar valves and opening of the atrioventricular valves. This sound is the “dub.”

3. The third heart sound is caused by turbulence associated with rapid filling of the ventricles shortly after opening of
the atrioventricular valves.

4. The fourth heart sound is caused by turbulence associated with the passage of blood from the atria into the ventricles
during atrial systole. This sound is heard immediately before the ventricles begin to contract and force the
atrioventricular valve to close.

Note: The first and second heart sounds are sharp and distinct, easily heard by the untrained ear. The third sound closely
follows the second and is of lower amplitude (muffled,) which makes it hard to distinguish. The fourth sound is often
of such low amplitude that it cannot be detected. For these reasons, discussion of heart sound measurement often refers
to only the first and second heart sounds.

Hearing deficits may affect detection and interpretation of the heart sounds. The BIOPAC stethoscope contains a microphone
that picks up sounds traveling through the tubing. The microphone is very sensitive and can pick up sounds that may not be
heard.

Placement of stethoscope diaphragm to hear corresponding valve sounds is shown in Fig. 17.3.
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Fig. 17.3 Stethoscope Positions for Optimal Detection of Heart Valve Function

A heart murmur is an atypical sound usually produced by abnormal closure of a cardiac valve, narrowing (stenosis) of the
valvular orifice, or defects in the atrial septum or ventricular septum. The fundamental cause of the change in sound is
increased turbulence. Murmurs may be heard during ventricular systole (systolic murmurs) or during ventricular diastole
(diastolic murmurs).

o  For example, if the mitral valve fails to completely close, thereby allowing retrograde flow, a systolic murmur may
occur. On the other hand, if the aortic valve is diseased and incompetent causing a murmur, the sound will be heard
during ventricular diastole.

The opening and closing of cardiac valves and the sounds they produce are mechanical events of the cardiac cycle. They are
preceded by the electrical events of the cardiac cycle.

Each heartbeat begins with a signal generated by the sinoauricular (SA) node, commonly called the pacemaker. As the signal
spreads through atrial muscle the atria respond by contracting (atrial systole). At this time the ventricles are relaxing
(ventricular diastole) and the atrioventricular valves are open, the semilunars are closed. The ventricles are filling with blood,
preparing for ejection.

The atrioventricular (AV) node picks up the pacemaker signal and, after a short delay that allows the atria to complete systole
and enter diastole, sends the signal down the atrioventricular conduction system to the ventricles stimulating them to contract
(ventricular systole). When the ventricles contract, ventricular pressure increases above atrial pressure and the
atrioventricular valves close (1st heart sound).

Ventricular pressure continues to increase, and when it exceeds arterial pressure, the semilunars open and blood is rapidly
ejected into the pulmonary trunk and aorta. The ventricles complete systole and enter diastole. As the ventricles relax
ventricular pressure falls below arterial pressure and the semilunar valves close (2nd heart sound).

When ventricular pressure falls below atrial pressure, the atrioventrcular valves open and ventricular filling begins again. At
this time (a period called diastasis) the atria and the ventricles are relaxed and awaiting the pacemaker to signal the next
cardiac cycle.

The electrical events of the cardiac cycle can be recorded in the form of an electrocardiogram (ECG).

o At this point, students should review Lesson 5, ECG I, for the meaning of the waveforms, time intervals and
segments of Lead II.

Fig. 17.4 shows the timing relationship of the heart sounds and the ECG electrical signal. It also includes aortic, ventricular
and atrial pressure plots for the left side of the heart. Pressure waves for the right side (not shown) would have similar shape
but be of less amplitude. This is because the pressure that builds up in the chambers of the left side of the heart is much
greater than that on the right. The higher pressure on the left causes the valves to snap shut harder and faster, so the valves on
the left side create the majority of the sound heard through the stethoscope.
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Fig. 17.4 Timing of Events in the Cardiac Cycle
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II. EXPERIMENTAL OBJECTIVES

1.

To listen to human heart sounds and describe them qualitatively in terms of intensity or loudness, pitch, and
duration.

To correlate the human heart sounds with the opening and closing of cardiac valves during the cardiac cycle and
with systole and diastole of the ventricles.

To determine the nature of the change in the relationship between electrical and mechanical events of the
cardiac cycle as heart rate increases.

III. MATERIALS

BIOPAC Stethoscope (SS30L) e Biopac Student Lab System: BSL 4
ft MP36, MP MP45 h
BIOPAC Electrode Lead Set (SS2L) software, MP36, MP35 or MP45 hardware

fer Syst ' M
BIOPAC Disposable Electrodes (EL503,) 3 *  Computer System (Windows or Mac)

electrodes per Subject e  Optional: BIOPAC Headphones

OUT1/OUT1A for MP3X or 40HP
BIOPAC Electrode Gel (GEL1) and gor MP45) o of
Abrasive Pad (ELPAD)

IV. EXPERIMENTAL METHODS

A. SETUP

1. Turn the computer ON.
e Ifusing an MP36/35 unit, turn it OFF.
e Ifusing an MP45, make sure USB cable
is connected and “Ready” light is ON.
2. Plug the equipment in as follows:
Stethoscope (SS30L) — CH 1
Electrode lead set (SS2L) — CH 2
3. Turn ON the MP36/35 unit.

OPTIONAL - BSL 4.0.2 and higher:
Heart sounds from the SS30L stethoscope
may also be heard via the following MP
headphone connections:

e OUT1 headphones into Analog Out
(MP35).

e OUT1 headphones into Analog Out or
OUT1A into the headphone output jack
(MP36).

e 40HP headphones into the headphone
output jack (MP45).
This can be useful when a second observer
wishes to monitor the stethoscope output.

Page P-1

FAST TRACK Setup Detailed Explanation of Setup Steps

Fig. 17.5 MP3X (top) and MP45 (bottom) equipment connections

Setup continues...

©BIOPAC Systems, Inc.
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4,

5.

6.

Select a Subject, a Recorder and, if

appropriate in your lab group, a Director.

CAUTION!
Subject selected must not have had or

now have any disorder, hypertension,
heart surgery, stroke, or any history of
cardiovascular degeneration.

Clean and abrade skin.

Attach three electrodes and clip leads in
Lead II setup.

o RIGHT forearm = WHITE lead
e RIGHT leg = BLACK lead (Ground)
e LEFT leg = RED lead

Setup continues...

L17 — Heart Sounds Biopac Student Lab 4

This lesson teaches the clinical detection of heart sounds, which are
monitored in four positions on the upper chest (between ribs two and six).

Normally, this involves one person (Director) listening to the heart sounds
of another individual (Subject). However, in a lab setting this may not be
comfortable or appropriate due to gender differences and personal
preference. In such cases:

®  Subject may listen to his/her own heart sounds by acting as and
following instructions for the Director.

®  When a Subject listens to his/her own heart sounds, it is imperative
that the right arm remains relaxed so EMG artifact does not corrupt
the ECG signal.—this means that Subject must hold the stethoscope
with the left hand.

®  The stethoscope may be placed over clothing for female Subjects or
for male Subjects who are not comfortable removing shirt. (Fig. 17.6)

Fig. 17.6 Stethoscope Placement

Subject should not have consumed caffeine, smoked, or performed heavy
exercise within one hour of the recording.

A Recorder is always required to run the lesson and insert event markers.

If the skin is oily, clean electrode sites with soap and water or alcohol

before abrading.

If electrode is dry, apply a drop of gel.

Remove any jewelry on or near the electrode sites.

Fig. 17.7 Electrode placement & lead attachment

Details

® Place one electrode on the medial surface of each leg, just above the
ankle. Place the third electrode on the right anterior forearm at the
wrist (same side of arm as the palm of hand).
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7.

10.

11.

12.

Subject gets in a seated, relaxed, position.

Clean the stethoscope earpieces and
diaphragm.

Start the Biopac Student Lab Program.

Choose lesson “L17 — Heart Sounds” and
click OK.

Type in your filename and click OK.

Optional Set Preferences.

e Choose File > Lesson Preferences.
e Select an option.
o Select the desired setting and click OK.

END OF SETUP

L17 — Heart Sounds Page P-3

® Lead Il is WHITE = right wrist, BLACK = right ankle, RED = left
ankle.

®  The pinch connectors work like a small clothespin, but will only latch
onto the nipple of the electrode from one side of the connector.

=  For optimal electrode contact, attach all electrodes to Subject at least
five minutes prior to recording.

Subject should sit with arms relaxed at side of body and hands apart in
lap, with legs flexed at knee and feet supported.
Position the cables and leads such that they do not pull on the electrodes;

connect the electrode cable clip to a convenient location on Subject’s
clothes.

Fig. 17.8 Calibration Positioning

Clean each earpiece with rubbing alcohol and allow it to dry completely.
You should also clean the surface of the stethoscope diaphragm (the part
that comes in contact with the skin) for each new Subject.

Start Biopac Student Lab by double-clicking the Desktop shortcut.

Biopac
Student Lab
4.0

A folder will be created using the filename. This same filename can be
used in other lessons to place the Subject’s data in a common folder.

This lesson has optional Preferences for data and display while recording.
Per your Lab Instructor’s guidelines, you may set:
Grids: Show or hide gridlines

Lesson Recordings: Specific recordings may be omitted based on
instructor’s preferences.
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B. CALIBRATION

Calibration establishes the hardware’s internal parameters (such as gain, offset, and scaling) and is critical for optimal
performance. Pay close attention to Calibration. (Click the Calibration tab to view example Calibration video.)

FAST TRACK Calibration Detailed Explanation of Calibration Steps

1. Subject remains seated, relaxed and still. Subject must remain relaxed and still throughout calibration to minimize
baseline shift and EMG artifact.

2. Click Calibrate.

3. Lightly tap the stethoscope diaphragm twice.

4. Wait for Calibration to stop. Calibration will stop automatically after 8 seconds.

5. Verify recording resembles the example data. The stethoscope data must show clear spikes to indicate when it was
tapped. There should be a recognizable ECG waveform with baseline at
or near 0 mV with no large baseline drift and no significant EMG

e If necessary, click Redo Calibration. artifact.

o If similar, proceed to next step.

T T

Fig. 17.9 Example Calibration data
If recording does not resemble the Example Data.

= Ifthe data is noisy or flatline, check all connections to the MP unit.
= Ifthe ECG displays baseline drift or excessive EMG artifact:

o Verity all electrodes are making good contact with the skin and
that the leads are not pulling on the electrodes.

o Make sure the Subject is in a relaxed position. (Fig. 17.8)

END OF CALIBRATION
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POSITIONING THE STETHOSCOPE =  For greater stethoscope comfort, rotate the Eartubes slightly

o Director determines optimal stethoscope forward.
diaphragm position for listening to heart
sounds 1 and 2 (“lub-dub”,) and should
mark the location with a water-soluble
pen.

o For suggested stethoscope placements, see
the Stethoscope Position Reference P .,
below. | 1

e If not performing the optional Note Fig. 17.10 Rotate Eartube for comfort
Sounds setup, click Continue to proceed

. . Refer to the Stethoscope Position Reference section below.
to the Data Recording section.

®  The best stethoscope position may be the one that produces the
loudest sounds, but it is important that heart sounds 1 and 2 (“lub-
dub”) are recorded. This may only be possible by “trial and error”
after reviewing the first data recording and redoing if necessary.

OPTIONALS: Click Note Sounds| The Director should describe the §ound as to .its.pitch, lqudn§ss, and
duration, and the Recorder types in the description. Begin with the

enter detailed descriptions of heart ; .
aortic valve and compare it to the others.

sounds at each valve position.

.. Cl Bopac Stdent Lab - Hote Sound - Aorhic Pasttion
o Refer to Stethoscope Position ot i i Bl P ot oAl W o o i

Reference (below) OR Help kTt 13 i kst i

menu Valve Positions. .

o After completing descriptions,
click Continue to proceed with
the recording.

ly Nest " e "

Fig. 17.11 Sound description entry dialog
Click Next to proceed to the next valve position, and repeat the
description/entry process. Repeat for all valve positions then click Done.
(All descriptions will appear in the Journal when the lesson is reviewed
in Analysis mode.)

Stethoscope Position Reference Jugu!ar Notch
(Fig. 17.12)

First Rib

Right .
Xiphold Prn:e-ns._.
Front View
Key:
Q- Aortic  @-Tricuspid
©@-Pulmenic @-Mitral

OPTIONAL: “NOTE SOUNDS” SETUP

Fig. 17.12 Heart valve position and corresponding stethoscope placement

Aortic and Pulmonic positions: Follow the collarbone to the jugular
(supraclavicular) notch, which is a little depression just below the
Adam’s apple. Go down vertically 64 mm (2.5”) and 38 mm (1.5”) to
the right for Aortic or 38 mm (1.5”) to the left for Pulmonic. Position
stethoscope between the ribs. Note that this description only works on
adults.

Tricuspid position: Just to the right of the tip of the sternum (xiphoid
process) immediately below the rib cage.

Mitral position: Roughly on the same horizontal plane as the tricuspid

position to the left of the tip of the sternum (xiphoid process) between
END OF NOTE SOUNDS SETUP the fifth and sixth ribs.
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C. DATA RECORDING
FAST TRACK Recording

1. Prepare for the recording.
¢ Subject remains seated, relaxed,
breathing normally (Fig. 17.8).

e Review recording steps before
proceeding.

Seated, at rest

2. Recorder clicks Record.

o Subject remains seated relaxed,
breathing normally.

e Stethoscope diaphragm is held in optimal
position.

3. Record for 20 seconds.

4. After 20 seconds, Subject begins a slow,
deep inhale/exhale cycle.

o Recorder presses F4 at start of inhale and
F5 at start of exhale.

e Wait for deep exhale to complete.

5. Click Suspend.

6. Verify that recording resembles the example
data.

e If similar, proceed to Step 7.
o If different, click Redo.

Recording continues...
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Detailed Explanation of Recording Steps

Two data recordings will be acquired*: One with Subject at rest and one
after moderate exercise.

*IMPORTANT

This procedure assumes that all lesson recordings are enabled in Lesson
Preferences, which may not be the case for your lab. Always match the
recording title to the recording reference in the journal and disregard any
references to excluded recordings.

Hints for obtaining optimal data:

®  If Subject is holding the stethoscope diaphragm, it must be held in
left hand, with right hand relaxed in order to minimize EMG artifact.

" To avoid noise artifact, the stethoscope must be held still.

®  The room should be quiet in order to easily hear sounds through the
stethoscope.

If the Stethoscope data displays very low amplitude, you can choose
Display > Autoscale Waveforms DURING the recording.

Subject begins a slow, deep inhalation, hold for one second and continue
with a slow exhalation, then return to normal breathing.

® Subject should breathe through the nose. Recorder should listen and
watch the Subject to detect the start of inhale and exhale.

®" To minimize baseline shift and EMG artifact, do not inhale or exhale
quickly and try to minimize chest expansion.

The heart sounds should be clearly seen in the stethoscope data. The ECG
data should show little baseline drift or EMG artifact except during the
deep breathing portion. The two event markers must be present.

) ’.ﬂunullllmH—LLMH@-’IJ{—"M{ L

Fig. 17.13 Example data
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7.

10.

11.

12.

Zoom in to verify heart sounds 1 and 2 are
recorded.

e If heart sounds 1 and 2 are present,
proceed to next recording.

e If necessary, click Redo.

e If all required recordings have been
completed, click Done.

After exercise

Unclip electrode leads from Subject.

Subject exercises to elevate heart rate to 1.5
x resting HR and then sits down to recover.

Check that electrodes are still making good
contact with skin and re-clip leads in Lead II
configuration.

Subject places stethoscope in same
optimal position as previous recording.

Click Record.

o Subject remains seated, recovering from
exercise.

e Stethoscope diaphragm is held in
optimal position.
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If recording does not resemble the Example Data...

® If the data is noisy or flatline, check all connections to the MP unit.

= If the stethoscope data is of very low amplitude, choose Display >
Autoscale Waveforms. If the heart sounds are not distinguishable
from baseline noise, redo and try a different diaphragm position
and/or apply more pressure to the stethoscope diaphragm. If the
diaphragm position changes, make sure to mark it with a water-
soluble pen.

® If there is too much noise artifact in the stethoscope data, make sure
to hold the stethoscope with constant pressure and to minimize
movement.

= If the ECG displays baseline drift or excessive EMG artifact:

o Verify all electrodes are making good contact with the skin
and that the leads are not pulling on the electrodes.

o Make sure the Subject is in a relaxed position (Fig. 17.8).

® If event markers are missing, redo and remind Recorder to press F4
and F5 at the appropriate times.

Click Redo and repeat Steps 1 — 6 if necessary. Note that once Redo is
clicked, the most recent recording will be erased.

Zoom in to see the details of the cardiac cycles. All four heart sounds may
be seen in your data, but it is important that at least heart sounds 1 and 2
are recorded for proper data analysis.

| 12
i --TI.MJ',H--u;’.*w..,wﬁqyl} u..»m#u.{.\..-u my.q,.d,.. _-...H{i ﬂ.g_u...,y;.w}.,.. ,‘..\iku.q--u,,,,

I A 40 B0 A sm @ A0 00 TR oW 8@ W G0 G@ AW 0
i

Fig. 17.14 Zoom to verify heart sounds 1 and 2 are recorded

If only one heart sound is recorded, Redo and try a slightly different
diaphragm position and/or apply more pressure to the stethoscope
diaphragm.

Subject must be able to move about freely to exercise and elevate the
heart rate.

The exercise required will vary depending on Subject and the level of
physical fitness. Generally, 20 — 30 push-ups/jumping-jacks or running in
place for 25 — 40 steps will suffice. After exercise, Subject sits down and
remains relaxed and still.

Check electrode adhesion and reconnect leads after exercise. Pay
attention to the lead color for proper placement, as shown in Fig. 17.7.

Recording continues...
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13. Record for 20 seconds.
14. Click Suspend.

15. Verify recording resembles the example
data.

o If similar, click Continue and proceed to
optional recording section, or Done to
finish the lesson.

e If necessary, click Redo.

OPTIONAL ACTIVE LEARNING PORTION

16. After clicking Done, choose an option and
click OK.

17. Remove the electrodes.

END OF RECORDING
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The heart sounds should be clearly seen in the stethoscope data and will
typically be of greater amplitude than the last recording (at rest). The
ECG may show more baseline drift or EMG artifact than in the first
recording.

]|
* 444&%\1-&-5-

TR

T T T Y T T T
ok

Fig. 17.15 Post-Exercise example data
Click Redo and repeat Steps 8 — 15 if necessary.
Note that when Redo is clicked, the most recent recording will be erased.

With this lesson you may record additional data by clicking Continue
following the last recording. Design an experiment to test or verify a
scientific principle(s) related to topics covered in this lesson. Although
you are limited to this lesson’s channel assignments, the electrodes or
transducers may be moved to different locations on the subject.

Design Your Experiment

Use a separate sheet to detail your experiment design, and be sure to
address these main points:

A. Hpypothesis

Describe the scientific principle to be tested or verified.
B. Materials

List the materials you will use to complete your investigation.
C. Method

Describe the experimental procedure—be sure to number each step
to make it easy to follow during recording.

Run Your Experiment
D. Set Up

Set up the equipment and prepare the subject for your experiment.
E. Record

Use the Continue, Record, and Suspend buttons to record as much
data as necessary for your experiment.

Click Done when you have completed all of the recordings required
for your experiment.

Analyze Your Experiment

F. Set measurements relevant to your experiment and record the results
in a Data Report.

If choosing the Record from another Subject option:

= Repeat Setup Steps 4 — 8, and then proceed to Calibration.
Remove the electrode cable pinch connectors and peel off all electrodes.
Discard the electrodes. (BIOPAC electrodes are not reusable.) Wash the
electrode gel residue from the skin, using soap and water. The electrodes

may leave a slight ring on the skin for a few hours which is quite
normal.
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V. DATA ANALYSIS

FAST TRACK Data Analysis

1. Enter the Review Saved Data mode and
choose the correct file.

e Note Channel Number (CH)

designations:
Channel Displays
CH1 Stethoscope
CH2 ECG

e Note measurement box settings:

Channel Measurement
CH1 P-P

CH1 Delta T

CH1 BPM

2. Set up the display window for optimal
viewing of the first recording.

3. Zoom in on an area of two complete
cardiac cycles, prior to the start of deep
inhalation.

4. Use the I-Beam cursor to select the area
from one R-wave to the next R-wave.

Note the BPM measurement.

g a

Data Analysis continues...
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Detailed Explanation of Data Analysis Steps

If entering Review Saved Data mode from the Startup dialog or Lessons
menu, make sure to choose the correct file.
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Fig. 17.16 Example data

The measurement boxes are above the marker region in the data window.
Each measurement has three sections: channel number, measurement type,
and result. The first two sections are pull-down menus that are activated
when you click them.

Brief definition of measurements:

P-P (Peak-to-Peak): Subtracts the minimum value from the maximum
value found in the selected area.

Delta T: Measures the difference in time between the end and
beginning of the selected area.

BPM: Calculates the difference in time between the first and last
selected points and then divides this value into 60 seconds/minute.

The “selected area” is the area selected by the I-Beam tool (including

endpoints)

Note: The append event markers # mark the beginning of each recording.
Click on (activate) the event marker to display its label.

Useful tools for changing view:

Display menu: Autoscale Horizontal, Autoscale Waveforms, Zoom Back,
Zoom Forward

Scroll Bars: Time (Horizontal); Amplitude (Vertical)

Cursor Tools: Zoom Tool

Buttons: Overlap, Split, Show Grid, Hide Grid, -, +

Hide/Show Channel: “Alt + click” (Windows) or “Option + click” (Mac)
the channel number box to toggle channel display.

Note: Try and choose two cardiac cycles that have clearly defined ECG
components and whose corresponding hear sounds have minimal noise
artifact. Scroll to other cardiac cycles if necessary.

©BIOPAC Systems, Inc.
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S.

Use the I-Beam cursor to select an area
from the start of the 2nd heart sound to the
start of the 1st heart sound of the next
cardiac cycle. (Refer to Stethoscope data
only (CH1); do not use the ECG channel
for this portion of the experiment.)

Note the Delta T measurement.

g a

Zoom in on an area of one complete
cardiac cycle.

Use the I-Beam cursor to select an area
from the R-wave peak to the start of the Ist
heart sound.

Note the Delta T measurement.

g A

Use the I-Beam cursor to select an area
from the R-wave peak to the start of the
2nd heart sound.

Note the Delta T measurement.

g a

Data Analysis continues...
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Fig. 17.17 R-R interval
Heart Sounds in Stethoscope channel (CH1) will lag slightly behind the R-

wave (ECG CH2).
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Fig. 17.18 2nd heart sound to 1st heart sound of next cardiac cycle
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Fig. 17.19 R-wave to 1st heart sound
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Fig. 17.20 R-wave to 2nd heart sound
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9. Use the I-Beam cursor to select an area
that encompasses the 1st heart sound.

Note the P-P measurement.

5 A

10. Use the I-Beam cursor to select an area
that encompasses the 2nd heart sound.

Note the P-P measurement.

g a

11. Scroll to the Inhale interval of the “Seated,

at rest” recording and take the

measurements described above (in Steps 3

— 10) as required to complete Table 17.1.

5 A

12. Scroll to the Exhale interval of the first
recording and take the measurements
described above (in Steps 3 — 10) as
required to complete Table 17.1.

g a

13. Scroll to the “After exercise” recording
and take the measurements described
above (in Steps 3 — 10) as required to
complete Table 17.1.

g a

14. Answer the questions at the end of the Data

Report.
15. Save or Print the data file.
16. Quit the program

END OF DATA ANALYSIS
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Fig. 17.21 1st heart sound interval
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Fig. 17.22 2nd heart sound interval

This interval begins with the event marker labeled “Inhale.” Choose
cardiac cycles that are a few cycles after the event marker.

This interval begins with the event marker labeled “Exhale.” Choose
cardiac cycles that are a few cycles after the event marker.

This recording begins with the append event marker labeled “After
exercise.”

Note: The ECG data may contain more baseline drift and/or EMG artifact
than the first recording and the stethoscope data may contain more noise
artifact. It may be necessary to scroll through the data until acceptable
cardiac cycles and corresponding heart sounds are found.

An electronically editable Data Report is located in the journal (following
the lesson summary,) or immediately following this Data Analysis section.
Your instructor will recommend the preferred format for your lab.

END OF LESSON 17

Complete the Lesson 17 Data Report that follows.
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HEART SOUNDS

e Cardiac valve functions
e Relationship between electrical and mechanical events of the cardiac cycle

DATA REPORT

Student’s Name:

Lab Section:

Date:
Subject Profile
Name: Height: Gender: Male / Female
Age: Weight:

Note: This Data Report assumes that all lesson recordings were performed, which may not be the case for your lab.
Please disregard any references to excluded recordings.

I. Data and Calculations

A. Heart Sound Measurements

Complete Table 17.1 with “Seated, at rest” and “After exercise” data and complete the required calculations.

Table 17.1
Seated, at rest After exercise
UL LI Lo L At Rest Inhalation Exhalation
E:x:zz to next
s
e e
;(SJLF%an heart
iy
o
2 eatzond
B. Description of Heart Sounds | Note: You may copy and paste descriptions from the Lesson 17 journal below. |

Describe the sounds of each of the following heart valves in terms of intensity (loudness,) pitch (frequency) and duration
(length). Begin with the aortic valve and compare others to it. This is a subjective description.

Aortic

Pulmonic

Tricuspid

Mitral
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II1. Questions
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1. Relative to the electrical and mechanical events of the cardiac cycle, what do each of the measurements in Table 17.1

represent?
BPM:

Delta T: R-wave to 1st sound

R-wave to 2nd sound

1st to 2nd

2nd sound to next 1st sound

P-P: 1st sound

2nd sound

2. Note whether the measured values in Table 7.1 increased, decreased or did not change from the resting value when

heart rate increased.
Table 17.2

Measured Value Increased Decreased

No Change

BPM

Delta T R-wave to 1st sound

R-wave to 2nd sound

1st to 2nd

2nd sound to next 1st sound

P-P 1st sound

2nd sound

3. Explain why each of these would change.

4. Briefly describe the cause of the turbulence associated with each of the four heart sounds:
1st sound

2nd sound

3rd sound

4th sound

5. Which of the four heart sounds is loudest? Give a reason.
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6. Does ventricular ejection occur during ventricular depolarization or during ventricular repolarization?
Refer to your experimental record before you answer, and explain your answer.

7.  Which cardiac valves close during ventricular systole? Which cardiac valves close during ventricular diastole?
Systole:

Diastole:

8. Define “systolic murmur” and give one example of a cause.

9. Define “diastolic murmur” and give one example of a cause.

10. Define “cardiac cycle.”

11. Briefly characterize the relationship between the electrical events and the mechanical events of the cardiac cycle.
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III. OPTIONAL Active Learning Portion
A. Hypothesis

B. Materials

C. Method

D. Set Up

E. Experimental Results

End of Lesson 17 Data Report



